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Preface

Purpose

This guide provides the information that you need to build OLAP models. It
explains al Hyperion® Integration Server OLAP model features and options, and
it contains the concepts, processes, procedures, formats, tasks, and examples that
you need to use the Hyperion Integration Server Desktop software.

Audience

Thisguideisfor Hyperion Integration Server database administrators who are
responsible for installing, implementing, and deploying the system.

To use the information in this book, you need the following skills:

e Knowledge of where the data for your business resides; for example, in a
relational database.

e Knowledge of how to create and maintain Open Database Connectivity
(ODBC) data sources.

e Knowledge of the data requirements for your business, so you can apply the
Hyperion Integration Server product family to your specific application.

e A fundamental understanding of Microsoft Windows and basic Microsoft
Windows terminology, such asdialog box, list box, and button. See Microsoft
Windows documentation for more information on these terms.

e Experience with the setup and operation of Hyperion® Esshase® OLAP
Server.

e A basic understanding of multidimensional concepts.
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Document Structure

xii H

This document contains the following information:

Chapter 1, “About Hyperion Integration Server,” introduces basic OLAP and
multidimensional concepts and describes how to use the desktop to create OLAP
models.

Chapter 2, “Preparing Relational Data Sources,” describes how to prepare
relational data for transfer to a Hyperion Essbase database.

Chapter 3, “ Creating and Working with OLAP Models,” describes how to openan
OLAP model, connect to OLAP Metadata Catalog and to arelational data source,
and create, save, delete, and print an OLAP model.

Chapter 4, “ Creating the Fact Table, Accounts Dimension, and Time Dimension,”
describes how to create afact table, an accounts dimension, and atime dimension
from one or more tablesin the relational data source.

Chapter 5, “ Creating and Working with Dimensions,” describes how to create and
edit dimensions.

Chapter 6, “Editing Columns in Dimension Tables and the Fact Table,” describes
how to view and change column properties.

Chapter 7, “Transforming Columns,” describes how to create columns, change
column properties, and transform columns.

Chapter 8, “ Setting Attribute-Enabled Columns,” describes how to select columns
to be attribute-enabled.

Chapter 9, “Joining Dimension Tables,” describes how to create, view, modify,
and delete joins to dimension tables.

Chapter 10, “ Creating and Working with Hierarchies,” describeshow to createand
edit hierarchies, from defining hierarchy filtersto sorting and transforming datain
ahierarchy.

Appendix A, “Creating a Sample OLAP Model Containing Attribute-Enabled
Columns,” provides procedures for using the sample TBC application to create an
OLAP model that contains attribute dimensions.

Glossary, lists and defines key Hyperion Integration Server terms.

Index, lists Hyperion Integration Server terms and their page numbers. Inthe PDF
version of this guide, select an index entry to view the relevant page.
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Sample Applications

The examples used in this book are based on two sample databases provided with
Hyperion Integration Server. The databases are called TBC (external data source)
and TBC_MD (OLAP Metadata Catalog). The TBC_MD OLAP Metadata
Catalog contains a sample OLAP model and a sample metaoutline. The OLAP
model is called TBC Model, and the metaoutline is called TBC Metaoutline.

Note: The capitalization of column and table names in the sample
applications depends on the relational database management
system (RDBMYS) that you use.

The person who installs Hyperion Integration Server isresponsible for making the
sampl e databases, the OL AP model, and the metaoutline available to end users. If
any of thefollowing problems occur when you launch Hyperion I ntegration Server
Desktop, contact the Hyperion Integration Server administrator:

e You cannot find the sample databases, the OLAP model, or the metaoutline.

e You do not have adequate access to the sampl e databases, the OLAP model,
or the metaoutline.

e You do not see any datain the sample databases.

Related Documentation

Hyperion provides the following documentation for this product:

e Hyperion Integration Server Desktop OLAP Metaoutline User’s Guide, for
information about basic multidimensional concepts and how to design, create,
and maintain one or more metaoutlines based on an OLAP model.

e Hyperion Integration Server System Administrator’s Guide, for information
about how to use OLAP Integration Server, OLAP Metadata Catalog, and
OLAP Command Interface, and about how to create and manage ODBC
connections.

e Hyperion Integration Server Installation Guide, for information about
installing the software, about Hyperion Integration Server directories and
files, and about connecting relational data sourcesto an OLAP Metadata
Catalog.
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Hyperion Essbase OLAP Server documents:

Hyperion Essbase OLAP Server Database Administrator’s Guide, for
information about basic multidimensional conceptsand descriptions of how to
design, create, and maintain a Hyperion Essbase database.

Hyperion Essbase QL Interface Guide, for information about the data
sources supported through Hyperion Essbase SQL Interface.

Hyperion Essbase Spreadsheet Add-in User’s Guide for Excel, for
information about how to use Hyperion Esshase Spreadsheet Add-in with
Microsoft Excel.

Hyperion Essbase Spreadsheet Add-in User’s Guide for Lotus 1-2-3, for
information about how to use Hyperion Essbase Spreadsheet Add-in with
Lotus 1-2-3 for Windows.

The online Quick Technical Reference in the pocs directory for information
about Hyperion Essbase calculation and report commands and functions.

Online Help

» To access online help:

1.
2.

Inadialog box, click Help.
In the Help dialog box, to display information about an item, click the item.

» To print an online help topic, display the topic and select File > Print.

Online Guides

The online guides are electronic versions of the printed documentation.

» Todisplay an online guide, select Help > Help Topics.

xiv Il
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Conventions

The following table shows the conventions used in this document:

Table i: Conventions Used in This Document

Item Meaning

> Arrows indicate the beginning of a procedure consisting
of sequential steps.

Brackets[] In examples, brackets indicate that the enclosed elements
are optional.

Bold Bold text indicates words or characters that you type

exactly asthey appear on the page. Bold in procedura
steps highlights major interface elements.

CAPITAL LETTERS | Capital |etters denote commands and various I Ds.
(Example: LOADALL command)

Example text Courier font indicates that the material shown isacode or
syntax example.

Ctrl +0 K eystroke combinations shown with the plus symbol (+)
indicate that you should press the first key and hold it
while you press the next key. Do not type the + symbol.

Courier italics | Courier italic text indicates avariablefield in command
syntax. Substitute avalue in place of the variable shownin

Courier italics.

Italics Italicsin aproduct-related term indicates that the term is
also included in the glossary of the book.

Ellipses(...) Ellipsis pointsindicate that text has been omitted from an
example.

Mouse orientation This document provides examples and procedures using

aright-handed mouse. If you use a left-handed mouse,
adjust the procedures accordingly.
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Table i: Conventions Used in This Document (Continued)

Item Meaning

Menu options Optionsin menus are shown in the following format:
Menu name > Menu command > Extended menu command
For example:
Connections > OLAP Metadata Catalog > Connect

n, X The variable n indicates that you must supply ageneric

number; the variable x indicates that you must supply a
generic letter.

Note: Theterm right-click, used throughout this guide, meansto click the
secondary mouse button to open a pop-up menu.
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About Hyperion
Integration Server

Hyperion Integration Server provides a suite of graphical toolsto create OLAP
models and metaoutlines. Y ou use tablesin arelationa data source to define a
logical model that represents the data in an online analytical processing (OLAP)
context. You then use the OLAP model to create a metaoutline that servesas a
template for a Hyperion Essbase database outline.

This chapter explains basic OLAP concepts, provides an overview of Hyperion
Integration Server, describes OL AP models, and definesthe workflow for creating
OLAP models.

This chapter contains the following topics:

“About OLAP’ on page 1-2

“About Multidimensional Databases’ on page 1-3
“About Hyperion Integration Server” on page 1-5
“About OLAP Models’ on page 1-10
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About Hyperion Integration Server

About OLAP

OLAP is adecision-support computing environment for business managers who
need to analyze consolidated enterprise datain real time. OLAP enables usersto
answer complex “what if” questions and to create sales and marketing scenariosto
test budgeting, sales promotion, and sales planning strategies. Hyperion Essbase
OLAP Server supports a multidimensional, multi-user database that enterprise
users can access using standard retrieval tools, such as spreadsheets.

Hyperion Essbase OL AP Server supports multiple views of datasets for userswho
need to analyze relationships between data categories. For example, a
decision-support user might ask the following questions:

e How did Product A sell last month? How does this figure compareto salesin
the same month over the last five years? How did Product A sell by branch,
by region, and by territory? How will Product A sell next month, next quarter,
and next year?

e Did Product A sell better in particular regions? Do regional trends exist?

e Did customers return Product A last year? Were returns due to product
defects? Did the company manufacture defective products in a specific plant?

e Did commissions and pricing affect how salespeople sold Product A? Did
particular salespeople do a better job of selling the product?

Y ou can use Hyperion Integration Server to create a Hyperion Esshase database
that enables users to answer these types of questions quickly and easily.

Y ou can use Hyperion Integration Server Desktop to create alogical data model
that represents the relational database that contains the data that you want to
analyze. Thus, you take the first step in advancing from arelationa database to
a Hyperion Essbase database.

1-2 1 Hyperion Integration Server Desktop OLAP Model User’s Guide



About Hyperion Integration Server

About Multidimensional Databases

A multidimensional database (MDDB) stores consolidated data at the
intersections of its members and dimensions. For example, if acompany sellsa
total of 20 units of all productsin the East region in the first quarter, Hyperion
Esshase stores 20 at the intersection of Product, East, Quarterl, and Unit Sales.

Dimensions represent the core components of a business plan and often relate to
business functions. Product, Region, and Y ear are typical dimensions. In most
databases, dimensions are static, rarely changing over the life of the application.

A member isan individual component of adimension. For example, Product A,
Product B, and Product C might be members of the Product dimension. Each
member has a unique name. A dimension can contain an unlimited number of
members. In some dimensions, members change frequently over the life of the
application.

Simultaneously, members can be parents of some members and children of other
members. The Hyperion Essbase outline indents members below one another to
indicate a consolidation relationship. For example, sales totals for the Products
dimension might betotalled by product description, broken down by product code,
and further broken down by product ID.

User Interactions with Data

Hyperion Essbase OL AP Server consolidates and calcul ates data to provide
different views of the data. With amultidimensional database, users can do all of
the following:

Consolidate (aggregate or roll up) data

The consolidation process computes the data relationshipsfor al parent and child
combinations within adimension. For example, the consolidation for the Y ear
dimensionisasfollows:

Year = Quarterl + Quarter2 + Quarter3 + Quarter4

A consolidation is typically additive, but it can be any type of calculation.
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1-4 1

Create sophisticated “what if” scenarios

Assumethat you set asalesgoal of ten percent growth for the upcoming year on all
product lines. With Hyperion Essbase, you can compare sales forecasts estimated
by planners with actual sales data (retrieved from the online transaction
processing [OLTP] database) to see how close you are to achieving your sales
goals. If actual salesrun lower than projected sales for agiven period, salespeople
can accessthe forecast data, input new product sal es scenarios (for example, What
if I sell 2000 widgetsto our biggest corporate customer?), update the forecast data,
and provide revised figures to headquarters.

I nput strategic planning assumptions

Assume that your company is planning for 50 percent growth over the next three
years. Y ou have afairly good idea of how many new products you need, but how
do you know how many new engineers, salespeople, and support personnel you
can afford to add while still optimizing profits and gross margin?

With Hyperion Essbase, you can input projected sales and expenses for each
product and calculate downward to determine the cost of goods sold. Thus, you
obtain arealistic picture of the bottom line. If the picture does not look practical,
you can create different scenarios with different mixes of products, people, and
expenses until you produce the profit picture that you require.

Spreadsheet operations

Drilling down or drilling up on data retrieves progressively more detailed or
progressively more generalized datarelative to a selected dimension. Drilling
down on a database dimension provides you with greater detail on the dimension.
Drilling up provides you with a higher level (more summarized) view of the
dimension. For example, you can drill down on the Y ear dimension to view the
values for each quarter. Then you can drill down on Quarterl to view the values
for each month of Quarterl. Y ou can view Quarterl sales for the Chicago office
and then drill up to view salestotals for the entire East region.
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Pivoting data alters the data perspective. When Hyperion Essbase retrieves a
dimension, it displays a configuration of rows and columns. A user can pivot
(rearrange) the data to obtain a different viewpoint.

For more information about spreadsheet operations, such as drill down and pivot,
see the Hyperion Esshase Spreadsheet Add-in User’s Guide for Excel or the
Hyperion Essbase Spreadsheet Add-in User’s Guide for Lotus 1-2-3.

Sources of Data

The datain a multidimensional database can originate from avariety of sources,
such as OL TP databases, text files, and spreadsheet files. OL TP databases contain
awealth of operational data, such as the following:

e How many units of Product A are on hand?
e What isthe current customer’s name, address, and billing status?

e What isan employee'ssaary, job title, and address?

Datain an OL TP database must be up to date and easy to change and must use as
little space as possible. The datais stored in rows and columnsin relational
database tables.

Hyperion Integration Server enables you to access data for an OLAP model from
adata sourcethat is configured for Open Database Connectivity (ODBC) and that
supports SQL 89 or |ater.

About Hyperion Integration Server

Hyperion Integration Server transfers data from relational tables to a Hyperion
Essbase database quickly. To perform the transfer, you must determine which
data to transfer and consolidate the selected data into aform that is useful for
decision-support users. Then you must identify the tables, rows, or columns
that contain the data and determine how they map to the structure of the
multidimensional database.
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Asillustrated in Figure 1-1, Hyperion Integration Server provides graphical tools
to help you to do the following tasks:

e Usethetables, views, and columnsin arelational databaseto createan OLAP
model. An OLAP model isalogical star schema consisting of afact table that
is surrounded by related dimension tables.

e Usethe OLAP model to create ametaoutline, an outline template that contains
the structure and the rules required to generate a Hyperion Essbase outline.

e Usethe metaoutline to create and populate a Hyperion Esshase database.

Relational Data Source
OLAP Model
o I —
'_’_Zij Metaoutline
— 1 Iy

B & MARKETS

I MARKETS
BB ACCOUNTS

O PROFIT

O RATIOS ‘

Hyperion Essbase Database

Figure 1-1: Workflow for Creating a Hyperion Essbase Database
from a Relational Data Source
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Components of Hyperion Integration Server

Hyperion Integration Server, pictured in Figure 1-2, consists of two major
components. Hyperion Integration Server Desktop and OLAP Integration Server.

Hyperion Integration Server

Hyperion Integration Server Desktop

OLAP Model OLAP Metaoutline
— (I Assistants and = S.gk;;HKET.HEGIDN
— — | Standard User fi g & Measures
Interface o Profit
I — o Ratios

TCPRAP

TCRIP
- | Hyperion
0 Esshase Server
TCPIP
Relational
Data Source
OLAP Command
Interface
OLAP Metadata )
Catalog Hyperion Essbase

Database

Figure 1-2: Hyperion Integration Server
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Hyperion Integration Server Desktop

Hyperion Integration Server Desktop, a graphical user interface, is used for
creating OLAP models and metatoutlines. Hyperion Integration Server Desktop
includes the following subcomponents:

OLAP Model Assistant: OLAP Model Assistant isawizard for building
centralized and reusable OL AP models that are based on arelational data
source. Therelationa data source consists of the tables and viewsin asingle
relational database and contains the data that you want to report in Hyperion
Esshase.

Use OLAP Model Assistant to create abasic OL AP model. For more complex
model-building functions, such as recursive self-joins, use the standard
Hyperion Integration Server Desktop user interface. Use the OLAP models
that you create from information in the relational data source to build one or
more metaoutlines.

OLAP Metaoutline Assistant: OLAP Metaoutline Assistant is awizard for
creating one or more metaoutlines from an OLAP model. A metaoutline
determines the structure and content of the final Hyperion Essbase database
outline.

Use OLAP Metaoutline Assistant to create a basic metaoutline. For more
complex metaoutline functions, such as scheduling member loads, use the
standard Hyperion Integration Server Desktop user interface. After you create
ametaoutline, you can build a Hyperion Essbase database and |oad datafrom
the relational data source directly into the Hyperion Essbase database.

Note: Thisuser’s guide provides detailed procedures for creating and
editing an OLAP model using the standard user interface. To
create an OLAP model using OLAP Model Assistant, refer to
“Working in OLAP Model Assistant” on page 3-7 (or click
Overview in the Welcome dia og box), the assistant online help,
and the inline help that appears within each assistant tab.

Hyperion Integration Server Desktop standard user interface: The
Hyperion Integration Server Desktop standard user interface is a graphical
user interface for creating OLAP models and metaoutlines. Use the standard
user interface to perform advanced functions, such as performing recursive
self-joinsin an OLAP modée or scheduling member loads for a metaoutline.
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To create an OLAP model using the standard user interface, you must connect
to OLAP Metadata Catalog and the relational data source. For more
information, see Chapter 3, “Creating and Working with OLAP Models.”

OLAP Integration Server

OLAP Integration Server isthe primary component of Hyperion Integration
Server. OLAP Integration Server is software that uses the information stored in
OLAP Metadata Catal og to extract from the relational data source the dimension
and member names needed to build an associated Hyperion Essbase outline. When
the Hyperion Essbase outline is complete, OLAP Integration Server extracts data
fromtherelational data source, performsthe operations specified in the associated
metaoutline, and loads the data into the Hyperion Essbase database. For more
information about OLAP Integration Server, see the Hyperion Integration Server
System Administrator’s Guide.

OLAP Integration Server includes the following subcomponents, asillustrated in
Figure 1-2:

e OLAP Metadata Catalog: OLAP Metadata Catalog is a Structured Query
Language (SQL) relational database that contains the following information:

— Metadata describing the nature, source, location, and type of datato
retrieve from the relational data source

— Metadata describing the information required to generate a Hyperion
Essbase outline

— OLAP models and metaoutlines

Y ou can create more than one OLAP Metadata Catalog to store OLAP
models and metaoutlines. However, you cannot move OLAP modelsand
metaoutlines to a different OLAP Metadata Catal og after you have
created and saved them to a specific catal og.

The OLAP Metadata Catalog is adata source that is configured for Open
Database Connectivity (ODBC). If you do not know how to create an ODBC
data source, see the Hyperion Integration Server Installation Guide or the
ODBC user documentation.

e OLAP Command Interface: OLAP Command Interface is a command-line
tool used to access OLAP Integration Server to perform operations on the
Hyperion Essbase outline and the data in the Hyperion Essbase database. For
more information, see the Hyperion Integration Server System
Administrator’s Guide.
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Workflow for Using Hyperion Integration Server

Figure 1-2 provides an overview of the Hyperion Integration Server components
that you use to prepare the relational datafor OLAP reporting through Hyperion
Essbase OLAP Server.

» To create a Hyperion Essbase database from arelational data source:

1. Build an OLAP model that is based on thetablesin the relational data source.
OLAP Integration Server stores the OLAP model and the information
necessary to retrieve the relevant tables in OLAP Metadata Catal og.

2. Create a metaoutline from the OLAP model. OLAP Integration Server stores
the metaoutline in OLAP Metadata Catal og.

L oad members and data into the Hyperion Essbase database.
4. Update the Hyperion Essbase database with new members and data.

About OLAP Models

An OLAP model contains a star schema. OLAP models are based on the idea that
valuesin arelational database can be categorized as either facts or dimensions of
facts. Facts are the numeric, variable values in the database, such as sales figures
and numbers of units sold. Associated with facts are rel ated data values that
provide additional information, such as store locations and product 1Ds of units
sold. AnOLAP model contains afact table, one or more dimension tables, and one
or more dimension branches. An OLAP model may contain time and accounts
dimensions.

About Hyperion Integration Server OLAP Models

1-10

Unlike other integration products, Hyperion Integration Server creates an OLAP
model that isalogical model, not a physical star schema. The OLAP model is
alogical representation of the data values that you select from the tables in the
relational database and that you want to report in Hyperion Essbase.
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The sample OLAP model included with Hyperion Integration Server, TBC Model,
contains the components shown in Figure 1-3.

* . Hyperion Integration Server Desktop - [OLAP Modell] M =]k
H File Edit “iew Connections Toolz ‘Window Help _|ﬁ||1|
Ded&= & 2e

-3 TEBC.FAMILY -

B TecheReT
- TBC.POPULATION
-E§ TBC.PRODUCT

TBC.PRODUCTDIM = Product
‘E3 TBCREGION =

TBC.SALESFACT
-E3 TBC.SCENARIO
-E TBC.SUPPLIER

1§ SALESFACT

£l

|

= Supplier @8 Accounts |

T ET—
4] | _'|LI

|Data Source: the
Faor Help, press F1 |DLAF' Catalog: TEC_MD i

Figure 1-3: Sample OLAP Model

About OLAP Models and Metaoutlines

Use an OLAP model to create one or more metaoutlines. A metaoutline contains
the basic structure required to build a Hyperion Essbase outline and to load data
into Hyperion Essbase. Y ou can use one OLAP model as the basis for another
OLAP model by saving the original OLAP model under a different name and
editing it as needed to meet reporting requirements. Y ou can create any number of
OLAP models for use in building metaoutlines. However, each metaoutline is
based on one, specific OLAP model.
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OLAP models have the following features:

e They arereusable. You can usethe same OLAP model asthebasisfor multiple
metaoutlines.

e They provide alayer of abstraction that insulates the Hyperion Esshase
database outline from changesin the relational database.

e They enable you to create hierarchies to structure and summarize datafrom a
relational database. You can use the hierarchies in multiple metaoutlines.

About the Fact Table

The fact table serves as a container for all numeric facts (for the measures
datavaluesthat vary over time). In the OLAP model shown in Figure 1-3, the fact
table consists of the SALESFACT relational table, atable that contains sales
figures, cost of goods sold figures, opening and ending inventory quantities, and
other variable measures data columns.

About Dimension Tables

Dimension tables, such asthe Product dimension tables shownin Figure 1-3, serve
as containers for relational tables. Each dimension table contains datathat is
related to the factsin the fact table. For example, the Product dimension tablein
the sample OLAP model contains arelational tablein which the PRODUCTID is
related to the sales figures and inventory quantitiesin the SALESFACT table.

When a dimension table joins to the fact table, the dimension table and all
dimension tables joined to it form adimension. A dimension in an OLAP model
represents a dimension that you want to report in Hyperion Essbase. For more
information on Hyperion Essbase dimensions, see “ About Multidimensional
Databases’ on page 1-3.

When you create a dimension in an OLAP model, the dimension becomes
availablefor usein creating adimension in an associated metaoutline. Y ou can
drag a predefined OLAP model dimension directly into the metaoutline to create
adimension. The newly created metaoutline dimension then becomes adimension
in the Hyperion Essbase outline that you create when you perform a member or
data load.
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When you build ametaoutline, you can create user-defined dimensions that do not
exist in the associated OLAP model. Use this option when you need adimension,
such as Scenario, that does not exist in the relational data source. If you create a
Scenario dimension, you can add both Actual and Budget members to track
measures, such as actual and projected revenue and profit, that may not be stored
in the relational data source. For more information on user-defined dimensions,
see the Hyperion Integration Server Desktop OLAP Metaoutline User’s Guide.

Workflow for Creating an OLAP Model

Before you can create an OLAP model, you must have the following in place:
e A running and properly prepared external data source

e The OLAP Metadata Catalog where you want to store the model that you
create

e A server that isrunning OLAP Integration Server
See the Hyperion Integration Server System Administrator’s Guide.

For more information on making the appropriate connections, see “Working with
OLAP Models’” on page 3-3.

After you make the necessary connections, use the following workflow as
illustrated in Figure 1-4 to create an OLAP model:

1. Start Hyperion Integration Server Desktop and use OLAP Model Assistant or
the standard user interface to create an OLAP model.

See “ Starting Hyperion Integration Server Desktop” on page 3-3 and
“Creating or Editing OLAP Models’ on page 3-4.

2. View alist of sourcetablesin the relational database and select the ones that
you want to use in the OLAP model.

See “Working in the OLAP Model Standard User Interface” on page 3-11.

3. To create an OLAP model that contains a fact table; dimension tables;
dimension branches; and optional time, accounts, and standard dimensions,
drag source tables from the left frame to the right frame.

See Chapter 4, “ Creating the Fact Table, Accounts Dimension, and Time
Dimension” and Chapter 5, “ Creating and Working with Dimensions.”
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4. If required, edit existing dimensions and dimension tables by moving,
renaming, or deleting them.

See Chapter 5, “ Creating and Working with Dimensions.”

5. If required, edit existing columns by creating, transforming, or changing
properties, or by deleting the columns.

See Chapter 6, “Editing Columns in Dimension Tables and the Fact Table”
and Chapter 7, “ Transforming Columns.”

6. If required, set existing columns to be attribute-enabled.
See Chapter 8, “ Setting Attribute-Enabled Columns.”

7. Asnecessary, performjoins, including joining each dimension tableto thefact
table and joining each additional dimension table to aprimary dimension
table, and, for recursive dimensions, joining adimension table to itself. If
tables are properly joined in the data source, you may not need to specify the
joins again.

See Chapter 9, “Joining Dimension Tables.”

8. Asnecessary, organize dimension table columnsinto hierarchiesto define
how Hyperion Essbase consolidates dimensions. When you create ahierarchy,
you can filter, sort, and transform the data in the hierarchy.

See Chapter 10, “ Creating and Working with Hierarchies.”
9. Validate and save the OLAP mode.
See “Validating OLAP Models Manually” on page 3-18.
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Figure 1-4: OLAP Model Workflow
When you are finished, you have a completed OLAP model stored in an OLAP

Metadata Catalog. Y ou use the OLAP model to create a metaoutline, as described
in the Hyperion Integration Server Desktop OLAP Metaoutline User’s Guide.
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Data Sources

An OLAP model is adimensional model of relational datain the form of a star
schema. Before you can create an effective OLAP model, you need to understand
and define the business needs and data sources that you have available. Y ou may
need to modify some data sources to make the transition from relational to
multidimensional as easy and efficient as possible.

For information about creating an OLAP model, see Chapter 3, “Creating and
Working with OLAP Models.”

This chapter contains the following topics to help you prepare relational data:
e “Defining User Needs’ on page 2-2

e “Defining Data Sources’ on page 2-3

e “Consolidating Datainto a Single Data Source” on page 2-4

e “Cleansing Data’ on page 2-6

e “Creating Viewsand Tables” on page 2-6

e “Joining Tables’ on page 2-13

e “Creating Indexes’ on page 2-14

e ‘“Transforming Data’ on page 2-14

e “Deciding Which Tables Are Available to OLAP Model Creators’ on
page 2-16

e “Creating Time and Accounts Dimensions’ on page 2-20
e “Accessing Tablesin OLAP Metadata Catalog” on page 2-23
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Defining User Needs

22l

Before you start to design an OLAP model, consider the questions in this topic.
By carefully defining answers to these questions, you begin to create an effective
OLAP model.

Remember that when you create an OLAP model, the ultimate goal isto create a
multidimensional Hyperion Essbase database. This topic assumes that you are
familiar with the design principles for a multidimensional database. For more
information, see “About OLAP’ on page 1-2 and the Hyperion Essbase OLAP
Server Database Administrator’s Guide.

What information (data) do userswant to seein the Hyperion Essbase
database?

Examples of types of information are orders, sales, invoices, and the general
ledger. Select data by combining an understanding of the business with an
understanding of what datais available. After reviewing the data that you select,
you decide whether to create one or multiple Hyperion Essbase databases.

What isthe maximum level of detail of data that userswant to seein the
Hyperion Essbase database?

Select the level of detail by combining an understanding of the business with an
understanding of the performance reguirements of the Hyperion Essbase database.
(In general, the less detail stored in the Hyperion Essbase database, the faster the
performance.) For example, you can opt to store datathat is aggregated by quarter
or by month. The level of detail that you select isthe basic level of detail that you
represent in the fact table. In an OLAP model, the fact table is where the numeric
measurements of the business are represented.

What dimensions apply to each fact table row?

A dimension is adata category. Typical dimensions are Product, Geography, and
Time. Base the selection of dimensions on an understanding of how users want to
view data. Each dimension hasanumber of members. For example, the Geography
dimension can include members representing New Y ork, Boston, San Francisco,
and Los Angeles. Each row in the fact table represents a combination of members,
one from each dimension. For example, arow in the fact table can store the sales
for Product A in New York in February.
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What measures do you want to represent in the fact table?

Measures are numeric quantities that vary over time. Examples of measures are
guantity sold, cost of goods sold, and profit. Not all numeric values are measures.
For example, athough product sizeis a numeric value, you probably prefer to
represent it as amember of a product dimension rather than as a member of a
measures dimension because users do not want to compare product size over time.

Defining Data Sources

Now that you have defined what data users want to see in the Hyperion Essbase
database, you need to define the data sources. Consider the following questions:

e Isthedataclean? Consider the quality and integrity of the source data. For
more information, see “ Cleansing Data’ on page 2-6.

e Isthedatacalculated by a procedure and not stored; for example, a discount
figurethat is calculated for a specific product at a specific time? You need to
create such information as tables in the chosen relational database
management system (RDBMS). Consider creating a staging area to perform
this task. See “ Deciding Whether to Create a Staging Area” on page 2-4.

e Isthedatain asingle structured query language (SQL) database?

e Isthedatain multiple SQL data sources? OLAP Integration Server does not
access multiple SQL sources; you must consolidate SQL tablesinto asingle
SQL data source in the chosen RDBMS.

e Isthedatainflat files? OLAP Integration Server does not accessflat files; you
need to create flat files as tables in the chosen RDBMS. Consider creating a
staging areato perform this task. See “Deciding Whether to Create a Staging
Ared’ on page 2-4. Alternatively, after you build the Hyperion Essbase
database, you can use Hyperion Essbase Application Manager to load data.
For more information, see the Hyperion Essbase OLAP Server Database
Administrator’s Guide.
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Consolidating Data into a Single Data Source

When you create an OLAP model, al the data that you need must be in asingle
SQL data source.

If al datais not in asingle data source, you need to take the following steps:

1.

Select atarget RDBMSS to connect to the server running OLARP Integration
Server. For alist of supported RDBM Ss, see the Hyperion Integration Server
Installation Guide.

Create any data that does not exist as an SQL data source; for example, create
relational tablesin the chosen RDBM Sfor any information that iscurrently in
flat files.

Consolidate the data source tables into a single database in the chosen
RDBMS.

When you consolidate the data, you may want to create a staging area.

Deciding Whether to Create a Staging Area

A staging area is an RDBMS database that you create to meet the needs of a
specific application. Typically, a staging areais small (a maximum of 1-2 GB)
in comparison to a data warehouse or online transaction processing (OLTP)
application. It is a snapshot of data. In other words, it is not constantly updated
with new data but is refreshed periodically from source data.

2-4 1

Using a staging area provides advantages because you can use a staging areato
perform any of the following tasks:

Combine data from heterogeneous platforms without changing the original
datain the RDBMS. For example, you can combine data from various
RDBMSs and flat files.

Fine-tune data for a specific application. For example, you can calculate a
subset of the RDBM S data and store the calculated datain astaging area. You
can then run faster queries on the pre-calculated data in the staging area.

Create tables or views to denormalize the data so that it maps more easily to
an OLAP model (see “Creating Views and Tables’ on page 2-6).
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e Transform datathat isnot consistently described (see” Transforming Data’ on
page 2-14).

e Preparedatain the staging areafor issuesrelated to the year 2000. Year-2000
issuesmay occur if the RDBM S storesthe year astwo digits (for example, 99)
and not four digits (for example, 1999).

The disadvantage of using astaging areais that the datain the staging areaisa
snapshot and may not represent the current data.

Figure 2-1 shows astaging area as part of adatawarehouse. Datais copied into the
staging areafrom the RDBM S source data and converted from flat files and other

RDBMS sources.
RDEMS RDEMS

9: 9:

Data Cleansing

$

Data Consistency

Staging Area

OLAP Integration Server <:>

Hyperion Essbase Database

Figure 2-1: Data Warehouse with Staging Area
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Cleansing Data

OLAP Integration Server does not cleanse invalid data for you. Data needs
cleansing if it isinconsistent. Inconsistent data may include values that are
incorrect, are not of the correct datatype, or do not match integrity constraints
(contai ning rows that do not have entries for the required key columns). Also, data
may be inconsistent because the same valueis entered in different forms. Such an
inconsistency occurs, for example, when datais drawn from more than one source
or when users enter data incorrectly.

If source dataisinconsistent, you need to fix, or cleanse, the data. Cleansing
data may be a simple process, such as making suspect datainto nulls, or a more
complex processthat requiresthe use of adatacleansing tool. Similar datarequires
similar cleansing rules.

Creating Views and Tables

26

OLAP Integration Server does not distinguish between the tables and the views of
an RDBMS; you can use either tablesor viewsto create an OLAP model. Y ou may
want to create views or tables specifically for use with OLAP Integration Server
to provide security and convenience and to make the transition from relational to
multidimensional as efficient as possible.

Consider creating views or new tablesif you want do either of the following steps:

e If youwant to build a Hyperion Essbase hierarchy down to a specific level in
arecursive table, see “Building Hyperion Essbase Hierarchies from
Recursive Tables” on page 2-8.

e If youwantto create aliasesinthe Hyperion Essbase database from data stored
in multiple columns in the source data tables, see “ Creating Aliases for
Dimension and Member Names” on page 2-19.

Also consider creating views or tablesif the source tables meet any of the
following criteria:

e Thesourcetables contain unions. OLAP Integration Server does not generate
SQL for unions. See “Removing Unions’ on page 2-10.

e The source tables have columns that you want to transpose to rows. See
“Transposing Columns and Rows” on page 2-10.
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e Thesourcetables are in a packaged application. If the sourcetablesarein a
packaged application, you may not know which tables contain the data that
you need because table names may not be meaningful in business terms. You
probably need to ask an application specialist to create the required tables and
views (with meaningful names) in a staging areain the target RDBMS. See
“Deciding Whether to Create a Staging Area” on page 2-4.

e The source tables are highly normalized. Normalized datais appropriately
grouped and does not include redundant data. Consider denormalizing datato
facilitate the transition of the data to a Hyperion Essbase database. See
“Denormalizing Source Data Tables’ on page 2-12.

Deciding Whether to Create a View or a New Table

In most cases, you create views of the relational data (instead of new tables)
because views ensure that datais current and efficiently stored and that you do not
need to maintain two sets of the same data.

When deciding whether to create a view and or whether to create a new table
consider the following questions:

e Doesthedataalready exist? If the data doesnot exist, you need to create anew
table. See “ Consolidating Datainto a Single Data Source” on page 2-4.

e Do youwant to index columns that are not indexed in the source RDBM S
table? You need to create a new table because you cannot index columnsin a
view. See “Creating Indexes’ on page 2-14.

e Do youwant to index columns that contain data that you need to
transform? Because many RDBM Ss ignore indexes on columns that have
transformations, you probably need to create a new table. See “ Transforming
Data’ on page 2-14.

If you are using astaging area, you create tables and views in the staging area. See
“Deciding Whether to Create a Staging Ared’ on page 2-4.
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Building Hyperion Essbase Hierarchies from
Recursive Tables

A recursive table contains information in one row that is a parent or child of
information in a second row. OLAP Integration Server can build Hyperion
Essbase outline hierarchies from arecursive source table.

When creating a Hyperion Essbase hierarchy from arecursive table, use the
following guidelines:

e To associate aliases or user-defined attributes (UDAS) with members created
from arecursive table, ensure that the column with which you will associate
the alias or UDA, isfully defined. See “Creating Aliases or UDAs for
Membersin a Recursive Table” on page 2-8.

e When creating an OLAP model, join the recursive table to itself. For more
information and for an example of arecursive source table, see “ About
Recursive Tables’” on page 10-4 and “ Defining a Recursive Table” on
page 9-15.

e When creating a metaoutline, select the parent or child column that you want
tofilter on asamember level inthe metaoutline. See the Hyperion Integration
Server Desktop OLAP Metaoutline User’s Guide.

Building a Hierarchy Down to a Specific Level

To build the Hyperion Esshase outline down to a specific level, you need to create
aview that contains data for only the levels that you want to build.

Creating Aliases or UDAs for Members in a
Recursive Table

When you create a Hyperion Essbase outline, you can associate aliases or UDAS
with members in the outline.

If you are working with arecursive source table and you want to associate aliases
or UDAswith members created from the recursive source table, you may need to
prepare the data. The stepsthat you need to taketo associate aliasesor UDAsvary,
depending on whether the alias or UDA data is contained in the recursive source
table or in a separate table.
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If thealiasor UDA dataisin a separatetable, you need to complete specific
stepswhen creating an OLAP model. The stepsthat you complete vary, depending
on whether the column, with which you are associating the alias or UDA, isfully
defined (see Table 2-1 and Table 2-2). For more information on the specific steps,
see “ Preparing Recursive Tables to Be Used with Aliases and User-Defined
Attributes’ on page 9-16.

If thealiasor UDA dataisin therecursive sourcetable, you need to complete
specific steps when creating the OLAP model. The column with which you
associatethe aliasor UDA must befully defined, and all aliasor UDA information
must relate to the fully defined column:

If you want to associate an alias or UDA with the parent column of a
recursivetable, the parent column must be fully defined. A recursive table parent
column is fully defined when the parent column contains every value (every
member proposed for the Hyperion Essbase hierarchy). Thus the parent column
contains the lowest-level value in the hierarchy with aNULL valuein the child
column. In Table 2-1, the GEO_PARENT column is fully defined because the
GEO_PARENT column contains the lowest-level value, 01010, withaNULL
child in the GEO_CHILD column.

Table 2-1: Fully Defined Parent Column

GEO_CHILD GEO_PARENT
East USA

Maine East

Bangor Maine

01010 Bangor
<NULL> 01010

If you want to associate an alias or UDA with the child columnin a
recursivetable, the child column must be fully defined. A recursive table child
column is fully defined when the child column contains every value (every
member proposed for the Hyperion Essbase hierarchy). Thus the child column
contains the highest-level value in the hierarchy, withaNULL valuein the parent
column.
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InTable 2-2, the GEO_CHILD columnisfully defined becausethe GEO_CHILD
column contains the highest-level value, USA, with aNULL parent in the
GEO_PARENT column.

Table 2-2: Fully Defined Child Column

GEO_CHILD GEO_PARENT
USA <NULL>

East USA

Maine East

Bangor Maine

01010 Bangor

For more information on the specific steps that you need to perform, see
“Preparing Recursive Tables to Be Used with Aliases and User-Defined
Attributes’ on page 9-16.

Removing Unions

OLAP Integration Server does not generate SQL for unions. A union is atype of
join that combinesthe results of two SELECT statements. A unionis often used to
merge lists of values that are contained in two tables. If the source tables use
unions, you need to create aview (or views) of the datathat does not use the unions
before you can start to work with the datain OLAP Integration Server. For more
information on unions, see the RDBM S documentation.

Transposing Columns and Rows

2-10 m

If you need to transpose columns and rows so that you can more easily transition
data from a data source to a Hyperion Essbase database, transpose the columns
before you start to work with the datain OLAP Integration Server. For example,
if you want to create multiple Hyperion Essbase members from asingle relational
database column, you can create anew table or view that transposes row valuesto
column values.

Consider the following example in which you want to create multiple Hyperion
Essbase measures (Init_Sales, Subsequent_Sales, and Return_Sales) fromasingle
database column (SALESTY PE).
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The SALESACTUAL S table contains the following columns:

Table 2-3: SALESACTUALS Table

PRODID | MKTID TIMEID MONTH SALESTYPE PRODID
100 2 01-01-2000 100.00 | Sales 100
100 2 01-02-2000 10.00 | Returns 100
100 2 01-03-2000 50.00 | Subsequent 100
100 2 01-04-2000 20.00 | Returns 100
100 2 01-01-2000 100.00 | Sales 100

Y ou want to create the Hyperion Essbase outline in the hierarchy illustrated in
Figure 2-2:

[~ Accounts Accounts
[~]Sales

Init_Sales
Subseguent_Sales

Return_Sales
Figure 2-2: Accounts Hierarchy

Y ou want each SALESTY PE value to form the Hyperion Essbase member:
SALES to form the Init_Sales member, RETURNS to form the Return_Sales
member, and SUBSEQUENT to form the Subsequent_Sales member. To achieve
these goals, create aview or anew table that transposes row values into column
values. This example produces the following table:

Table 2-4: View of SALESACTUALS Table with Transposed Columns

PRODID | MKTID | TIMEID INITSALES | RETURNS | SUBSEQUENT

100 2 01-01-2000 100.00 0.00 0.00
100 2 01-02-2000 0.00 10.00 0.00
100 2 01-03-2000 0.00 0.00 50.00
100 2 01-04-2000 0.00 20.00 0.00

Hyperion Integration Server Desktop OLAP Model User’s Guide H 2-11



Preparing Relational Data Sources

The following example of Oracle SQL defines the view shown in Table 2-4:

Create view SalesActuals_vw as
(Select ProdId, MktId, Timeld,
decode (SalesType, 'Sales', Sales, 0) "InitSales",

decode (SalesType, 'Returns', Sales, 0) "Returns",
decode (SalesType, 'Subsequent', Sales, 0)"Subsequent" from
SalesActuals

For moreinformation on using SQL to define views, seethe documentation for the
RDBMS that you use.

When you have defined a new table or view, useit to create an OLAP model.

Denormalizing Source Data Tables

If datais highly normalized, it may not map clearly to an OLAP model.
Normalized datais appropriately grouped and does not include redundant data.
Even though you can use normalized source tables to create an OLAP model by
specifying joins (see Chapter 9, “Joining Dimension Tables’), it may be more
efficient to create a new table of denormalized datain the RDBMS.

Consider thefollowing example. Inthefirst threetables, datais highly normalized
so that redundant data is minimized:

Table 2-5: Normalized Product Family Data

FAMILYID FAMILYDESC
100 Colas
200 Root Beer

Table 2-6: Normalized Product Data

PRODID FAMILYID
100-10 100
100-20 100
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Table 2-7: Normalized Product Description Data

PRODID PRODDESC
100-10 Cola
100-20 Diet Cola

The following table shows the denormalized data in one table:

Table 2-8: Denormalized Product Data

FAMILYID FAMILYDESC PRODID PRODDESC

100 Colas 100-10 Cola

100 Colas 100-20 Diet Cola

100 Colas 100-30 Caffeine Free Cola
100 Colas 100-10 Cola

If you use the denormalized data source, OL AP Integration Server does not need
to compute the joins when it builds the OLAP model.

Joining Tables

In the data source tables, set up primary and foreign keys to join each of the
following tables:

e Jointablesthat form the fact table. See “ Selecting Tables for the Fact Table”
on page 2-17.

e Join tables within each dimension branch. See “ Selecting Tables for
Dimensions’ on page 2-18.

e Join dimension tables to the tables in the fact table.

When you join tablesin the RDBMS, OLAP Integration Server automatically
detects the join when it builds the OLAP model.
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Creating Indexes

OLAP Integration Server detects indexes (including bitmapped indexes) that you
have defined on the source tables and uses them to create a Hyperion Essbase
outline and to load data. Indexes are pointers that are logically arranged by the
values of akey. Indexes optimize accessto relational data. Bitmapped indexes are
specialized indexes that may improve performance during analysis of numeric
data.

Y ou can significantly improve performance by defining indexes on the appropriate
datain the source tables.

Consider taking the following actions to improve performance:

e Defineindexeson columnsthat you useto filter datain the RDBM S source or
inthe OLAP model. For example, if the source database contains columnsfor
city and state and you filter on city or state (for example, SELECT * FROM
Region WHERE State = Ca$%), then index the columns on which you are
filtering (in this example, the columns Region and State). If you are creating
alias names and you filter on alias names, index the column containing alias
names. For moreinformation on alias names, see the Hyperion Essbase OLAP
Server Database Administrator’s Guide.

e Define bitmapped indexes on numeric data that you use to filter the
database. For example, if you filter on sales values (for example, SELECT
Product FROM ProdSales GROUPBY Product ORDERBY ProdId HAVING
SUM (Sales) >15000), then consider defining a bitmapped index on sales
values. Most RDBM Ss support bitmapped indexes. For more information on
bitmapped indexes, see the documentation for the RDBM S you are using.

Transforming Data

2-14 1

Y ou may need to transform some of the data, for example, to change date formats
or to ensure that data is described consistently. Assume that you want to create an
OLAP model that combines data from the sales databases and data from the
financial databases. If the sales databases specify New Y ork asNew_Y ork and the
financial databases specify New York asNY, you cantransform NY to New_Y ork
inthe staging area (see “ Deciding Whether to Create a Staging Area’ on page 2-4)
without changing the datain the original financial databases.
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Y ou can do some data transformations in OL AP models and metatoutlines.

For acomplete list of available transformations, see Chapter 7, “ Transforming
Columns,” and the Hyperion Integration Server Desktop OLAP Metaoutline
User’s Guide. However, if you need to do significant transformations on the data,
you may want to use a data transformation tool before you use the datain OLAP
Integration Server.

Transformations that you need to perform in the RDBMS, and not in Hyperion
Integration Server, include the following items:

e The most frequently accessed transformations

For example, assume that you want the Hyperion Essbase database outline to
have membersfor Y ear, Qtr, and Month and that the data sourcetabl e contains
acolumn caled TRANSDATE. TRANSDATE holds the transaction date for
each row. Transform the data ahead of time, creating a new source table that
contains the columns Y EAR, QTR, and MONTH. The new columns contain
the datatransformed from the TRANSDATE column. Y ou can then index the
YEAR, QTR, and MONTH columnsto improve performance.

Note: Many RDBM Ssignore indexes on columns that have
transformations. You need to transform the data and create a
physical table with new columns that can be indexed.

e Transformationsto take the intelligence out of key columns

Some key columns may include categories of information that you want to
split out before using the datain OLAP Integration Server. For example, if the
source table has a PRODID column containing product identification
information, transform the datain the RDBMS so that it mapsto the data
categories that you want to display in the Hyperion Essbase outline. In
Figure 2-3, for example, the categories are CUSTID, STATE and
PRODNUM.

C0001-52-95124

CustlD 4 T \— Prodhum

State

Figure 2-3: Transforming a Product Code Stored in a PRODID Column
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Deciding Which Tables Are Availableto
OLAP Model Creators

2-16 |

When you connect to the source database, OL AP Integration Server displaysinthe
left frame all tables to which the RDBM S user ID provides you access (SELECT
permission).

For all RDBMSs, if you have partial accessto atable, OLAP Integration Server
displaysthe whole table. (For example, if you have SELECT permission for only
half of the columnsin atable, you can seethe wholetable.) However, inthe OLAP
model, do not use a column to which you do not have SELECT permission. OLAP
Integration Server cannot filter, dataload, or member load a column for which you
do not have SELECT permission.

Note: For DB2, OLAP Integration Server displays al tablesthat arein the
database, irrespective of whether you have accessto them. However,
if you do not have access (SELECT permission) to atable, you cannot
view the columns in the table or use the table to build an OLAP
model.

For added security and ease of administration, you may want to define which
tables the users can see by doing one or more of the following actions:

e Create specific RDBMS user IDs for users who are creating OLAP models.

e Createviewsof somedataand providing userswho are creating OLAP models
with access to the views rather than access to the original tables.

e Useconditions to restrict aview so that users who are creating an OLAP
model can see only asubset of the view. For example, you can restrict the view
to show dataonly for the current year although the table contains datafor three
years. For more information on adding restrictive conditions, see the
documentation for the RDBMS that you use.

Note: When you connect to the source database, OLAP Integration Server
provides read-only access to the source database irrespective of the
access provided by the RDBM S user ID. For example, if theRDBM S
user 1D has read-write access, you have only read-only access when
creating OLAP models.
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Selecting Tables for the Fact Table

A fact tableisalogical container for therelational tablesthat definethe datavalues
(measures) for each dimension intersection in an OLAP model. For more
information, see “ About the Fact Table” on page 1-12. The type of Hyperion
Essbhase database that you want to create determines which source tables you need
toincludein the fact table. See “Defining User Needs’ on page 2-2.

When you select source tables to include in the fact table, consider both how the
datais distributed among the tables and how the data relates to the dimensionsin
the Hyperion Essbase database.

Select atable or tablesthat contain all of the measures data that Hyperion Essbase
end users want to see. For example, if the relational database contains the
following ORDERS and ORDERDETAIL Stables, you need to include both tables
if you want the fact table to include data from both tables.

Table 2-9: ORDERS and ORDERDETAILS Tables for the Fact Table

Orders ORDERID TRANSDATE SHIPID EMPTYID

Order Details ORDERID PRODID NUMUNITS UTPRICE

Select atable or tables that represent all of the dimensions (data categories) on
which the Hyperion Essbase end users want to analyze data. For example, if end
users need to analyze product sales by time, by geography, and by sales channel,
select atable or tables that contain key columns for each of these dimensions.

Table 2-10: Sales Table for the Fact Table

PRODID | SALES | DATESOLD | CITY CHANNEL | UNTSSOLD

Sales

Note: You canimprove performance by setting up primary and foreign keys
and joining the tables that form the fact table. See “ Joining Tables’
on page 2-13.
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Selecting Tables for Dimensions

A dimension is a data category. Typical dimensions are Product, Geography,
and Time. A dimension tableisalogical container within an OLAP model.

A dimension table includes one or more relationa tables that define a potential
Hyperion Essbase dimension. A dimension table can join to other dimension
tables, forming a dimension branch.

The datathat you want to be available for analysisin the Hyperion Essbase
application that you create determines which source tables you use to create
dimensions. See “Defining User Needs” on page 2-2. When you select source
tablesfor each dimension, select asourcetable or tablesthat include the maximum
amount of information about the data category (dimension). For example, if you
have the following PRODUCTS and ORDERS source tables, select the
PRODUCTS table to form the Products dimension.

Table 2-11: ORDERS and PRODUCTS Tables for the Dimension Table

Products PRODID PRODNAME SIZE COLOR

Orders PRODID PRODNAM ORDERID DATE

The ORDERStable contains product information for only those productsthat have
been sold. The PRODUCT Stable contains data for all products. Thus, Hyperion
Essbase end users can use the PRODUCT S table information to analyze products
that are or are not selling.
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Creating Aliases for Dimension and Member Names

Aliases are aternative names for the members and dimensions of a Hyperion
Essbase outline. An dliasis often a more easily identifiable product name or
product description for a column in arelational data source. For example, in

the Hyperion Essbase Sample Basic database, the 200-20 member in the Product
dimension has the alias Diet Root Beer.

If the source data contains information that you want to use to create aliasesin a
Hyperion Essbase outline, include the relevant data as a column in the associated
OLAP modd.

When you create a metaoutline, you can retrieve alias information from only one
column in the OLAP model. If the alias information in the source dataisin more
than one column, complete one of the following data preparation procedures:

e IntheRDBMS, createaview or anew tableto concatenate (and, if necessary,
transform) the alias information into a single column. Creating aview or new
table may bethe easiest method, especially if thealiasinformationisstoredin
three or more columns.

e Inthe OLAP model, concatenate (and, if necessary, transform) the columns
that contain the aliasinformation. For more information on concatenating and
transforming columns, see Chapter 7, “ Transforming Columns.”

e Inthe OLAP model, use the pass-through feature to run a procedure that uses
RDBMS logic to retrieve aias information from the column or columns that
you specify. For example, you can use the pass-through feature to run a
procedure in DB2. The DB2 procedure uses CASE logic to retrieve alias
information from two different columns; if afield in one columnis empty, the
proceduretellsthe RDBMSto retrieve the aliasinformation for that field from
adifferent column.

For more information, see “ Defining Pass-Through Transformations” on
page 7-14. For more information on procedures and CA SE logic, see the
RDBMS documentation.

Note: You can associate one aliastable for each Hyperion Essbase database
that you create using Hyperion Integration Server.
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Creating Time and Accounts Dimensions

In an OLAP model, you can create time and accounts dimensions that carry over
directly to the Hyperion Esshase outline as the dimensions tagged as time and
accounts. The time dimension table contains date-related columns from the
relational data source. The accounts dimension table contains measures columns
that duplicate the columns contained in the fact table.

Preparing Data for Time Analysis

If the business application requirestime-rel ated analysis, such as examining trends
over time or making seasonal sales comparisons, include atime dimension in the
Hyperion Essbase outline. A time dimension includes members for the time
periods that you report on; for example, monthly, quarterly, and yearly sales.

To support atime dimension, the data source should include the following
elements:

e The data source should include one or more time-related columns associated
with measures data. For example, if you want to report on sales per month and
per quarter, one of the tables that you include in the fact table needs a date
column to reflect sales by month and quarter.

e If needed, the data source should include one or more tables containing
user-defined calendars. A user-defined cal endar mapsthetime-related column
in the fact table to a specific business calendar.

Associating Time Data with Measures Data

To enable OLAP Integration Server to map the data that you are measuring (such
as sales or costs) to specific time periods (such as month, quarter, or year), the
source data for the fact table must contain one or more time-related columns. For
example, from a transaction date column, you can determine the day, week, and
month in which the associated transaction occurred. Or, the transaction data can
include separate columns for each time period. These time periods are potential
members of the dimension tagged as time.
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Working with Summary Data

If the measures columnsin the source data contain summary data, the time-related
column must indicate the time period for which the data is summarized. For
example, assume that the SALESINVACT table contains measures columns
SALES and COGS, adate-related column, TRANSDATE, and STATE and
PRODCODE columns that categorize by sales date, state, and product code.

Table 2-12: TBC_MD Data in the SALESINVACT Table

STATE | PRODCODE TRANSDATE SALES | COGS
IL 100-10-C001-S0002-P001 Jan 4 2000 12:00AM 672.00 | 217.00
IL 100-10-C001-S0002-P0O01 Feb 4 2000 12:00AM 241.00 | 70.00
IL 100-10-C001-S0002-P0O01 Mar 3 2000 12:00AM 287.00 | 84.00
IL 100-10-C001-S0002-P0O01 Apr 7 2000 12:00AM 295.00 | 85.00
IL 100-10-C001-S0002-P0O01 May 3 2000 12:00AM 702.00 | 207.00

Each row in the SALESINVACT table summarizes product sales and costs for a
particular date for customers from a particular state. Instead of summarizing data
by day, arow can summarize data by other periods; for example, by week or by
month.

Formatting the Date

OLAP Integration Server supportsthree data types: string, numeric, and datetime.
“About Column Data Types’ on page 6-3 shows how the basic Open Database
Connectivity (ODBC) data types map to four data types within Hyperion
Integration Server: text, numeric, Boolean, and datetime. The datetime data type
is atimestamp that includes the year, month, day, and time of day.

The data type of the source data column that contains time-related data does not
matter. For example, the date can be atimestamp in acolumn with adatetime data
type, or it can be keyed data in anumeric column (for example, 09232000 or
20000923). A string column can contain dates with or without separating
characters such asslashes or periods (for example, 09/23/20000r23.09.2000
or 09232000). Portionsof the date (such asthe day, week, month, or quarter) can
beincluded in the source data as separate string or numeric columns.
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It isimportant that the valuesin the time-related columns can be mapped to the
time periods that you want in the time dimension. If dates are stored as datetime
data types and you want quarterly totals, OLAP Integration Server can determine
the quarter. If dates are stored in numeric or string columns and you want quarterly
totals, you must have an explicit column containing the associated quarter for the
data that you want to consolidate.

Working with Data in Similar Time Periods

In certain applications, such as general ledger and legacy systems, tables may be
organized so that columnsidentify similar time periods. For example, asinglerow
may include all months of ayear. In this case, each subsequent row includes a
measure category as a data value; for example, a specific account number.

Table 2-13: Example of a Table Where Columns Define the Time Periods

PRODCODE STATE ACCOUNT | JAN FEB MAR

100-10-C001-S002-P0O01 AZ Sales 672.00 | 241.00 | 287.00
100-10-C001-S002-P001 AZ COGS 403.00 |132.00 | 177.00
100-10-C001-S002-P001 CA Sales 401.00 | 143.00 | 378.00
100-10-C001-S002-P001 CA COGS 260.00 | 101.00 | 226.00
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To create adimension of the type time, OLAP Integration Server requires that all
time identifiers be in one column and that accounts identifiers be in separate
columns, as shown in Table 2-14. If, for example, datais stored with each month
asan individual column, as shownin Table 2-13, you should restructure the data.
Individual months should be data valuesin aMONTH column, and the measure
categories, such as SALES and COGS, should be separate columns.

Table 2-14: Example of a Table Where Time Periods
Are Stored as Data Values

PRODCODE STATE MONTH SALES COGS
100-10-C001-S002-P0O01 AZ 1 672.00 403.00
100-10-C001-S002-P0O01 AZ 2 241.00 132.00
100-10-C001-S002-P001 AZ 3 287.00 177.00
100-10-C001-S002-P001 CA 1 401.00 260.00
100-10-C001-S002-P001 CA 2 143.00 101.00
100-10-C001-S002-P0O01 CA 3 378.00 226.00
100-10-C001-S002-P001 AZ 1 672.00 403.00

Y ou can write a program to convert the data to a table that uses the appropriate
format or use an RDBM S to transpose the columns (see “ Transposing Columns
and Rows’ on page 2-10).

Accessing Tables in OLAP Metadata Catalog

If youlog onwith aparticular user ID whenyou create an OL AP Metadata Catal og
and then log on with adifferent user ID, you cannot accessthetablesin the OLAP
Metadata Catal og unless you create an aias for the user ID (Sybase, SQL Server)
or synonymsfor thetables (DB2, Oracle). For moreinformation, seethe Hyperion
Integration Server Installation Guide.

Y ou must perform adifferent procedure when time measures are stored as columns
that include accounts information, as described in “ Switching the Time and
Accounts Dimensions’ on page 4-14.
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Creating and Working with
OLAP Models

Thischapter describes how to create and work with OL AP models—from opening
or creating an OL AP model through validating and saving an OLAP model. Before
you read this chapter, read Chapter 1, “ About Hyperion Integration Server” to
familiarize yourself with the definition and components of an OLAP model.

This chapter contains the following topics:

“Understanding the OLAP Model Workflow” on page 3-2

“Working with OLAP Models’ on page 3-3

“Working in OLAP Model Assistant” on page 3-7

“Working in the OLAP Model Standard User Interface” on page 3-11
“Validating OLAP Models Manually” on page 3-18

“Saving OLAP Models’ on page 3-20

“Printing OLAP Models’ on page 3-29

“Deleting OLAP Models’ on page 3-30
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Understanding the OLAP Model Workflow

Figure 3-1 illustrates the workflow for creating an OLAP model. This workflow
includes creating and working with an OLAP model; creating afact table, an
accounts dimension, and atime dimension; creating and working with dimensions;
editing and transforming the columns of dimension tables; joining dimension
tables; and creating and working with hierarchies. This chapter focuses on how to
create an OLAP model and manage existing OLAP models.

Creating F={als Bl * . Hyperion Integration Server Desktop - [TBC Model]
Working W|th ::= File Edit “iew Connections Tools 'Window Help
OLAP models | DEE 8]0 & [#] 22 | |

=-F1 THCFAMILY | /
E-F TECMARKET

* . Hyperion Integration Server Desktop - [TBC Model]
::= File Edit “iew Connections Toolz ‘Window Help

DEE|&] & [#] 2] 2 | /

TEC.FAMILY | /
- TECMARKET @Q
= MARKET | [@vear |
Creating and working M SALESPACT TE_E. Accounts
with dimensions = PRODUCT | % | SCENARIO |

Table Properties

You Are Here

Creating a fact table,
an accounts dimension,
and a time dimension

General Columns | PhysicalJoinsI

| Table Mame | Column Marme | Hidden
Enec CAFFEINATED TBC.PRODUCT  CAFFEINATED

B FAMILYID TBC.PRODUCT  FAMILYID

Editing and transforming
columns

Table Properties

General Columns | PhysicalJoinsI

| Table Mame | Column Marme | Hidden
Enec CAFFEINATED TBC.PRODUCT  CAFFEINATED

Be: FAMILYID TEC.PRODUCT  FAMILYID

B@INTRODATE  TECPRODUCT INTRODATE

Edit Hierarchy
Mame:

IYEAH-DUAHTEH-MDNTH

Joining dimension tables

E% rear
EH&) Timne. Quarter

Creating and working
- Time.Manth

with hierarchies

Figure 3-1: OLAP Model Workflow
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Working with OLAP Models

Before you start working with an OLAP model, make sure that the OLAP
Metadata Catalog where your OLAP model will be stored, the server on which
OLAP Integration Server is running, and the data source are accessible. These
items can be on servers on a network; they do not need to be on your local
computer to be available to Hyperion Integration Server Desktop. For more
information, see the Hyperion Integration Server System Administrator’s Guide.

To work with an OLAP model, start Hyperion Integration Server Desktop and
choose whether to use OLAP Model Assistant (to be guided through creating or
editing an OLAP model), or to use the OLAP Model standard user interface (to
create or edit an OLAP model without guidance). For more information, see

“ Starting Hyperion Integration Server Desktop” on page 3-3 and “ Creating or
Editing OLAP Models’ on page 3-4.

Starting Hyperion Integration Server Desktop
To start Hyperion Integration Server Desktop, use any of the following methods:
e From the Windows Start menu, select Hyperion Integration Server Desktop.

B
e Double-click the Hyperion Integration Server Desktop icon, &%.

e Onthe command line, type the executable name (olapbldr).

For example, if Hyperion Integration Server Desktop isinstalled in the
\hyperion\is\bin directory, type the following path:

\hyperion\is\bin\olapbldr
Note: The default client directory, which is specified during instalation is
\hyperion\is. Your application may have adifferent installation

directory. Consult the person who installed Hyperion Integration
Server at your site if you are not sure of the directory specification.

Now you can start working on an OLAP model. See “Creating or Editing OLAP
Models’ on page 3-4.
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Creating or Editing OLAP Models

To create or edit OLAP models, start Hyperion Integration Server Desktop and
connect to OLAP Integration Server, an OLAP Metadata Catal og, and a data
source.

For more information about connecting to OLAP Integration Server, OLAP
Metadata Catalog or a data source, see the Hyperion Integration Server
Installation Guide. If you have problems connecting, see “ Correcting Connection
Problems” on page 3-6.

If you just started Hyperion Integration Server Desktop, the Welcome dialog box
that you use to choose whether to create or edit an OLAP model opens
automatically.

If you are already running Hyperion Integration Server Desktop and are connected
to OLAP Metadata Catal og, select File> New or File> Open to open the Welcome
dialog box.

Using OLAP Model Assistant is the quickest, easiest way to create basic OLAP
models or to edit OLAP models. If, however, you want to perform more complex
tasks, you must use the OLAP Model standard user interface. For more
information, see “Tasks That Cannot Be Performed Using OLAP Model
Assistant” on page 3-10.

» To use OLAP Model Assistant to create anew OLAP model:

1. Select the Model Assistant icon, s,

2. If you want to place write-lock privileges on the OLAP model, select
Exclusive Access.

Exclusive Access enables you to modify and save the OLAP model. If
Exclusive Access is not selectable, another user has write-lock privileges
and you have read-only or no privileges.

3. Click Open.
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» To use OLAP Model standard user interface to create a new OLAP model:

1. Select the Model icon, Hodsl,

2. If you want to place write-lock privileges on the OLAP model, select
Exclusive Access.

Exclusive Access enables you to modify and save the OLAP model. If
Exclusive Accessis not selectable, another user has write-lock privileges and
you have read-only or no privileges.

3. Click Open.

» To use OLAP Model Assistant to edit an OLAP model:
1. Inthe Welcome dialog box, select the Existing or Recent tab.

2. Select the OLAP model name. For more information about the OLAP model,
look in the Details group box.

Make sure that Open with Assistant is selected.

4. If you want to place write-lock privileges on the OLAP model, select
Exclusive Access.

Exclusive Access enables you to modify and save the OLAP model. If
Exclusive Accessis not selectable, another user has write-lock privileges and
you have read-only or no privileges.

5. Click Open.

6. If necessary, log on to the appropriate data source.

» To use OLAP Model standard user interface to edit an OLAP model:
1. Inthe Welcome dialog box, select the Existing or Recent tab.

2. Select the OLAP model name. For more information about the OLAP model,
look in the Details group box.

Make sure that Open with Assistant is not selected.

4. If you want to place write-lock privileges on the OLAP model, select
Exclusive Access.

Exclusive Access enables you to modify and save the OLAP model. If
Exclusive Accessis not selectable, another user has write-lock privileges and
you have read-only or no privileges.
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5. Click Open.

6. If necessary, log on to the appropriate data source.

Correcting Connection Problems

If you have problems connecting from Hyperion Integration Server Desktop to
OLAP Integration Server, OLAP Metadata Catal og, Hyperion Esshase server, or
the data source, use the following checklist to help diagnose the problem:

e Wasthe server temporarily down or not available? Try again to connect.

e Didyou enter the correct server name? Your network configuration
may reguire a fully-qualified internet host name; for example,
myserver.mycompany .Ccom.

e Didyou enter the correct user name and password? Passwords are usually
case-sensitive. Make sure that the Caps Lock key is not activated.

e Do you have anetwork connection to the server? Check your network
connection by using the ping command. See Microsoft Windows online help
for more information about using ping.

If the above steps do not resolve the problem, contact your database administrator
or system administrator. For more information about troubleshooting server
connections, see the Hyperion Integration Server System Administrator’s Guide.

36 W Hyperion Integration Server Desktop OLAP Model User’s Guide



Creating and Working with OLAP Models

Working in OLAP Model Assistant

OLAP Model Assistant isawizard that steps you through creating or editing an
OLAPmodel quickly and easily. OLAP Model Assistant contains multipletabs. If
you are creating an OLAP model, complete the tabs and their tasks in order.

After you complete the required tasksin all tabs, you have avalid OLAP model
that you can use to create one or more metaoutlines. If you are editing an existing
OLAP model, work through the tabs in any order to revise the model as needed.

When you open OLAP Model Assistant, it displays the first tab, Select Fact

Table, as shown in Figure 3-2.

® .. OLAP Model Assistant - New

Tatle Hierarchies
Maintenance

1.5elect Fact Table | 2. Select Time

Type a name to describe the table that contains facts and the accounts dimengion.

Mame

Accounts

Select the tables that will be used to create the fact table and the accounts dimension.

Available Relational Tables Selected Relational Tables

[ [ x]

Finizh

TBC.FAMILY =]
TBC.MARKET =
TBC.POPULATION E
TBC.PRODUCT AI
TBC.PRODUCTDIM

TBC.REGION iy
TBC.SALESFACT —I
TBC.SCENARIO

TBC.SUPPLIER

-3 SvYSCATATTRIBUTES hd|

IScreen 1of10 Help | Save | Cancel

< Back |

Mest » |

Figure 3-2: Select Fact Table Tab in OLAP Model Assistant
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Process Graphics

The process graphics along the top of OLAP Model Assistant represent related
tasks. When you create an OL AP model, the tasks must be completed in order from
left to right. After you complete all the tabs that a process graphic represents, the
next process graphic becomes accessible and you can begin work on the task
within that task group. When you edit an existing OLAP model, all process
graphics are clearly displayed and all tabs are accessible.

Note: For best visibility of the OLAP Model Assistant process buttons, a
color palette of 65536 colors is recommended. To set this palette,
select Start > Settings> Control Panel. Double-click the Display icon,
select 65536 from the Color Pd ette drop-down list, click Apply, and
then click OK. (Your PC may not support a palette of 65536 colors.)

Inline Help Text

Each tab contains brief descriptions of the tasks that you need to perform. If you
need additional information on atask, click the Help button.

Tasks to Complete

Each tab contains tasks that you must complete to define a particular part of an
OLAP model. In the first tab, for example, you must select the table to use as the
fact table. For help on using any tab, click the Help button.

OLAP Model Assistant contains the following tabs:

Table 3-1: OLAP Model Assistant Tabs

Tab Name More Information

Select Fact Table “About the Fact Table” on page 4-3

Select Time “About the Time Dimension” on page 4-8

Name Dimensions “Creating Dimensions’ on page 5-3

Select Relational Table “Adding Source Tablesto Create Dimension
Branches’ on page 5-6

Fact Table Joins “About Joins’ on page 9-3

Dimension Table Joins “About Joins’ on page 9-3
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Table 3-1: OLAP Model Assistant Tabs (Continued)

Tab Name More Information
Edit Tables Chapter 6, “Editing Columnsin Dimension
Tables and the Fact Table”
Define Hierarchies “About Hierarchies’ on page 10-3
Preview Hierarchies “Previewing the Hyperion Essbase Outline” on
page 10-27
Finish “Saving OLAP Models’ on page 3-20
Buttons
The following buttons are always displayed along the bottom of OLAP Model
Assistant:

e Help button. Click to view detailed help for the selected tab. The help
describes each field in the OLAP Maodel Assistant tabs and explainswhat you
must do to complete the tasksin the sel ected tab before moving to the next tab.

e Savebutton. Click to savethe OLAP model. You can save an OLAP model in
any tab and then continue to move through the other tabs. Changes that you
made to all previous tabs are saved.

When you save an OLAP model, it is validated automatically. Y ou can save
an OLAP model with validation problems, but you cannot use the OLAP
model to create metaoutlines.

e Cancel button. Click to close the OLAP model without saving. Changes that
you saved in previous tabs are not discarded. Changes in previous tabs that
have not been saved are discarded, as are al changes in the current tab.

e Back button. Click to move to the previous tab. You can move back through
previous tabs and make changes at any time.

e Next button. Click to moveto the next tab. If you are creating an OLAP model
and have not completed all mandatory tasksin atab (such as selecting afact
table), you cannot move to the next tab.
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Tasks That Cannot Be Performed Using
OLAP Model Assistant

Y ou cannot use OLAP Model Assistant to perform thefollowing tasks. If you need
to perform these tasks in an OLAP model, use the OLAP Model standard user
interface.

3-10 m

Create an OLAP model that contains attribute dimensions.

Create an OLAP model that contains dimension branches. If you want to add
multiple dimension tables to adimension, you must combine the tables.

Create afact table or an accounts dimension from multiple source tables.
Join adimension tabletoitself; that is, perform arecursive self-join on atable.

Manually validate the OLAP model at any time during the creation or editing
process.

Set up to switch the time and accounts dimensions.

Rename a dimension table; that is, give a dimension table a name other than
the source table name.

Rename an existing dimension.

Delete columns or rename columns.

Create drill-through or user-defined columns.

Define retrieval optimization preferences for Oracle databases.
Filter, port, or transform columns in hierarchies.

View relational source table data.

Note: Thisuser’s guide provides detailed procedures for creating and

editing an OLAP model using the standard user interface. To create
an OLAP model using OLAP Model Assistant, refer to the assistant
overview information (click Overview in the Welcome dialog box),
to the online help, and to the inline help that appears within each
assistant tab.
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Working in the OLAP Model Standard
User Interface

To create an OLAP model using the standard user interface, you must connect to
OLAP Metadata Catalog and the to relational data source. For more information,
see “Working with OLAP Models’ on page 3-3. After you click the OLAP Model
icon, Hyperion Integration Server Desktop displays the OLAP Model main
window, as shown in Figure 3-3. The window displays source tablesin the left
frame and a blank modeling area in the right frame.

* . Hyperion Integration Server Desktop - [DLAP Modell] M= 3
::= File Edit “iew Connections Toolz ‘Window Help _|ﬁ||1|
D@l (&[0 a2 ]®
(-3 TBCRAMILY -
+--F3 TBC.MARKET
+-[] TBC.POPULATION
-3 TBC.PRODUCT
[-E3 TBC.PRODUCTDIM
[-E3 TBCREGION
-3 TBC.SALESFACT
-3 TBC.SCENARIO
=-EJ TBC.SUPFLIER
K — _>l_I
|Data Source: TBC
Faor Help, press F1 |DLAF' Catalog: TEC_MD i

Figure 3-3: OLAP Model Main Window
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Left Frame

312 .

Theleft frame displays alist of sourcetables. Y ou can use the listed source tables
to create an OLAP model. Y ou can view tables, views, and synonyms in the left
frame. Although you can view tables, views, synonyms, or any combination of
tables, views, and synonymsin the left frame, this guide refers only to tables.
Whenever tablesin the left frame are discussed, synonyms and views are implied.
To view synonyms, select View > Show Synonyms.

The name of each table in the relational data source is displayed after a plus
symbol, [, or minus symbol, =

e Theplussymbol, [ indicates that you can expand the table to see the
columnsit contains. For example, if MARKET is not expanded, clicking
MARKET expands the table to show STATE, STATEID, and so on.

e Theminussymbol, (=], indicatesthat you can collapse the table. For example,
if MARKET is expanded, clicking MARKET collapses the table to show the
table name but not the table columns.

Y ou can view the contents of atable in the Ieft frame in the following ways:
e Select thetable and select View > View Table Data.
e Select thetable, right-click, and select View Table Data.

For more information, see “Viewing Table Data” on page 3-17.
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Right Frame

Theright frameiswhere you build an OLAP model. Y ou drag source tables from
theleft frameto theright frameto create afact table, accounts dimension, optional
time dimension, standard (default) dimensions, and dimension branches.

When you create an OLAP model, the relational tables that you drag to the right
frame become the fact table and the dimension tables. Y ou can add, hide, delete,
transform, and perform other operations on columns in these dimension tablesto
refine the data that you want reported in Hyperion Essbase. After you complete
and save an OLAP model, open it to create a metaoutline. At that time, the
dimension tables can become dimensions.

Tools and Toolbars

Use the dual-function Join tool, .d , on the toolbar to add joins between tablesin
an OLAP model or to move objectsin an OLAP model. The default position for
the Join tool is Move mode. To switch between Move mode and Add Joins mode,
click the Join tool.

Use the toolbar to perform commonly used functions. For more information

on individual toolbar buttons, click Help. To hide the toolbar, deselect View >
Toolbar. In the menu, the check mark next to Toolbar is removed, and the tool bar
disappears. To redisplay the toolbar, select View > Toolbar.

The toolbar is not attached to the edge of the program window. Y ou can move it
by selecting it and dragging it to a new location. Y ou can also change the shape
and size of thetoolbar.

Menus
Use the menu bar to perform commonly used commands.

Use the pop-up menu that opens when you right-click an object to perform
operations on the selected object.
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Status Bar

The status bar identifies the data source and the OLAP Metadata Catalog to which
you are connected and displays other status information. To hide the status bar,
deselect View > Status Bar. In the View menu, the check mark next to Status Bar
isremoved, and the status bar disappears. To redisplay the status bar, select View
> Status Bar.

OLAP Model Dimension Table Graphics
The following graphics identify dimension tables in the OLAP model:

E identifies the fact table as the table containing measures values for the
OLAP model.

3 identifiesatime dimension.
[7=]  identifies an accounts dimension.

Il identifiesastandard dimension table.

For illustrations and explanations of the graphics that identify relational data
source columns, see “Viewing Column Properties’ on page 6-4.
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Display of Column Names

Normally, thetablesin therelational datasource are displayed in acollapsed view
in the left frame of the OLAP Model main window, as shown in Figure 3-4.

* . Hyperion Integration Server Desktop

::= File Edit “iew Connections Tools

0 & | &) & | 2

-3 TBCFRAMILY

‘B TBC.MARKET

-E TEC.POPULATION
-E TEC.PRODUCT
TBC.PRODUCTDIM
-E TBC.REGION

-Ed TBC.SALESFACT
-E3 TBC.SCEMARIO
-E TBC.SUPPLIER

£l

Faor Help, press F1

Figure 3-4: Collapsed Table View in Left Frame

Asyou create afact table or adimension table, you can display the names of the
source columnsthat the table contains. Y ou can use thisinformation to ensure that
you have selected the correct table from the relational data source. Display the

contents of the table by selecting the table and then selecting View > View Table

Data or by clicking the plus symbol, [, to the I&ft of the table name.

Note: When you display columnsin the left frame, OLAP Integration
Server displays only certain ODBC data types. For acomplete list,
see “About Column Data Types’ on page 6-3.

The following topics describe the methods that you can use to display column
names and contents:

e “Displaying Column Namesin the Left Frame” on page 3-16 describes how
to display table columns as they are displayed in the original relational data
source.

e “Viewing Table Data’ on page 3-17 describes how to display the data of the
selected relational table.

e “Displaying Column Namesin the Right Frame” on page 3-18 describes how
to display table columns after you have added the tables to an OLAP model.
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Displaying Column Names in the Left Frame

» To display the column names of arelational table:

1. Expand thetable by clicking the plussign, !, in front of the table.
The table expands to include an alphabetical list of columns, as shown in

Figure 3-5. A graphicidentifies each column asacolumn, m, or asaprimary

key, &9 In this example, the TBC.MARKET and TBC.POPULATION
tables are expanded. Y ou can expand as many tables as you want and scroll
through each table to display column and key names.

* . Hyperion Integration Server Desktop
::= File Edit “iew Connections Tools

o2 [# 2|

TBEMAHKET
EH POPULATIONID
FH REGIONID
~FH STATE
Lem STATEID
B l TEC.POPULATION

-
-
-
-
-
-

Faor Help, press F1

Figure 3-5: Expanded Columns in the Left Frame

2. Intheleft frame, right-click and select Show Views, Show Tables, or Show
Synonyms to display views, tables, or synonyms (aliases).

e Aviewisalogical table created by combining columns from one or more

tablesin the relational data source (see “Creating Views and Tables’ on
page 2-6).

e Synonyms are displayed only for RDBM Ss that support synonyms
(aliases).

3-16 W Hyperion Integration Server Desktop OLAP Model User’s Guide



Creating and Working with OLAP Models

e Althoughyou candisplay tables, views, synonyms, or any combination of
tables, views, or synonyms in the left frame, this guide refers to tables.
Whenever tables in the left frame are discussed, synonyms and views are
implied.

3. Click the minussign, E|, in front of the table to collapse it.

Viewing Table Data

» To display the contents of atable that islisted in the left frame:
1. Select thetable, right-click, and select View Table Data.

Hyperion Integration Server Desktop displays the View Table Data dialog
box, as shown in Figure 3-6. The View Table Data dialog box displaysthe
first 100 rows of the selected source table.

Source  [TEC Table |TBCMARKET
STATEID | REGIONID | sTATE | PO~
1 1 Mew vork 7
2 1 Maszachusetts 3
3 1 Florida 5
4 1 Connecticut 2
5 1 Mew Hampshire 1
B 2 Califorria 1
7 2 Oregon 2
8 2 Washington 2
| 2 Utah 1
10 2 Mevada 1
1 3 Texas 7
12 3 Oklahoma 2
13 3 Loviziana 1
14 3 Mew Mexico 1
15 4 Winoiz 4
18 4 Ohio 4 |
17 4 Wisconsin 2
18 4 Miszouri 2
19 1 lowa 1_|;|
1 3
Fows 0-19
Brevious | ezt | = e | | Help |

Figure 3-6: Viewing Table Data

2. Toview the next 100 rows, click Next.
To display the previous 100 rows, click Previous.

4. Todisplay al rowsinthetable, click Show All. Retrieval may take sometime,
depending on the number of rows the table contains.
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Displaying Column Names in the Right Frame

To display column names after dragging a table to the right frame, use one of the
following methods:

e Drag the corner of the dimension table or fact table down until the table is
large enough to display its columns.

e Right-click the dimension table or fact table and select View Columns.
To collapse the column list, right-click and select View Columns again.

e Select the dimension table or fact table and select View > View Columns.
To collapse the column list, Select View > View Columns again.

e Todisplay al columns of all dimension tables (including the fact table)
currently in theright frame, select View > View All Columns.

A scrollable list of column namesis displayed for each dimension table, as
shown in Figure 3-7.

FRODUCT 4]
Blee CAFFEINATED
Ba: FAMILYID J
B INTRODATE
P DUNCES
B PRGTYPE -

Figure 3-7: View Columns Option

For illustrations and explanations of the graphics that identify columns, see
“Viewing Column Properties’ on page 6-4.

Validating OLAP Models Manually

3-18 1

Whenyou savean OLAP model, OLAP Integration Server automatically validates
it and writes it to OLAP Metadata Catalog. If you prefer, you can manually
validate an OLAP model before saving it. Y ou can save an OLAP model that does
not pass validation, but you cannot use it to create a metaoutline.

To validate an OLAP model manually, select File > Validate. If the OLAP model
isvalid, adiaog box informs you that the OLAP model contains no errors.
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If the OLAP model isinvalid, Hyperion Integration Server Desktop displays a
dialog box, similar to the one in Figure 3-8, that details the errorsin the OLAP

model.
OLAP Model Yalidation Errors [ %]

Errors and ‘Warnings:
ERROR: Mo joing defined between OLAP model tables 'SALESFACT' and ‘Time',

Figure 3-8: Invalid OLAP Model Validation Error Message Listing

If the OLAP model isinvalid, check to make sure that the following conditions
are met:

e The OLAP mode contains afact table. See Chapter 4, “ Creating the Fact
Table, Accounts Dimension, and Time Dimension.”

e The OLAP model contains at least one measures value; for example, sales
amounts, quantities sold, or commissions. (Measures can be included in the
fact table and do not necessarily need to be in an accounts dimension. If the
businessisanon-financial application, for example, you do not need to create
an accounts dimension.) See Chapter 4, “ Creating the Fact Table, Accounts
Dimension, and Time Dimension.”

e The OLAP modd contains at least one dimension.

e Each dimension table in the OLAP modd isjoined to the fact table or to
another dimension table.
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e If the OLAP model contains a single dimension, the dimension contains at
|east one column.

e Dimensionsin the OLAP model that are made up of two or more physica
tables have joins defined. See Chapter 9, “Joining Dimension Tables.”

e The OLAP model contains no dimensions with duplicate names.

To save amodel that does not pass validation, see “ Saving an OLAP Model
Manually” on page 3-22.

Saving OLAP Models

When you save an OLAP model, Hyperion Integration Server automatically
validatesit and writesit to OL AP Metadata Catalog.Y ou can save an OL AP model
if it does not pass validation, but you cannot use aninvalid OLAP model to create
ametaoutline.

This topic describes how to save an OLAP model and contains the following
subtopics:

e “Understanding Exclusive Access’ on page 3-21

e “Saving an OLAP Model Manually” on page 3-22

e “Saving While Closing” on page 3-27

e “Saving an OLAP Moddl to aDifferent Name” on page 3-27
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Understanding Exclusive Access

Y ou can save an OLAP model even if multiple users are reading it by selecting
Exclusive Accessin the Welcome dialog box, as shownin Figure 3-9. Opening an
existing OLAP model with Exclusive Access guarantees that no other user can

modify the OLAP model.

a3 . ]
-—-E\ Hyperion® Integration Server

Mew  Existing | Hecentl

Select an OLAP model or metaoutline. Then click Open.
=% [TBC Mods] e
odel
¥ TBC Metaoutine Data Source

[TeC

Drescription
=
=

Dimensions

‘rear -

Measures

Product

Market

Scenario

Sonnlier LI

™ Open with Agsistant

Open I Owerview... | Cancel Help

Figure 3-9: Selecting the Exclusive Access Option
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When opening an existing OLAP model, select Exclusive Access to place
write-lock privileges on the model. This option allows you to do both of the
following:

e You can save an existing OLAP model.

e You can modify and save an existing OLAP model. If you open aread-only
OLAP model and no other user has Exclusive Access, you can savethe OLAP
model to the same name.

If Exclusive Access is not selectable, another user has write-lock privileges, and
you have read-only privileges.

If you want to modify and save an OLAP model but have read-only privileges,
use File > Save Asto save the OLAP model to a different name. See “ Saving an
OLAP Model to aDifferent Name” on page 3-27. Also see the Hyperion
Integration Server System Administrator’s Guide for information on unlocking
OLAP models.

Note: You cannot save an OLAP model if other usersarereading it. Saveit
later or use File > Save Asto save the model with a different name.
See “Saving an OLAP Model to a Different Name” on page 3-27.

Saving an OLAP Model Manually

If the OLAP model that you want to save has been previously saved and you do
not want to give the OLAP model adifferent name, select File > Save.

OLAP Integration Server writes the changes to the OL AP Metadata Catalog to
which you are connected.

If you have not previously saved the OLAP model or if you want to savethe OLAP
model to a different name, you must use the Save New OLAP Model dialog box.
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» To usethe Save New OLAP Model dialog box to save an outline manually:
1. Select one of the following menu options:
e If you are saving aan OLAP model for the first time, select File > Save.

e If you are saving apreviously saved an OLAP model to a new name,
select File> Save As.

The Save New OL AP Model didog box, as shown in Figure 3-10, is

displayed.

Save New OLAP Model [ %]
OLAP bModel Mame:
IDLAF' Model3

Cancel |
Existing OLAP Models:
TEL Model Hep |
Security:
Allows readdwrite access for other users j
Description:
Test version of TBC Model ;I

Figure 3-10: Saving an OLAP Model

Note: If yousavean existingmodel, the Save New OLAP Model dialog
box is not displayed

2. Inthe OLAP Model Name text box, enter the name of the OLAP model.
See “Observing Naming Rules’ on page 3-28.
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3. From the Security drop-down list box, select one of the following options to
determine who can access the OLAP model:

Table 3-2: Read/Write Settings

Option Permitted Activity

Allow read/write access | Other users can read and write to the OLAP mode!.

for other users. This setting is the default.

Allow read access for Other users can read the OLAP model but not write

other users. to the OLAP model; that is, another user cannot
save changes to the OLAP model.

Disallow all access for Other users can neither read nor write to the OLAP

other users. model. Only you can read or write to the OLAP
model.

Note: To changethe permissionsonan OLAP model after you createit,
you must use the tools provided with the rel ational database that
contains the OLAP Metadata Catalog or use File > Save Asto
save the OLAP model to adifferent name. See the Hyperion
Integration Server System Administrator’s Guide.

4. If you want to describe the OLAP model, in the Description text box, enter a
brief description.

The description can include up to 255 characters. Hyperion Integration Server
Desktop displays the description in the following places:

e TheSaveNew OLAP Model dialog box when you select File > Save As
(see “Saving an OLAP Model to a Different Name” on page 3-27)

e TheOLAP Mode Propertiesdialog box (see“ Changing Read/Write
Access’ on page 3-25)

e TheExisting tab of the Welcome dialog box (see “Working with OLAP
Models’ on page 3-3)
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5. Click OK.

If the OLAP model isinvalid, Hyperion Integration Server Desktop displays
an error message. Y ou can save the OLAP model without correcting the error,
but you cannot use an invalid OLAP model to create a metaoutline.

Note: If you attempt to save an OLAP model that another user currently has
open, adialog box informs you that the OLAP model is currently
locked or open. You must wait to save until al other users close the
OLAP model.

Changing Read/Write Access
At any time after you save an OLAP model, you can change the access rights that
you originally assigned by using the OLAP Model Properties dialog box.
» To change read/write access to an OLAP model:
1. Inablank space of theright frame, right-click and select Properties.

Hyperion Integration Server Desktop displays the General tab of the OLAP
M odel Propertiesdialog box.

2. Inthe Security drop-down list box, change the user access defined for the
model.

For more information about security settings, see Table 3-2.
3. Click OK.

Specifying Retrieval Optimization Preferences

Oracle users have the option of specifying dataretrieval optimization preferences
in the Optimization tab of the OLAP Model Properties dialog box. Optimization
preferences determine how OLAP Integration Server handles data queries for
individual users. This option exists for Oracle users because Oracle is the only
RDBM S that offers performance options for overall database access. Overall
database information is stored with the OLAP model.
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» To specify optimization preferences for Oracle users:
1. Inablank space of theright frame, right-click and select Properties.
The OLAP Model Properties dialog box is displayed.

Tip: You can aso open the OLAP Model Properties dialog box by
selecting View > Properties > OLAP Model.

2. Select the Optimization tab, shown in Figure 3-11.

OLAP Model Properties E

General Optimization |

Query Optimization

= Best Throughput

" Best Response Time

QK I Cancel | Help |

Figure 3-11: Optimization Tab of the OLAP Model Properties Dialog Box

3. Select one of the following preferences:
e Noneto have no parametersincluded in user data queries

e Best Throughput to have all userstreated equally, with no high-priority
dataretrieval

e Best Response Timeto have some queries (queriesfrom userswho have
this setting) receive a higher priority response than other, concurrent
queries

4. Click OK.
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Saving While Closing

If you try to close an OLAP model without saving it, adiaog box promptsyou to
save your changes.

Click Yesto save the OLAP model or Noto close the OLAP model without saving
the changes. See “Saving an OLAP Model Manually” on page 3-22.

CAUTION: If the OLAP modé that you are closing isanew OLAP
model that has never been saved, you will loseit if you
click No.

Saving an OLAP Model to a Different Name

Savean OLAP model to adifferent nameif you want to take either of thefollowing
actions:

e Change the name of an OLAP model. (The original OLAP model retains the
original name.)

e Makeacopy of an OLAP model.

Y ou cannot copy an OLAP model using the Copy function that the operating
system provides because the OLAP model residesin an OLAP Metadata
Catalog. Instead, you need to save the OLAP model to a different name.

To save an OLAP modéd to adifferent name, select File > Save As. Hyperion
Integration Server Desktop displaysthe Save New OL AP M odel dialog box. For
more information, see “ Saving an OLAP Model Manually” on page 3-22.
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Observing Naming Rules
When naming objectsin an OLAP model, follow these rules:

328 1

e Do not use more than 80 characters.

e Do use mixed uppercase and lowercase characters. Names are not
case-sensitive in Hyperion Essbase unless there is a check mark next to
the Settings > Case Sensitive Members menu item in Hyperion Essbase.

e Do not use the following characters anywhere in a name:

(ampersand) < (lessthan sign)
(asterisk) () (parenthesis)

(at sign) . (period)

(backslash) + (plus sign)

(brace) ' (single quotation mark)
(comma) tab

(dash, hyphen, or minus sign) _ (underscore)

(double quotation mark) | (vertical bar)

(equal sign)

e Do not place spaces at the beginning or end of a name. Hyperion Essbase
ignores spaces at the beginning or end of a name.

e Do not use the following words, commands, or names as dimension or
member names:

$SSUNIVERSESSS
#MISSING Or #MI
Calc script commands, operators, and keywords

For alist of commands, see the online Quick Technical Referencein the
pocs directory.

Report script commands

For alist of Hyperion Essbase commands, see the online Quick Technical
Reference in the pocs directory. (Hyperion Integration Server uses
OLAP Command Interface Commands.)
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— Function names and function arguments

For alist of functions, see the online Quick Technical Referencein the
pocs directory.

— Namesthat are already in the database: names of dimensions and
members (unless the member is shared), names of generationsand levels,
and aliases and combinational aliases.

Note: If you tag members as Dynamic Time Series, do not use the
associated generation names:. History, Year, Season, Period,
Quarter, Month, Week, or Day. See the Hyperion Essbase OLAP
Server Database Administrator’s Guide for more information.

Printing OLAP Models

Y ou can print the OLAP models contained in the right frame of the OLAP Model
main window to use as a hard-copy reference or to retain on file. Therelational
tables in the left frame of the window do not print when you print the OLAP
model.

» To print an OLAP model:

1. Clickintheright frame.

2. Select File> Print or click the Print toolbar button, @, to open the standard
Print dialog box.

3. Select the settings that you want.
4. Click OK.
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Deleting OLAP Models

When you delete an OLAP model, Hyperion Integration Server removes the
OLAP model from OLAP Metadata Catal og.

» To delete one or more OLAP modéls:

1. Makesurethat you are connected to the OL AP Metadata Catal og in which the
OLAP moded is stored.

If you are connected, the lower-right corner of the OLAP Maodel main window
contains the appropriate OL AP Metadata Catal og name (for example,
TBC_MD in the sample TBC database).

If you are not connected, select Connections > OLAP Metadata Catalog >
Connect and log on to the correct OLAP Metadata Catalog.

2. Select File> Delete to display the Delete an OL AP M odel/M etaoutline
dialog box, shown in Figure 3-12.

Delete an OLAP Model/Metaoutline E
[-%£ TBC Model Close I
¥R TBC Metaoutling
B 0L4F Modell Delete |
Help |
Drescription:

Figure 3-12: Deleting an OLAP Model
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3. Select the OLAP model to delete; for example, OLAP Model1, and click
Delete.

Note: To select multiple OLAP models, select one OLAP model, hold
down the Ctrl key, and select each additional OLAP model.

Hyperion Integration Server Desktop displays a dialog box that prompts you
to confirm that you want to delete the OLAP model.

CAUTION: Use caution when deleting. You cannot undo the deletion
of an OLAP model.

4. Click Yes.

OLAP Integration Server deletes the selected model from OLAP Metadata
Catalog.

Note: If you attempt to delete an OLAP model that you or another user
currently has open, adialog box informsyou that the OLAP model is
currently locked or open. If you haveit open, close the OLAP model
and select Connections > OLAP Metadata Catalog > Delete L ocks. If
other users have the OLAP maodel open, you must wait until they
closeit.
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4 Accounts Dimension, and
Time Dimension

Every OLAP mode contains afact table. The fact table serves as a container for
all numeric (measures) dataval uesthat you want to track. Measuresareitems such
as unit price, units sold, and sales amounts. If you track more than one measure,
you must create an accounts dimension to hold the measures. If an application
requires analysis to be performed on atime basis, you should aso create atime
dimension.

Thetopicsof this chapter describe the role of the fact tableinan OLAP model and
provide procedures for creating a fact table, an accounts dimension, and atime
dimension:

e “Understanding the OLAP Model Workflow” on page 4-2

e “About the Fact Table” on page 4-3

e “Creating the Fact Table” on page 4-4

e “About the Accounts Dimension” on page 4-7

e “Creating the Accounts Dimension Manually” on page 4-8

e “About the Time Dimension” on page 4-8

e “Creating the Time Dimension Manually” on page 4-9

e “Switching the Time and Accounts Dimensions’ on page 4-14
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Understanding the OLAP Model Workflow

Figure 4-1 illustrates the workflow for creating an OLAP model. This workflow
includes creating and working with an OLAP model; creating afact table, an
accounts dimension, and atime dimension; creating and working with dimensions;
editing and transforming the columns of dimension tables; joining dimension
tables, and creating and working with hierarchies. This chapter focuses on how
to create afact table, an accounts dimension, and a time dimension.

Creating and working | T i Ty e 1 1o L]
with OLAP Models ::= File Edit %iew Connections Tools ‘window Help

DEE|&] & [#] 2] 2 | /

=-F1 THCFAMILY | /
E-F TECMARKET

* . Hyperion Integration Server Desktop - [TBC Model]
@ Creating a fact
table, an accounts

::= File Edit “iew Connections Toolz ‘Window Help
DESM & s |F| &2 | /
You Are Here dimension, and a
time dimension

TEC.FAMILY | /
- TECMARKET @Q
= MARKET | [@vear |
Creating and working M SALESPACT TE_E. Accounts
with dimensions = PRODUCT | % | SCENARIO |

Table Properties

General Columns | PhysicalJoinsI

| Table Mame | Column Marme | Hidden
Enec CAFFEINATED TBC.PRODUCT  CAFFEINATED

B FAMILYID TBC.PRODUCT  FAMILYID

Editing and transforming
columns

Table Properties

General Columns | PhysicalJoinsI

| Table Mame | Column Marme | Hidden
Enec CAFFEINATED TBC.PRODUCT  CAFFEINATED

Be: FAMILYID TEC.PRODUCT  FAMILYID

B@INTRODATE  TECPRODUCT INTRODATE

Edit Hierarchy
Mame:

IYEAH-DUAHTEH-MDNTH

Joining dimension tables

E% rear
EH&) Timne. Quarter

Creating and working
- Time.Manth

with hierarchies

Figure 4-1: OLAP Model Workflow
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About the Fact Table

A fact table contains detailed measures (data values) for each dimension
intersection of its OLAP model. Measures include items such as price or units
sold. For example, if the OLAP model contains Product, Geography, and Time
dimensions, the fact table may contain the number of units of Product A sold in
New York in January.

What Components Are Included in the Fact
Table

The fact table is made up of one or more source tables and contains a compound
key that uniquely identifies the records that it contains. The compound key
consists of primary and foreign keys and links to each dimension table of the
OLAP model, asillustrated in Figure 4-2. The dimension tables contain columns
of related information from the source tables.

Fact Table (Orders)

Quantity
Froduct_1D
Geography_ID

N\

N

- ]
Geography_ID
Froduct_ID Region
Product Name

Geography

Product

Figure 4-2: Dimension Tables Joined to the Fact Table with
Primary and Foreign Keys

For example, you might store product ID and geographic information in two or
more tablesin the relational database. Y ou can use the relational tables to create
Product and Geography dimensionsin the OLAP model. Y oujoin the dimensions
to the fact table, either manually or through automatic joins. When you create a
new dimension, OLAP Integration Server creates an automatic join whenever it
detectsanatural join relationship. A natural join exists between two tableswhen a
primary key of onetableisidentified as aforeign key in the other table.
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Bear in mind that OLAP Integration Server does not create additional structures
for the relational datathat you use when creating an OLAP model. Rather, it
reorganizesthe existing datainto aformat that you can use to create ametaoutline.

Why a Fact Table is Required

Every OLAP model that you create must contain afact table. The fact table
contains the values that are |later aggregated and reported by Hyperion Essbase.
The first source table that you drag to the right frame automatically becomes the
fact table. Because of its relationship to each dimension that you define, the fact
table becomes the hub (the center) of the OLAP modedl. After you create the fact
table, you can add other source tablesto it.

Any columnsthat you add to the fact table are added automatically to the accounts
dimension. Likewise, columns that you add to the accounts dimension are added
automatically to the fact table. All measures values that you want reported are
referenced through the fact table and through the accounts dimension, which isan
exact copy of the fact table.

If, in the relational data source, you have only one column containing measures,
you can store the column in the fact table, and you do not need to create an
accounts dimension. For more information about the accounts dimension, see

“ About the Accounts Dimension” on page 4-7.

Creating the Fact Table

Thefirst table that you drag to the right frame of the OLAP Model main window
becomesthe fact table. When you create the fact table, you also choose whether to
create the time and accounts dimensions automatically.

CAUTION: If the relational database stores accounts measures values
and time values in the same columns, you must use a
non-standard method to create the OL AP model accounts
dimension. This situation is common in some applications,
such as general ledger and legacy systems. See “ Switching
the Time and Accounts Dimensions” on page 4-14.
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For more information on the fact table, see “ About the Fact Table” on page 4-3.
Before creating an OLAP model, be sure to read and follow the proceduresin
Chapter 2, “Preparing Relational Data Sources.”

» To create afact table:

1. Drag the appropriate source table from the | eft frame to the right frame, as

shown in Figure 4-3.

If you are not sure which tableto use, view the data stored in each sourcetable
by selecting View > View Table Data. For more information, see “Viewing

Table Data’ on page 3-17.

* . Hyperion Integration Server Desktop - [DLAP Modell]
::= File Edit “iew Connections Toolz ‘Window Help

[_[O]x]
==l x|

DEE|(&|w s | & &%

TBC.FAMILY
TBC.MARKET
TBC.POPULATION
TBC.PRODUCT
TBC.PRODUCTDIM
TEC.REGION
TBC.SALESFACT
TBC.SCENARIO
TBC.SUPPLIER

Faor Help, press F1

1§ SALESFACT |

o

|Data Source: TBC

|DLAF' Catalog: TEC_MD

4

Figure 4-3: Creating a Fact Table

Thefact table uses the name of the source table that you select to createit. To
rename the fact table, see “Renaming Dimensions and the Fact Table” on

page 5-14.
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2. Decide whether to create the time dimension first and then the accounts

dimension, by responding to the following prompts:

e Would you like aTime dimension using avalue from the fact table? Click

Yesor No.

e Would you like to add an Accounts dimension? Click Yes or No.

Table 4-1: Deciding when to Create Dimensions Automatically

When to Create the Time
Dimension Automatically

When to Create the Accounts
Dimension Automatically

The table that you select to create the
fact table contains at least one column
with a time value (a shipping date, for
example) and you want to use that
column to create atime dimension.

If you select this option, the time
dimension initially contains the same
columns as the fact table. However,
any columnsthat you later add to the
time dimension are not added
automatically to the fact table;
likewise, if you add columnsto the
fact table, they are not added
automatically to the time dimension.

The source table that you select to
create the fact table contains at least
one column with a measures value
(units sold, for example) and you
want to use that column to create an
accounts dimension.

The accountsdimension inheritsall of
the columns that the fact table
contains. In an OLAP model, the fact
table and the accounts dimension are
mirror images of each other. The
accounts dimension reflects changes
made in the fact table; likewise, the
fact table reflects changes madein the
accounts dimension.

After you respond to the time and accounts dimension prompts, the fact table

is displayed in the right frame.

If you create an accounts dimension automatically, an object isdisplayed in

the right frame. The object is identified by the “ Accounts’ label and the
graphic. A join line connects the fact table and the accounts dimension.

If you create atime dimension automatically, an object isdisplayed in theright

frame. The object isidentified by the“Time” |abel and the & graphic. A join
line connects the fact table and the time dimension.
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3. After you create the fact table, proceed with the following options:

e Toaddtablesfromtherelational datasourceto thefact table, see“Adding
Tablesto the Fact Table” on page 5-12.

e Toaddtime and accounts dimensions manually, if you opted not to create
time and accounts dimensions automatical ly along with the fact table, see
“Creating the Time Dimension Manually” on page 4-9 and “ Creating the
Accounts Dimension Manually” on page 4-8.

e Tocreatestandard dimensions, see Chapter 5, “ Creating and Working with
Dimensions.”

About the Accounts Dimension

The accounts dimension consists of columns that contain measures. Measures
values are numeric data values that you track over time, such as sales, discounts,
and commissions. In Hyperion Essbase, accountsis adimension type that makes
accounting intelligence available during online analytical processing.

An OLAP model is not complete without at |east one column from the relational
data source that contains a measure. If you add more than a single measure to the
fact table, you must create an accounts dimension in the OLAP model.

If you have a non-financial application or for any reason have only asingle
measure to be analyzed and reported, you do not need to create an accounts
dimension. Add the appropriate measure to thefact table. Y ou can use the measure
from the fact table to add a single measure to the metaoutline that you create from
the OLAP mode, as described in the Hyperion Integration Server Desktop OLAP
Metaoutline User’s Guide.

CAUTION: If the relational database stores accounts measures values
and time values in the same columns, you must use a
non-standard method to create the OLAP model accounts
dimension. This situation is common in some applications,
such as general ledger and legacy systems. See “ Switching
the Time and Accounts Dimensions” on page 4-14.
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Creating the Accounts Dimension Manually

If you need an accounts dimension and do not create it automatically, you can
create it manually. To add an accounts dimension manually:

1. Right-click the fact table, and select Add Accounts Dimension.
An accounts dimension is displayed in the right frame. The dimensionis

identified by the “ Accounts’ label and the %2l graphic. A join line connects
the accounts dimension to the fact table.

2. If needed, add one or more source tables to the accounts dimension.

Y ou must add source tables directly to the accounts dimension; you cannot
create adimension branch. For moreinformation, see“ Adding Source Tables
Directly to Dimension Tables’ on page 5-7.

3. If needed, add one or more user-defined columns to the accounts dimension.

Any columnsthat you add to the accounts dimension are also added to the fact
table. For instructions on how to add new columnsto the accounts dimension,
see “ Creating User-Defined Columns” on page 6-14.

About the Time Dimension

4-8 H

In aHyperion Essbhase database, you use the dimension tagged astime to describe
how often you collect and update data. Y ou can usetime dimension members, such
as Y ear and Quarter, to report yearly and quarterly totals for members of other
dimensions; for example, total sales of Diet Colain Boston for the first quarter.

In an OLAP model, you create a dimension tagged as time to provide atime
structure from which to create a specific time dimension in an associated
metaoutline. Y ou cannot create atime dimension in ametaoutline if you did not
create, in the associated OLAP model, a dimension that contains atime value.

It is not mandatory to include atime dimension in an OLAP model. However, if
an application requires analysisto be performed on atimebasis, such asexamining
trends over time or making seasonal sales comparisons, you should include atime
dimension. Y ou can create only one time dimension in an OLAP model, but you
can create as many time dimension hierarchies, within that single time dimension,
as are necessary to meet reporting requirements.
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In an OLAP model, the time dimension includes the following elements:
e Oneor more time-related columns joined to the fact table.

e A time-related column for every time dimension member that you want to
report on in Hyperion Essbase; for example, a separate column for year, for
guarter, and for month. You use these time-related columnsin an associated
metaoutline to define members of the time dimension.

e Asneeded, one or more hierarchies that define how to roll up member datain
the time dimension. For example, atime hierarchy can include Month,
Quarter, and Year members whereby monthly totalsroll up to quarterly totals
and quarterly totalsroll up to yearly totals. Creating hierarchiesin an OLAP
model provides a multilevel structure that you can view when creating
dimensions in metaoutlines.

Y ou may have specific reporting and analysis requirements that are based on
specialized calendar years, such asin amerchant calendar. For more information
on how to prepare the relational data source to meet such requirements, see
“Creating Time and Accounts Dimensions’ on page 2-20.

Creating the Time Dimension Manually

Y ou can create atime dimension either automatically or manually. The procedure
for automatically creating atime dimension is described in “ Creating the Fact
Table” on page 4-4. After automatically creating the time dimension, you can edit
the columnsiit contains, as described in Chapter 6, “Editing Columnsin
Dimension Tables and the Fact Table.”

If you do not create atime dimension automatically when you create the fact table,
you can add the time dimension manually. Y ou create the time dimension
manually in one of two ways.

e Based on the fact table, whereby the time dimension table inherits al of the
columnsin the fact table. See “Manually Creating a Time Dimension that Is
Based on the Fact Table” on page 4-10.

e Based on another table in the relational data source, such as a user-defined
calendar. Follow the same procedure that you use for creating standard
dimensions, with some exceptions that are noted in the procedure. See
“Creating Dimensions’ on page 5-3.
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Manually Creating a Time Dimension that Is
Based on the Fact Table

» To add atime dimension that is based on the fact table:
1. Right-click the fact table, and select Add Time Dimension.
A time dimensionisdisplayed in theright frame. The dimension isidentified

by the* Time” label and the & graphic. A broken join line connects the time
dimension to the fact table. The time dimension table includes all of the
columnsin thefact table. The broken join lineindicatesthat you need to select
time-related columnsin both tables to define the join rel ationshi p between the
two tables.

2. Define the join between the two tables, as described in Chapter 9, “ Joining
Dimension Tables.”

3. If needed, add one or more source tables to the time dimension.

Y ou must add source tables directly to the time dimension; you cannot create
adimension branch. For more information, see “ Adding Source Tables
Directly to Dimension Tables’ on page 5-7.

4. |If needed, add one or more user-defined columns to the time dimension.

Add new columnsto the time dimension to use the columnsaslevelsin atime
hierarchy. If you want monthly and quarterly aggregationsin the Hyperion
Essbase database, you need a monthly and a quarterly column in the OLAP
model time dimension.

If the time dimension does not include the needed columns, you must add new,
user-defined columns. Add a column for each level of aggregation that the
OLAP model does not currently include. Y ou derive the values of the new
columns from date columns currently existing in the data; for example, a
transaction or sales date.

For instructions on how to add new columns to the time dimension table,
see “ Creating User-Defined Columns” on page 6-14.
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Determining if a User-Defined Calendar Is Needed

OLAPIntegration Server can map adate in asource columnto aday, week, month,
guarter, or year time period in the time dimension.

If you need to analyze data by other time periods or if you use acaendar different
from the standard Gregorian calendar, create a user-defined calendar in the source
data. A user-defined calendar isa sourcetablein arelational database that maps a
busi ness calendar to the date information associated with the measures data. If you
answer “Yes' to any of the following questions, create arelational source table
containing your user-defined calendar to perform the required mapping.

e Doesthefisca year start on adate other than January 1?

e Doesthetime dimension include amember for a period that has no matching
column in the source data for the fact table? For example, do you want to
measure by sales season, but no sales season column existsin the source data
for the fact table?

e Do you measure business cyclesin periods other than the standard Gregorian
calendar months? For example, instead of the standard 12 monthsto the year,
isyour year measured by 13 four-week periods?

Designing a User-Defined Calendar

Assumethat auser-defined calendar islocated in atablein the source database that
you are using to create an OLAP model. Thistable requires both of the following:

e A column for each potential time period (member) in the time dimension.

e A time-related key column that mapsto the lowest-level, time-related column
associated with the measures data. See* Associating Time Datawith Measures
Data’ on page 2-20.
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Table 4-2 is an example of a user-defined calendar.

Table 4-2: A User-Defined Calendar

WK_OF | DAY_OF | DAY_OF
TIMESTAMP YEAR | QTR | MONTH | YEAR YEAR WEEK SEASON
Jul 12000 12:00AM 2000 |1 1 1 1 Thurs Summer
Jul 22000 12:00AM 2000 |1 1 1 2 Fri Summer
Jul 522000 12:00AM 2000 |1 1 2 5 Mon Summer
Jul 6 2000 12:00AM 2000 |1 1 2 6 Tues Summer
Jul 7 2000 12:00AM 2000 |1 1 2 7 Wed Summer
Jul 8 2000 12:00AM 2000 |1 1 2 8 Thurs Summer
Jul 9 2000 12:00AM 2000 |1 1 2 9 Fri Summer
Sep 12000 12:00AM | 2000 |1 3 10 63 Wed Autumn
Sep 22000 12:00AM | 2000 |1 3 10 64 Thurs Autumn
Sep 32000 12:00AM | 2000 |1 3 10 65 Fri Autumn
Sep 6 2000 12:00AM | 2000 |1 3 11 66 Mon Autumn

Table 4-2 illustrates several pointsto consider when creating a user-defined
calendar:

e Thefirst column, TIMESTAMP, isthe key column in the user-defined
calendar table. Thiscolumnisjoined to atime-related columninthefact table.
Asjoined columns, the columns must have the same data type. The key
column in a user-defined calendar defines the lowest level of time analysis
that the source data can provide to the fact table.
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e Inorder for the measuresdata (such as sales) to map to the time members, each
value in the date column of the source data for the fact table must match a
value in the key column of the user-defined calendar table.

TIMESTAMP is a column with a datetime data type. Its valuesinclude the
time rounded in minutes to 12:00 AM; for example, Jul 2 2000 12: 00AM.
TIMESTAMP isthejoin column from the user-defined table to the fact table.
Therefore, not only must the join column in thefact table have a datetime data
type, but also each time value must be rounded to 12 : 00aM. For example, if
asale occurred on July 2, 2000, at 8:30 AM, you must prepare the transaction
datein the source data so that the fact table and the user-defined calendar show
the ssme value, Jul 2 2000 12: 00AM.

e Representing afiscal calendar starting with July 1, the calendar in Table 4-2
showsthe July 1 timestamp value mapping to a 1 value for the quarter,
month, week, and day of the year.

e Table4-2 showsonly afew rowsfor July and September. Actually, atable
must contain arow for every potential date in the source data. For example,
Table 4-2 does not include rows for the dates that are Saturdays and Sundays.
Unless you are certain that no data is posted with a Saturday or Sunday date,
you should include rows for those days.

e Table4-2includestwo columnsrelated to the day: the day of the year and the
day of the week. If you want to analyze whether sales are better on Mondays
than on Wednesdays, you need a column in the user-defined calendar and a
corresponding member in the time dimension for the day of the week.

e Table4-2includesaSEASON column. Although Autumn traditionally starts
in mid-September, the example shows Autumn starting on September first. Set
the values in the calendar to correspond to the needs of your company.

A user-defined calendar is as unique as the business requirements of your
company.
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Switching the Time and Accounts Dimensions

Most databases store time values in rows and measures values in columns, as
shown in Table 4-3. For this type of data, you do not need to switch the time and
accounts dimensions.

Table 4-3: Time Data Stored in Rows

COGS Sales
January 105 127
February 111 214
March 120 189

Some applications, such as general ledger applications, store time valuesin
columns and measuresvaluesin rows, as shown in Table 4-4. For these databases,
you must switch the time and accounts dimensions in the OLAP model and then
set the dimension types correctly in the associated metaoutline. For more
information, see “ Switching the Time and Accounts Dimensionsin the OLAP
Model” on page 4-15 and “ Setting Dimension Properties in the Metaoutling” on
page 4-17.

Table 4-4: Time Data Stored in Columns

January February March
COGS 105 111 120
Sales 127 214 189

4-14 1
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Switching the Time and Accounts Dimensions in the
OLAP Model

» To switch time and accounts dimensions in the OLAP model:

1. Create and name the fact table using the procedures in “ Creating the Fact
Table” on page 4-4, with the following exceptions:

e Tothe prompt for creating the time dimension automatically, click No.

e Tothe prompt for creating the accounts dimension automatically, click
Yes.

e Right-click the Accounts dimension table and select Propertiesto display
the Dimension Properties dialog box, change the name of the Accounts
dimension to Time, and click OK .

e Right-click the newly created Time dimension table and select View
Columns to display the column names.

e Right-click the Accountstable in the column view, select Properties to
display the Table Properties dialog box, change the name of the
Accounts dimension to Time, and click OK.

2. Inthe OLAP Model main window, drag the source table that you used for the
fact table; for example, FACT_TABLE, to the right frame to create a new
dimension.

3. When adialog box prompts you to rename the table (because that name
aready exists), click Yes.

Hyperion Integration Server Desktop displays the Create New Table dialog
box, as shown in Figure 4-4.

'
Cancel |

Currertt T ables:

MARKET
SALESFACT

Figure 4-4: Create New Table Dialog Box
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4-16 1

4. Inthe Name text box, type Accounts and click OK to close the dialog box.

Inthe OLAP Model main window, usethejointool to join the new dimension
to the fact table.

Click thejointool (or right-click in ablank space of theright frame and select
Add Joins Mode) to activate Add Joins Mode, and drag the tool between the
two tables.

Hyperion Integration Server Desktop displays the Create New Dimension
dialog box with the dimension name Accountsin the Nametext box, asshown
in Figure 4-5.

Create Hew Dimension [ %]
M ame:
oK
= x|
Cancel |
Dimenzion Type:
IDefauIt j Help |

Current Dimensions:
M&RKET

Figure 4-5: Create New Dimension Dialog Box

6. From the Dimension Type drop-down list, select Default, and click OK to
close the dialog box.

7. Define thejoins completely, using all necessary keys.

8. Create any other dimensions that you need (see “ Creating Dimensions” on
page 5-3).
9. Savethe OLAP model (see*” Saving OLAP Models’ on page 3-20).

Complete the OLAP model before using it to create a metaoutline.
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Setting Dimension Properties in the Metaoutline

» To set properties for the time and accounts dimensions in the metaoutline:

1. Fromthenewly created OLAP model, create a metaoutline (see the Hyperion
Integration Server Desktop OLAP Metaoutline User’s Guide).

2. After you add the time dimension to the metaoutline, right-click the time
dimension and select Properties.

Hyperion Integration Server Desktop displays the General tab of the
Dimension Properties dialog box.

a. Select the Member Infotab.
b. From the Dimension Type options, select Time.

c. Completeinformation on the other tabs as needed, and click OK to close
the dialog box.

3. Asneeded, right-click amember level name within the time dimension, select
the Properties option, complete information on the tabs.

4. Click OK to closethe dialog box.
5. Right-click the accounts dimension and select Properties.

Hyperion Integration Server Desktop displays the General tab of the
Dimension Properties dialog box.

a. SelecttheMember Info tab.
b. From the Dimension type options, select Accounts.

c. Completeinformation on the other tabs as needed, and click OK to close
the dialog box.

6. Asneeded, right-click a member level name within the accounts dimension,
select the Properties option, and specify on each tab the information required
to define the selected member level.

7. Click OK to close the dialog box.

8. Continue with the workflow as described in the Hyperion Integration Server
Desktop OLAP Metaoutline User’s Guide.
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Creating and Working
with Dimensions

After you create afact table, continue building an OLAP model by adding
dimensions. Y ou can create atime dimension, an accounts dimension, and various
other dimensionsin an OLAP model. If you do not create time and accounts
dimensions when you create the fact table, you can add them manually as
described in Chapter 4, “ Creating the Fact Table, Accounts Dimension, and Time
Dimension.”

Y ou may also need to create additional dimensions to provide Hyperion Essbase
with enough information to meet your business analysis requirements. This
chapter describes how to create dimensions other than time and accounts and how
to edit dimensions and the fact table.

This chapter contains the following topics:

e “Understanding the OLAP Model Workflow” on page 5-2

e “Creating Dimensions’ on page 5-3

e “About Dimension Branches’ on page 5-5

e “Viewing Dimension Table and Fact Table Information” on page 5-13
e “Renaming Dimensions and the Fact Table” on page 5-14

e “Renaming Dimension Tables” on page 5-15

e “Moving Tables’ on page 5-15

e “Deleting Dimension Tables or the Fact Table” on page 5-16
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Understanding the OLAP Model Workflow

52 1

Figure 5-1 illustrates the workflow for creating an OLAP model. This workflow

includes creating and working with an OLAP model; creating afact table, an

accounts dimension, and atime dimension; creating and working with dimensions;

editing and transforming the columns of dimension tables; joining dimension

tables; and creating and working with hierarchies. This chapter focuses on how to
create dimensions other than time and accounts and how to edit dimensions and

the fact table.

Creating and working | T i Ty e 1 1o L]
with OLAP Models ::= File Edit %iew Connections Tools ‘window Help
DEE|&] & [#] 2] 2 | /

TEC.FAMILY /
TEC.MARKET

* . Hyperion Integration Server Desktop - [TBC Model]
::= File Edit “iew Connections Toolz ‘Window Help

Creating a fact table,
an accounts dimension,
and a time dimension

DEE|&] & [#] 2] 2 | /

R

w3 TBC.FAMILY
73 TBCMARKET |$ﬂl /
[ MARKET || [@vear |
@ Creating and 8 Accounts |
working with

You Are Here dimensions | | EZIIC| [Z scENARIO |

Table Properties

General Columns | PhysicalJoinsI
Mame | Table Mame | Column Marme | Hidden
Enec CAFFEINATED TEBC.PRODUCT CAFFEIMATED

B FAMILYID TBC.PRODUCT  FAMILYID

Editing and transforming
columns

Table Properties

General Columns | PhysicalJoinsI

| Table Mame | Column Marme | Hidden
Enec CAFFEINATED TBC.PRODUCT  CAFFEINATED

Be: FAMILYID TEC.PRODUCT  FAMILYID

B@INTRODATE  TECPRODUCT INTRODATE

Edit Hierarchy
Mame:

Joining dimension tables

IYEAH-DUAHTEH-MDNTH
. ) EE‘?’ “ear B, Year
Creating and working B Time EH&) Time. Quarter

with hierarchies M DD TIONS - Time.Manth
. COGS

s MARKETING

e MISC

----- A Month

Figure 5-1: OLAP Model Workflow
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Creating Dimensions

This topic describes how to create a dimension that joins directly with the fact
table. To create afact table, see “Creating the Fact Table” on page 4-4.

Tip: You can create two or more dimensions from a single relational
database table. Each dimension must have adifferent name. You should
hide all columnsthat do not contain valuesthat you want to be reported
for the dimension (see “Hiding and Showing Columns’ on page 6-6).

» To create dimensions:
1. Drag the appropriate source table from the left frame to the right frame.

If you are not sure which table to use, view the data stored in the table by
selecting atable, right-clicking, and then selecting View Table Data. For
information, see “Viewing Table Data” on page 3-17.

e If apredefined primary-foreign key relationship exists between the table
that you are adding and the fact table, Hyperion Integration Server joins
the dimension table to the fact table. Because the dimension table joins
directly to the fact table, the dimension table is a'so adimension.

e If apredefined primary-foreign key relationship does not exist between
the table that you are adding and the fact table, Hyperion Integration
Server does not join the dimension table to the fact table. To create the
dimension, join the dimension table to the fact table manually. See
“Joining Dimension Tables Directly to the Fact Table” on page 9-6.

Hyperion Integration Server Desktop displays the Create New Dimension
dialog box, asshown in Figure 5-2. By default, the new dimension inheritsthe
name of the source table you select to create it.

Di i T Cancel |
T = v |

Current Dimensions:

Figure 5-2: Creating a New Dimension
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2. If you want to change the dimension name, in the Name text box, enter a
new name.

For naming rules, see “ Observing Naming Rules’ on page 3-28.
From the Dimension Type drop-down list, select Default.
4. Click OK.

Adding Tables to Dimension Tables
or to the Fact Table

Y ou can add tablesto existing dimension tables or to the fact table by using either
of two methods:

e Youcanadd asourcetableto an existing dimensiontableto createadimension
branch by adding the new sourcetableto the OLAP model andjoiningit to the
existing dimension table.

e You can add the new source table directly to an existing dimension table
without creating a branch.

The method used to add a table to a dimension affects both the OLAP model and
the metaoutlines that you create from the OLAP model.

This topic describes how to add source tables to dimension tables and to the fact
table and explains the reasons to add tables to dimension tables or dimension
branches. This topic contains the foll owing subtopics:

e “About Dimension Branches’ on page 5-5
e “Adding Source Tablesto Create Dimension Branches” on page 5-6
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About Dimension Branches

A dimension branch contains a dimension table that joins directly to the fact table
(known as the primary dimension table) and to one or more related dimension
tables. In Figure 5-3, the PRODUCT and FAMILY dimension tablesform a
dimension branch for the Product dimension.

Dirnension
FACT_TABLE =l LOOKUP_PRODUCT =
fze ADDITIONS J Pus CAFFEINATED
. CITY_ID B DIET

« COGS
« ENDING_INVENTORY
« MARKETING =l

B INTRO_DATE

.. OUNCES_ID

Be: PACKAGE_TYPE_ID [ =|| |Dimension table
‘ in a dimension

branch

ATTRIEUTE_OUMNCES
B DUNCES

P OUNCES_ID e B

Figure 5-3: A Dimension Branch

Notice that both dimension tables are located in the Product dimension and that
both dimension tables display the name Product in their title bars.

The hierarchical structure of dimension branchesis similar to the consolidation
levels reported in Hyperion Essbase. The fact table in an OLAP model is
considered level 0 (zero). A dimension table joined directly to the fact tableis
level 1. A dimension table joined to another dimension tablethat isjoined directly
tothefact tableislevel 2. A dimensiontablejoinedto alevel 2tableislevel 3, and
soon.

Level numbers are assigned to dimension tables and branches to provide a
hierarchical structure to work with as you create a metaoutline. Viewing a
hierarchica structure in an OLAP model helpsyou to define the correct
consolidation levels you require. Level numbers do not carry over to the
metaoutline or to the subsegquent Hyperion Essbase outline.
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Adding Source Tables to Create
Dimension Branches

56 A

The use of dimension branches offers some advantages, asillustrated in
Figure 5-4. In both the OLAP model and the metaoutline, it is easy to tell

to which source table each column belongs. In the metaoutline, it is easy to
add columnsin the required order—the hierarchical order defined by the
dimension branch in the OLAP model. For example, in the metaoutline, the
columnsinthe FAMILY table must be added before and positioned above the
columns in the PRODUCT table.

In an OLAP model In a metaoutline
=B Produc
# PRODUCT B1-E7 FAMILY
PRODUCT | B... FAMILY
Em ?:;TE\L“ATED J ----- P FAMILYID
Em oy I Plee FAMILTYMAME
Az

----- B INTRODATE

Pl FAMILYNAME
&-E1 PRODUCT
P.. FAMILY_FAMILY x| £-F] PRODUCTDIM

| ----- Plee FAMILY

R R —_. R Plee FAMILYATTR
----- Biee FAMILYNAME
T Blee SKU
Boe FabIY | Plee SKUMAME
P FAMILYID ow B =3 PRODUCT
Blee FAMILYNAME - % Product
B INTRODATE -5 Attibutes

Figure 5-4: Displaying Table and Column Information in a Dimension Branch

When you join asource table to an existing dimension table to create a dimension
branch, all columns of the table are added to the dimension. Each dimension table
in the dimension branch displays the original dimension table name.

Y ou cannot create dimension branches for the fact table, for the time dimension,
or for the accounts dimension. To use multiple tables for the time and accounts
dimensions and for the fact table, add the tables directly (see “ Adding Source
Tables Directly to Dimension Tables” on page 5-7).

» To add atable and its columns to form a dimension branch:

1. Drag the source table from the left frame to the right frame.

2. Join the table to the dimension table as described in “ Joining Dimension
Tablesto Create or Expand a Dimension Branch” on page 9-8.
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Adding Source Tables Directly to Dimension Tables

When you add a new table directly to a dimension table, you combine the two
tables. Combining tables offers both advantages and disadvantages, asillustrated
in Figure 5-5.

In both the OLAP model and the metaoutline, the original sources of the
columns are not as clear as they would be if the new table were part of a
dimension branch, but in the OLAP model there are fewer tables. In the
metaoutline, you can add columns in any order (that is, you are not required
to duplicate the OLAP model hierarchy). For example, in Figure 5-5, the
ADDITIONS and OPENINGINVENTORY columnsarein different order in
the OLAP model and the metaoutline.

In an OLAP model In a metaoutline
B8 Measures
I Accounts EIEI Profit
Be. ADDITIONS : Margin
Bs. COGS B:. SALES
B:. MARKETING B:. coGs
s MISC : O Total Expenses
B-. OPEMINGINVENTORY wflre MARKETING
fe. PAYROLL B:. PAYROLL
fz. PRODUCTID vl MISC
Bz. SALES B0 Inventory
B:. SCEMARIOID -fls. DPENINGINVENTORY
Bz STATEID [z ADDITIONS
Bz SUPFLIERID O Ending Inventary
B TRANSDATE

Figure 5-5: Displaying Table and Column Information from Multiple Tables
Combined in a Single Dimension Table

When you add a new source table directly to an existing dimension table, you
must join columns between the two tables. If a column nameis used in both
tables, the name of the added tableis prefixed to the duplicate name from the
added table. To add tables to the fact table, the time dimension, and the
accounts dimension, you must combine tables; you cannot create dimension
branches.
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5-8 |

» To add a source table to adimension table:

1. Dragthesourcetablefrom theleft frametotheright frame, position it directly

over the dimension table to which you want to add it, and release the mouse
button.

A dialog box prompts you to make sure that you want to add the columns to
the existing dimension table.

Toadd all columns of the new dimension tableto the existing dimension tabl e,
click Yes.

Hyperion Integration Server Desktop displays the Physical Joins tab of the
Table Properties dialog box, as shown in Figure 5-6.

Table Properties [ %]

Generall Colurnre  Physical Jains |

Table Table
| TBCFAMILY = |tecPrODUCT |
Column | Column | -
FamILY CAFFEINATED
FAMILYID Féibd L]0 Add
FatILYMNAME INTRODATE
INTRODATE OUNCES —
PKGTYPE
PRODUCTID LI
Colurnm 1 | Colurmn 2
TEC.PRODUCT.FaMILYID TEC.FAMILY. FaMILYID
Welete,. |
Eecursian... |

QK I Cancel | Help |

Figure 5-6: Adding a Table to a Dimension Table

Theleft Table drop-down list contains the name of the table that you just
added. Theright Table drop-down list contains the names of all tables
currently included within the dimension table, including the name of the
newly added table. The left and right Column lists contain the names of
the columns associated with the two selected tables. If a predefined
primary-foreign key relationship exists between the tables, the join
columns are displayed under Column 1 and Column 2 at the bottom

of the dialog box.
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3. If thecolumn joins listed in the join information box are correct and no joins
are missing, proceed to step 5.

4. If you need tojoin additional columns or if the columnjoinslisted in thejoin
information are not correct, complete the following steps:

a. Intheright Tablelist, select the table with which the newly added table
has a relationship.

b. From theleft and right Column lists, select from each table the columns
that you want to join; for example, FAMILYID.

Tip: If you double-click acolumnin onelist, the column with the
same name is selected in the other list.
c. Tojointhe sdlected columns, click Add.

The columns that you select are displayed in the box at the bottom of the
dialog box.

d. Asneeded, repeat steps a. through c. to join additional columns from the
selected table.

5. When you finish specifying join information for the selected table, click OK
to return to the right frame of the OLAP Model main window.

If you select the original dimension table to which you have added the new
dimension table and then right-click and select View Columns, al of the
columns that the new table contains are displayed in the original dimension
table.

Now isagood time to hide or delete unwanted columns that the dimension table
received from the newly added table and to mark columns as Drill-Through. See
“Hiding and Showing Columns” on page 6-6, “ Deleting Columns’ on page 6-9,
and “Defining Drill-Through Columns” on page 6-12.

Note: Deleted columns are permanently removed from the OLAP model. If

you later decide to include the deleted columns, you must re-create
the OLAP model.
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About Adding Tables to the Time Dimension
When adding source tables to the time dimension, remember the following:

e Thetablethat you add must have at least one column with date or time
information; for example, a shipping date. The column can be any data type.

e Thecolumns are not added to the fact table. Likewise, when you add atable
to the fact table, the columns are not added to the time dimension.

For instructions on how to add tables to the time dimension, see “Adding Source
Tables Directly to Dimension Tables” on page 5-7.

About Adding Tables to the Accounts Dimension

When adding source tables to the accounts dimension, remember the following:

e The source table that you are adding must have at least one measures data
column; for example, COGS (cost of goods sold).

e Thecolumnsare added to the fact table. Likewise, when you add atableto the
fact table, the columns it contains are added to the accounts dimension.

e Intheaccountsdimension, you can hide or del ete non-measures columns after
you add atable (see “Hiding and Showing Columns” on page 6-6 and
“Deleting Columns” on page 6-9).

e Columnsthat are hidden or deleted in the accounts dimension do not appear
in the fact table; likewise, columns that are hidden or deleted in the fact table
do not appear in the accounts dimension.

Note: Deleted columns are permanently removed from the OLAP model. If
you later decide to include the deleted columns, you must re-create
the OLAP model.

For instructions on how to add tables to the accounts dimension, see “ Adding
Source Tables Directly to Dimension Tables” on page 5-7.
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About Adding Tables to the Fact Table

After you create afact table, you can add other tables from the relational data
source to the fact table. For example, assume that you created the fact table from
asdestable in therelational data source. If you want to track inventory and keep
inventory data values in a separate table, you need to add to the fact table the
necessary columns from the relational data source inventory table.

When adding source tables to the fact table, remember the following:

e When you add a source table to the fact table, the source table columns are
added to the accounts dimension. Likewise, when you add atable to the
accounts dimension, the source table columns are added to the fact table.

e You can hide or delete columnsin the fact table after you add atable (see
“Hiding and Showing Columns” on page 6-6 and “ Deleting Columns’ on

page 6-9).
e Columnsthat are hidden or deleted in the fact table do not appear in the

accounts dimension; likewise, columns that are hidden or deleted in the
accounts dimension do not appear in the fact table.

e When you add a source table to the time dimension, the source table columns
are not added to the fact table. Likewise, when you add a source table to the
fact table, the source table columns are not added to the time dimension.

To ensurethat you select the correct relational sourcetablesto add to thefact table,
view the column names within the tables as described in “ Display of Column
Names’ on page 3-15. If you decide to hide columns after adding atable, check
column names after compl eting the process to make sure that you made the correct
selections.

Note: Deleted columns are permanently removed from the OLAP model.
If you later decide to include those columns, you must re-create the
OLAP modd.
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Adding Tables to the Fact Table

» To add tables to the fact table:

1. Dragthesourcetablefrom theleft frametotheright frame, positionit directly
over the fact table, and release the mouse button.

A dialog box prompts you to make sure that you want to add the columns to
the fact table.

2. To add the new table to the fact table, click Yes.

Hyperion Integration Server Desktop displays the Physical Joinstab in the
Table Properties dialog box.

3. Jointhe new tableto the fact table as described in “ Joining Dimension Tables
Directly to the Fact Table” on page 9-6.

Now isagood timeto hide or delete unwanted columnsthat the fact table received
from the newly added table. See “Hiding and Showing Columns’ on page 6-6 and
“Deleting Columns” on page 6-9.

Note: Deleted columns are permanently removed from the OLAP model. If

you later decide to include the deleted columns, you must re-create
the OLAP model.
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Viewing Dimension Table and
Fact Table Information

Theright frame of the OLAP Model main window contains the fact table and the
dimension tablesthat the OLAP model contains. Thistopic describes how to view
information about the fact table and related dimension tables.

> To view properties of adimension table or of the fact table:
1. Select the dimension table or the fact table, and then select View > Properties

> Table.

Hyperion Integration Server Desktop displays the General tab of the Table
Propertiesdiaog box, asshownin Figure 5-7. The Gener al tab describesthe
dimension table—its name, its dimension, its level, and the names of its
relational source tables. The fact tableislevel 0. Dimension tables joined to
the fact table are level 1. In adimension branch, dimension tables joined to
level 1 dimension tables are level 2; dimension tables joined to level 2 tables
arelevel 3, and so on.

Table Properties [ %]

General | Eolumnsl PhysicalJoinsI Dimensionsl

Mame:
ISALESFAET

Dimensior:

Lewvel:

List of Physical Table(z]
TBC.S4LESFACT

QK I Cancel | Help |

Figure 5-7: General Tab of the Table Properties Dialog Box
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2. Toview thetable propertiesfor thefact table, select the Dimensionstab to see
alist of all dimensionsin the OLAP model, as shown in Figure 5-8.

Table Properties [ %]

Generall Eolumnsl Physical Joing ~ Dimensions |

Accounts Edit |
PRODUCT

Time

QK I Cancel | Help |

Figure 5-8: Viewing the Names of Dimensions in an OLAP Model

Renaming Dimensions and the Fact Table

When you create an OL AP model fact table or adimension, the source table name
isused by default. Thistopic describes how to change the name of adimension or
the name of the fact table. For information on how to change adimension table
name, see “Renaming Dimension Tables’ on page 5-15.

» To rename adimension or to rename the fact table:

1. Intheright frame of the OLAP Model main window, select the dimension or
the fact table, right-click, and select Rename.

2. Typethe new namefor the dimension or the fact table; for example, REGION.
Follow the rules described in * Observing Naming Rules’ on page 3-28.
3. PressEnter to record the new name.

Hyperion Integration Server Desktop displays the new name in the right
frame.
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Renaming Dimension Tables

When you create adimension table, the source table name becomes the dimension
table name by default. Thistopic describes how to change the name of adimension
table. For information on how to change the name of a dimension or of the fact
table, see “Renaming Dimensions and the Fact Table” on page 5-14.

» To rename a dimension table:

1. Intheright frame of the OLAP Model main window, select the dimension
table.

If the dimension table is not visible, drag the corner of the dimension box
down until the dimension table is visible.

2. Click thedimension table.
3. Typethe new name.
Follow the rules described in * Observing Naming Rules’ on page 3-28.

4. PressEnter to record the new name.

Hyperion Integration Server Desktop displays the new name in the right
frame.

Moving Tables

Y ou can rearrange dimension tables and the fact table in the right frame. For
example, you can move atableto allow room to display al columns of thetablein
theright frame. Y ou can a so move tablesto display the tables more clearly in the
right frame of the OLAP Model main window.

» Tomove atable:

1. Make surethat thejointool isin Move mode, not in Add Joins mode.

In Move mode, the join toal is not indented, -

In Add Joins mode, the join tool isindented, 2 .

If the join tool isin Add Joins mode, click the join tool to change it to
Move mode.
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2.

Select the dimension table and drag it to the new location.

If the dimension table that you move isjoined to another dimension table, the
join line also moves.

Deleting Dimension Tables or the Fact Table

Remember these rules when deleting dimension tables or the fact table:

5-16 &

If you delete atable, its columns are not available for metaoutlines.

Deleting atablein the OLAP model does not affect the tables of the relational
data source.

When you delete atable, you also delete the joins associated withiit.

If you delete atablethat isthe primary dimension table of adimension branch,
the other dimension tables of the branch remain in the OLAP model as
unjoined dimension tables. When you validate or save an OLAP model with
unjoined tables, you receive an error message and you cannot use the model
to create a metaoutline.

You cannot delete tables that are used in hierarchies or metaoutlines.
If you delete the fact table, the accounts dimension is del eted.

If you delete the fact table and you created the time dimension from the fact
table, the time dimension is deleted.

If you delete the fact table, the next source table that you drag to the right
frameis used to create a new fact table.

» To delete adimension table or the fact table:

1.

Intheright frame of the OL AP model main window, right-click the dimension
table or the fact table, and select Delete.

Hyperion Integration Server Desktop displays a delete confirmation dialog
box.

Click Yesto confirm the deletion.
The dimension table or fact table is removed from the OLAP mode!.
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citaiss Editing Columns in
Dimension Tables
and the Fact Table

Each source table that you drag to the right frame to create a fact table or
dimension table contains columns. Y ou can perform operations on columns
contained in the tables. For example, you can rename, hide, and delete columns.

This chapter describes how to edit columns and how to create user-defined
columns. For information on changing column values, see Chapter 7,
“Transforming Columns.” For information about selecting columns to be
attribute-enabled, see Chapter 8, “ Setting Attribute-Enabled Columns.”

Note: For examples of how to enable columns to be attributes, refer to the
proceduresin Appendix A, “Creating a Sample OLAP Model
Containing Attribute-Enabled Columns.” Therelational data source,
OLAP Metadata Catalog, OLAP model, metaoutline, and dataon the
example screensin this appendix are based on the sample TBC
application provided with Hyperion Integration Server.

This chapter contains the following topics:

e “Understanding the OLAP Model Workflow” on page 6-2
e “About Column Data Types’ on page 6-3

e “Viewing Column Properties’ on page 6-4

e “Renaming Columns’ on page 6-6

e “Hiding and Showing Columns’ on page 6-6

e “Working with Multiple Columns’ on page 6-8

e “Deéleting Columns’ on page 6-9

e “Using aColumn to Create Time Hierarchies’ on page 6-10
e “Defining Drill-Through Columns’ on page 6-12

e “Creating User-Defined Columns’ on page 6-14
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Understanding the OLAP Model Workflow

6-2

Figure 6-1 illustrates the workflow for creating an OLAP model. This workflow
includes creating and working with an OLAP model; creating afact table, an
accounts dimension, and atime dimension; creating and working with dimensions;
editing and transforming the columns of dimension tables; joining dimension
tables; and creating and working with hierarchies. This chapter focuses on editing
columnsin dimension tables and the fact table.

Creating and working | T i Ty e 1 1o L]
with OLAP Models ::= File Edit %iew Connections Tools ‘window Help

DEE|&] & [#] 2] 2 | /

::= File Edit “iew Connections Toolz ‘Window Help
Creating a fact table, DEME &= #|£]2 ] }

an accounts dimension, |[m-E1 TECFAMILY | /
and a time dimension 71 TBC.MARKET @Q
& MARKET | [@vear |
Creating and working 1 SALESFACT TE—E. AECOUNtS
with dimensions = PRODUCT | % | SCENARIO |

Table Properties
@ Editing and
transforming

You Are Here  columns

[]

General Columns | PhysicalJoinsI

| Table Mame | Column Marme | Hidden
Enec CAFFEINATED TBC.PRODUCT  CAFFEINATED

B FAMILYID TBC.PRODUCT  FAMILYID

Table Properties

General Columns | PhysicalJoinsI

| Table Mame | Column Marme | Hidden
Enec CAFFEINATED TBC.PRODUCT  CAFFEINATED

Be: FAMILYID TEC.PRODUCT  FAMILYID

B@INTRODATE  TECPRODUCT INTRODATE

Edit Hierarchy
Mame:

Joining dimension tables

[VEAR-DUARTER-MONTH
. ) EE‘?’ “ear B, Year
Creating and working -5 Time =A% Time. Quarter
with hierarchies [ .0 TICNS - Time.Manth

P.. COGS
s MARKETING
B MISC

Figure 6-1: OLAP Model Workflow
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About Column Data Types

When you drag asourcetableto theright frameto create afact table or adimension
table, OLAP Integration Server assigns a data type to each column of the table
based on the Open Database Connectivity (ODBC) data type of the column in the
source table. Table 6-1 shows commonly used names for these data types. Some
relational database management systems (RDBM Ss) use different names. Some
RDBMSs do not list all types; see the SQL documentation for the RDBM S that
you are using.

An OLAP model refersto columns as having numeric, string, or datetime
data types.

Table 6-1: Mapping ODBC Data Types to Hyperion
Integration Server Data Types

ODBC Data Type Hyperion Integration Server Data Type

CHAR String and Boolean. OLAP Integration Server handles
CHAR columns that include up to 80 characters. For a
CHAR column exceeding 80 characters, add a string
column that is based on the CHAR column and use a
substring transformation rule to extract 80 or fewer
characters (see “ Creating User-Defined Columns’ on
page 6-14).

VARCHAR String and Boolean

DECIMAL Numeric and Boolean

NUMERIC Numeric and Boolean

TINYINT Numeric and Boolean

SMALLINT Numeric and Boolean

BIGINT Numeric and Boolean

INTEGER Numeric and Boolean

REAL Numeric and Boolean

FLOAT Numeric and Boolean

DOUBLE Numeric and Boolean
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Table 6-1: Mapping ODBC Data Types to Hyperion
Integration Server Data Types (Continued)

ODBC Data Type Hyperion Integration Server Data Type
DATE DateTime
TIME DateTime
TIMESTAMP DateTime

OLAP Integration Server does not include columns with the following data types:
e LONGVARCHAR

e BIT

e BINARY

e VARBINARY

e LONGVARBINARY

Viewing Column Properties

In the OLAP Model main window, you can view the name and properties of any
column at any time.

» To display the names and properties of columnsin adimension table or in the fact
table:

1. Todisplay ascrollablelist of column names, as shownin Figure 6-2,
right-click the dimension and select View Columns.

& PRODUCT
PRODUCT 4]
Blee CAFFEINATED J

Ba: FAMILYID

B INTRODATE

P DUNCES

B PRGTYPE -

Figure 6-2: View Columns Option

6-4 W Hyperion Integration Server Desktop OLAP Model User’s Guide



Editing Columns in Dimension Tables and the Fact Table

The following graphics identify column properties:

E“B,: identifies a string column.

H: « identifies ameasures column in the fact table.

E identifies a numeric column in any dimension table other than the fact
12z
table.

identifies a datetime column.
identifies a hidden column.

identifies a Drill-Through column.

identifies a primary key column.

identifies a column on which a hierarchy filter is defined.

identifies a column on which a column transformation is defined.

o
2
(-] identifies ajoin column.
&y
e
%o
&

identifies a column on which a hierarchy transformation is defined.

2. If you want to turn off the display of al graphics next to columns, deselect
View > Model Icons > All.

Y ou can aso choose to turn off the display of individual column graphics; for
example, to turn off the display of all primary key graphicsin the OLAP
model, deselect View > Model Icons > Primary Key.

3. Toclosethe column ligt, right-click and select View Columns.
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Editing Columns

Y ou can perform avariety of basic editing procedures on columns. Y ou can
rename columns, hide and show columns, and delete columns. When you edit
columns, you can select an individua column, or you can select multiple columns
on which you want to perform the same editing procedure.

Note: To learn how to select columns as attribute-enabled in an OLAP
model, see Appendix A, “Creating a Sample OLAP Model
Containing Attribute-Enabled Columns” and Chapter 8, “ Setting
Attribute-Enabled Columns.”

Renaming Columns
Y ou can rename any column in adimension table or in the fact table. Renaming a
column in the OLAP model does not affect the relational data source.
» To rename a column:
1. Intheright frame of the OLAP Model main window, select the column.

If the column is not visible, drag down the corner of the dimension table
containing the column until the columniisvisible.

2. Select the column name.
3. Typethe new column name.

Follow the rules described in * Observing Naming Rules’ on page 3-28.
4. Press Enter to record the new name.

Hyperion Integration Server displays the new name in the selected table.

Hiding and Showing Columns

Typicaly, relational data source tables contain some columnsthat you do not want
to include in a Hyperion Esshase database. Hiding a column removes it from an
OLAP mode in the sense that the column is not available to ametaoutline as a
member level, ameasure, an dias, or a Drill-Through column.
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Y ou can join dimension tables on hidden columns. Y ou can also show apreviously
hidden column if you change your mind and want to make the column available to
ametaoutline. Hiding columns does not affect the relational data source.

Note: Inan OLAP model, you cannot hide a column that is used in an
associated metaoutline.

» To hide or show acolumn:
1. Choose one of the following options:

e Select the fact table or dimension table, and then select
View > Properties > Table.

e Dragthe corner of adimension table until its columns are visible,
right-click the table name within the column view, and select Properties.

Hyperion Integration Server Desktop displays the General tab of the Table
Properties dialog box.

2. Select the Columnstab.

The Columnstab displaysall columnsavailableinthe OLAP model. For each
hidden column, the Hidden field containsa Y (Yes), as shownin Figure 6-3.

Table Properties [ %]

General Columns | PhysicalJoinsI

Mame | Table Mame | Column Marme | H| D| Al

wec CAFFEINA . TBC.PRODU...  CAFFEINATED Y Eddit... |

B FAMILYID TBC.PRODU.. FAMILYID

B@INTRODATE TECPRODU.. INTRODATE Y Add...
Bz DUNCES TBC.PRODU.. OUMWCES A
Be:PKGTYPE  TBCPRODU.. PKGTYPE Y Delete. |

B: PRODUCTID TECPRODU..  PRODUCTID A

EnscSKU TEC.PRODU... SkU N [ate-Hierarchy |
BeoSKUMAME  TECPRODU..  SKUMAME

Hide: |

Lrill-Dhraugt |

Atribute |

QK I Cancel | Help |

Figure 6-3: Viewing Hidden Columns on the Columns Tab
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3. Choose one of the following settings:

e To hide one or more available columns (columns without aY in the
Hidden column), select each appropriate column, and click Hide.

e To show one or more hidden columns (columnswithaY in the Hidden
column), select each appropriate column, and click Hide to reverse the
Setting.

To select multiple columns, see “Working with Multiple Columns’ on
page 6-8.

If you select acombination of columns (some with and some without theY in
the Hidden column) and then click Hide, all selected columns are hidden.

If you select acolumnwithaY inthe Drill-Through column, the Y is
removed from the Drill-Through column and placed in the Hidden column
because columns cannot be both hidden and Drill-Through.

Working with Multiple Columns

Y ou can apply aprocedureto an individual column or to multiple columns. If you
want to apply a procedure to multiple columns, use the Table Propertiesdialog
box to select the members.

» To select multiple, contiguous columnsin the Table Properties diaog box:
1. Click the name of the first column.
2. Shift-click the name of the last column.

Thefirst, last, and all columns between are selected.

» To select multiple, non-contiguous columnsin the Table Properties dialog box:
1. Click the name of the first column.

2. Hold down Ctrl and click the individual names of the other columns.

6-8 | Hyperion Integration Server Desktop OLAP Model User’s Guide



Editing Columns in Dimension Tables and the Fact Table

Deleting Columns

Y ou can delete unwanted columns from dimension tables and from the fact
table. Deleting columnsis different from hiding columns; deleted columns are
permanently removed from the OLAP model. If you later decide to include the
deleted columns, you must re-create the OLAP model.

Deleting columns from an OLAP model does not affect therelational data source.

Note: You cannot delete columns that are currently used in joins,
hierarchies, or associated metaoutlines.

» To delete a column from a dimension table or from the fact table:

1. Select the dimension table or the fact table, and then select
View > Properties > Table.

Hyperion Integration Server Desktop displays the Table Properties dialog
box.

Tip: You can aso delete a column by selecting it in the OLAP Model
main window, right-clicking, and selecting Delete.

2. Select the Columnstab.
3. Sedlect the column to delete.

To select multiple columns, see “Working with Multiple Columns’ on
page 6-8.
4. Click Delete.

Hyperion Integration Server Desktop displays a delete confirmation dialog
box.

CAUTION: Use caution when deleting. You cannot undo the deletion
of acolumn.

5. Click Yesto confirm the deletion.

The selected column name is removed from the list of namesin the
Columns tab.
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Using a Column to Create Time Hierarchies
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Y ou can create predefined time hierarchies automatically from a single column.
For example, you can select a column containing a timestamp, such asbec 29
2000 0733AM and use the values of the timestamp to create a hierarchy that
includes the year (2000), quarter (Qtr_4) and month (December).

» To transform a date column into a hierarchy:

1. Select the dimension table that contains the column that you want to use to
create a hierarchy and then select View > Properties > Table to display the
Table Properties dialog box.

2. IntheTable Properties dialog box, select the Columnstab.

Hyperion Integration Server Desktop displays the Columns tab of the Table
Properties dialog box, as shown in Figure 6-4.

Table Properties [ %]

General Columns | PhysicalJoinsI

Mame | Table Mame | Column Marme | H| D| A..:I

1ex MARKETING TBC.SALESF.. MARKETING Edi... |

B MISC TBC.SALESF.. MISC
A& Manth TBC.SALESF.. TRANSDATE Add..
P OPEMINGI.. TEC.SALESF.. OPEMNINGIN..

e PAYROLL  TBC.SALESF.. PAYROLL Delete. . |

Be: PRODUCTID TBC.SALESF.. PRODUCTID

Hé Quarter TBC.SALESF.. TRAMSDATE [ate-Hierarchy |

P SALES TBCSALESF.. SALES

Bz SCENARIO.. TBC.SALESF.. SCEMARIDID Hide |

B STATEID TBCSALESF.. STATEID

B: SUPPLIERID TBC.SALESF.. SUPPLIERID Drill-Through |

BmTRANSDA.. TECSALESF.. TRANSDATE —

|51 | o Aupue |

QK I Cancel | Help |

Figure 6-4: Columns Tab, Table Properties Dialog Box
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3. Select the appropriate date or time column, and click Date-Hierar chy.
Hyperion Integration Server Desktop displays the Date Hierarchy dialog
box, as shown in Figure 6-5.

Date Hierarchy [ %]

To create a date hierarchy from a single table column, select from the
lizt below

“rear, Huarter la oK I
‘Vear, Quarter, Month —

‘ear, Quarter, Month, Week |
‘Year, Quarter, Maonth, Day Capee!
“ear, Quarter, Morth, Week, Day Hel |
“rear, Month il

‘Year, Month, Week

‘Year, Month, Week, Day

“ear, Month, Day

‘ear, Week

Year, Day

Quarter, Maonth —
Quarter, Month, Week

Guarter, Month, wWeek, Day LI

Figure 6-5: Date Hierarchy Dialog Box

4. Select the hierarchy to create from the selected column; for example, Y ear,
Quarter, Month.

If you attempt to create a hierarchy that includes a column that already exists
within the OLAP model, Hyperion Integration Server displays an error
message. Y ou cannot create a hierarchy with a duplicate column name,
whether the duplicate column is contained in the source data or in an OLAP
model fact table or dimension table (including user-defined columns).

5. Toreturn tothe OLAP Model main window, click OK twice.
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Defining Drill-Through Columns
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Drill-Through columns are not avail able as member levels, aliases, or measuresin
metaoutlines. Therefore, Drill-Through columns are not available to Hyperion
Essbase databases. However, Drill-Through columns are available to Hyperion
Essbase database users as additional information in reports.

For example, if you set the PRODDESC column as Drill-Through, PRODDESC
is not available to the Hyperion Essbase database. However, when Hyperion
Esshase Spreadsheet Add-in users drill through to a report that contains the
PRODDESC column, they see the product descriptions as a part of the detail. For
more information about Drill-Through reports, see the Hyperion Integration
Server Desktop OLAP Metaoutline User’s Guide.

Use the following guidelines when creating Drill-Through columns:

e You cannot define columnsin the accounts dimension table and the fact table
as Drill-Through.

e You cannot define a column as Drill-Through if the column isused in an
associated metaoutline.

e You can define hidden columns as Drill-Through.

CAUTION: Do not define columns as Drill-Through if you want to use
the columns as aliases, member levels, or measuresin a
metaoutline.
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» To change the Drill-Through property of a column:

1. Choose one of the following methods to display the General tab of the Table
Properties dialog box:

e Select the dimension table, and select View > Properties > Table.

e Dragthe corner of adimension table until its columns are visible,
right-click the table name within the column view, and select Properties.

2. Select the Columnstab.

The Columns tab displays all columns of the OLAP model, as shown in
Figure 6-6. Each Drill-Through column displaysaY (Yes) in the
Drill-Through field. All numeric columns in the accounts dimension table
and the fact table show NA under Drill-Through. An NA indicates that a
column is not available as a Drill-Through column.

Table Properties [ %]

General Columns | PhysicalJoinsI

Table Mame | Calumnn Na... [ Hid_. [ Drill-Thraugh |

wee CAFFEINA. . TBC.PRO..  CAFFEINA.. Edit... |

B FAMILYID TBCPRO... FAMILYID

B@INTRODATE TECFRO.. INTRODA.. Add.
P OUNCES  TEBCPRO..  OUNCES
BuePKGTYPE  TECPRO.. PKGTYPE Delete.. |
Pu: PRODUCTID TEC.PRO..  PRODUC.. ¥
o ) TBCPRO..  SKU Y DBte HierarEhy |
BueeSKUNAME  TECPRO..  SKUMAME
Hide |

Dill-Through |

4] i Bl Attribute |

QK I Cancel | Help |

Figure 6-6: Viewing Drill-Through Columns on the Columns Tab

3. Select one or more columns for which you want to add or remove the
Drill-Through property.

To select multiple columns, see “Working with Multiple Columns’ on
page 6-8.
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4. Click Drill-Through.

e If you select only columns that do not haveaY (Yes) inthe
Drill-Through column, each selected column receivesaY.

e If you select only columns that have aY in the Drill-Through column,
the Y of each selected column is removed.

e If you select acombination of columnsthat do and do not haveay inthe
Drill-Through column, each selected column receivesor retainsaY (as
determined by its previous status).

e If youselect acolumnthat hasa inthe Hidden column, theY is
removed from the Hidden column and placed in the Drill-Through
column because columns cannot be both hidden and Drill-Through.

Creating User-Defined Columns
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User-defined columns are columns that you create, based on existing columnsin
the relational database. Y ou may want to add user-defined columns to dimension
tables for several reasons. For example, assume that you want to split out a
specific portion of the PRODCODE column. To accomplish this, create a
SHORTPROD column from the first six characters of the PRODCODE column.
As aresult, when the value of PRODCODE is 100-10-C001-S0003, the value of
SHORTPROD is 100-10.

Another reason to add user-defined columnsisto use the columns aslevelsin a
time hierarchy. If you want monthly and quarterly aggregationsin the Hyperion
Essbase database, you need monthly and quarterly columnsin the dimension table
for the time dimension. Y ou can add the columns as user-defined columns and
derive their values from a single transaction date column contained in the same
dimension table.

Y ou must base a user-defined column on existing columns in a dimension table.
A user-defined column assumes a numeric, string, or datetime data type, based on
the data type of the source column, as discussed in “ About Column Data Types’
on page 6-3. You cannot change the data type of a column.

Adding user-defined columns to a dimension table includes two major steps:

e Selecting an existing column asthe source for the new column and naming the
new column

e Applying transformation rules that determine how the data values of the
user-defined column are derived from the source column
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» To add a user-defined column to a dimension table:

1. Select thetable that contains the source column on which you want to base a
new column.

2. Choose one of the following methods to display the General tab of the Table
Properties dialog box:

e Select the fact table or dimension table and then select
View > Properties > Table.

e Dragthe corner of adimension table until its columns are visible,
right-click the table name within the column view, and select Properties.

3. IntheTable Properties dialog box, select the Columnstab.

Hyperion Integration Server Desktop displays the Columnstab of the Table
Properties dialog box, as shown in Figure 6-7.

Table Properties [ %]

General Columns | PhysicalJoinsI

Mame | Table Mame | Column Marme | H| D| Al

wc DIRECTOR  TECREGION  DIRECTOR Edit... |
Eﬁ

B i

e REGION TBCREGION  REGIOM
g=clullvg TECREGIOW  REGIOWID Add...

Delete... |
[ate-Hierarchy |
Hide |
Dill-Through |
Attribute |

QK I Cancel | Help |

Figure 6-7: Table Properties Dialog Box, Columns Tab
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4. Click Add.

Hyperion Integration Server Desktop displays the Add New Column to
Table dialog box, as shown in Figure 6-8.

Marne:
IF'hysicaI Table: Cancel |
|TBC.REGION =l Help |
Physical Columi:

|REGIONID =l

Type:

INumeric

Figure 6-8: Adding a User-defined Column to a Dimension Table

5. Enter the name of the user-defined column; for example, California.
Follow the rules described in “ Observing Naming Rules’ on page 3-28.

6. FromthePhysical Tablelist, select the source table that contains the column
on which you are basing the user-defined column; for example,
TBC.REGION.

7. From the Physical Column list, select the source column that contains the
data values from which you want to derive the values of the new column; for
example, REGIONID.
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8. Click OK.

Hyperion Integration Server Desktop displaysthe General tab of the Column

Propertiesdialog box, asshown in Figure 6-9. Thetab listsinformation about
the column that you are creating.

Column Properties [ %]
General | Transfarmation Hulel
M ame:
|mm
Fhysical Table:
ITBE.HEGIDN
Physical Column:
IHEGIDNID
Type:
INumeric j
QK I Cancel | Help |

Figure 6-9: Specifying General Properties for a User-defined Column

The General tab displays the name that you just entered, the names of the
source (physical) table and column, and the data type of the column.

If the user-defined column isin the accounts dimension and the column has a
numeric data type, the dialog box also contains an Aggregation drop-down
list. Aggregation options are methods for consolidating column data.
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9. If the user-defined column belongs to the accounts dimension table, from the
Aggregation drop-down list, select an aggregation option.

SUM: addsthe datafor each reporting level. SUM isthe default selection.

<NONE>: prevents a column from being available as measures to the
metaoutline. Typically, <NONE> isthe aggregation option specified for a
join column.

AVG MIN, or MAX: reports, respectively, the average, minimum, or
maximum value computed from the datain the column.

COUNT: reports, for each reporting level, a count of the source datacells
that are not NULL.

10. To define the transformation rule for the user-defined column, select the
Transfor mation Rule tab.

Hyperion Integration Server Desktop displays the Transformation Rule tab
appropriate to the data type of the column with which you are working.

For more information about transformations for each data type, see one

or more of the following subtopics:

6-18 W

“Defining Transformations that Use Substrings to Create String
Columns’ on page 7-3

“Defining Transformations that Use Concatenations to Create String
Columns” on page 7-5

“Defining Transformations for Numeric Columns’ on page 7-8
“Defining Transformations for Datetime Columns’ on page 7-12
“Defining Pass-Through Transformations” on page 7-14
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Use transformation rules to define how the datain columnsis derived. Y ou can
perform transformationsthat are common to most relational database management
systems (RDBM Ss) and define transformations that are specific to a particular
RDBMS. OLAP Integration Server performs column transformations when it
loads members into a Hyperion Essbase outline.

This chapter describes how to transform columns in the right frame of the
OLAP Model main window. For information on editing columns, see Chapter 6,
“Editing Columnsin Dimension Tables and the Fact Table.” For information on
transforming columns that are part of a hierarchy, see Chapter 10, “Creating and
Working with Hierarchies.”

This chapter contains the following topics:
e “Understanding the OLAP Model Workflow” on page 7-2

e “Defining Transformations that Use Substringsto Create String Columns’ on
page 7-3

e “Defining Transformations that Use Concatenations to Create String
Columns’ on page 7-5

e “Defining Transformations for Numeric Columns’ on page 7-8
e “Defining Transformations for Datetime Columns’ on page 7-12
e “Defining Pass-Through Transformations’ on page 7-14

e “Editing Column Transformation Rules’ on page 7-17
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Understanding the OLAP Model Workflow

Figure 7-1 illustrates the workflow for creating an OLAP model. This workflow
includes creating and working with an OLAP model; creating afact table, an
accounts dimension, and atime dimension; creating and working with dimensions;
editing and transforming the columns of dimension tables; joining dimension
tables; and creating and working with hierarchies. This chapter focuses on
transforming columns in dimension tables and the fact table.

Creating and working | T i Ty e 1 1o L]
with OLAP Models ::= File Edit %iew Connections Tools ‘window Help

DEE|&] & [#] 2] 2 | /

::= File Edit “iew Connections Toolz ‘Window Help

Creating a fact table, DEME &= #|£]2 ] }
an accounts dimension, |[m-E1 TECFAMILY | /
and a time dimension 73 TBCMARKET ?ﬂl
i MARKET | [@vear |
Creating and working 1AL ESEAGH I8 Accounts |
with dimensions % PRODUCT | = SCENARIO |

Table Properties
@ Editing and
transforming

You Are Here  columns

[]

General Columns | PhysicalJoinsI

| Table Mame | Column Marme | Hidden
Enec CAFFEINATED TBC.PRODUCT  CAFFEINATED

B FAMILYID TBC.PRODUCT  FAMILYID

Table Properties

General Columns | PhysicalJoinsI

| Table Mame | Column Marme | Hidden
Enec CAFFEINATED TBC.PRODUCT  CAFFEINATED

Be: FAMILYID TEC.PRODUCT  FAMILYID

B@INTRODATE  TECPRODUCT INTRODATE

Edit Hierarchy
Mame:

Joining dimension tables

[VEAR-DUARTER-MONTH
. ) EE‘?’ “ear B, Year
Creating and working -5 Time =A% Time. Quarter
with hierarchies [ .0 TICNS - Time.Manth

P.. COGS
s MARKETING
B MISC

Figure 7-1: OLAP Model Workflow
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Defining Transformations that Use Substrings
to Create String Columns

Y ou can define astring column as a substring of another column, provided that the
two columns are in the same dimension. For example, if only the six characters at
the beginning of the PRODCODE column are meaningful to your analysis, you
can create a SHORTPROD column that contains only thefirst six characters. Asa
result, when the value of PRODCODE is 100-10-C001-S0003, the value of
SHORTPROD is 100-10.

To define atransformation rule for a user-defined column, see “Creating
User-Defined Columns’ on page 6-14.

To use a pass-through transformation, see “Defining Pass-Through
Transformations” on page 7-14.
» To define atransformation rule that uses a substring to create a string column:

1. Select the appropriate dimension table and then select View > Properties >
Table.

2. IntheTable Properties diaog box, select the Columnstab.

3. Double-click the column that you want to transform to display the Column
Properties dialog box.

4. Inthe Column Propertiesdialog box, select the Transformation Rule tab.

Column Properties [ ]

General Transformation Rule |

™ Passthrough [Databass Specifich D ate-part l <Nones LI

Function:

Substring
Concatenate

QK I Cancel | Help

Figure 7-2: Transformation Rule Tab for a String Column
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The Function list displays the options that you can use to derive the new
column from the source data.

For numeric and string columnsin thetime dimension, the dialog box contains
aDate-part drop-down list. Use the optionsin the Date-part list to use a
column to define aDynamic Time Series member and to report to-date totals,
such as week-to-date totals, in the Hyperion Essbase database. For more
information about defining Dynamic Time Series members, see the Hyperion
Integration Server Desktop OLAP Metaoutline User’s Guide.

If the columnisatime-related column of thetimedimension, inthe Date-part
drop-down list, select the part of the date that you want the column to
represent.

For example, if you want the substring to contain the year, select Y ears.

In the Function list, select Substring.

Two text boxes, Start and L ength, are displayed to theright of the Function
list, as shown in Figure 7-3.

Function: Start:

Length:

=

Concatenate

Figure 7-3: Adding a Column that Is a Substring
of Another Column

In the Start text box, enter anumber that identifies the position in the source
column at which you want to start the substring.
For example, to start at the first position of the product code string, type 1.

In the Length text box, enter a number that identifies how many characters
from the source column are needed in the new column.

For example, to use the first six positions of the product code, type 6.
Click OK.
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Defining Transformations that Use
Concatenations to Create String Columns

Y ou can define the datain a string column by concatenating one or more string
columns, provided that all columns are from the same dimension. For example,
assume that you want to create asingle column, COLA_|ID_DESCRIPTION,
that contains values from both the PRODUCT _ID and the PRODUCT_DESC
columns. When the value of the PRODUCT _ID columnis 100-10 and the value of
the PRODUCT_DESC columnisKoolKola, the value of the concatenated column
becomes 100-10-KoolK ola.

To define the transformation rule for a user-defined column, see “Creating
User-Defined Columns’ on page 6-14.

To use a pass-through transformation, see “Defining Pass-Through
Transformations” on page 7-14.
» To define atransformation rule that uses a concatenation to create a string column:

1. Select the appropriate dimension table and then select View > Properties >
Table.

2. IntheTable Properties diaog box, select the Columnstab.

3. Double-click the column that you want to transform to display the Column
Properties dialog box.
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4. Inthe Column Propertiesdialog box, select the Transfor mation Rule tab.

Column Properties [ ]

General Transformation Rule |

™ Passthrough [Databass Specifich D ate-part l <Nones LI

Function:

Substring
Concatenate

QK I Cancel | Help

Figure 7-4: Transformation Rule Tab for a String Column

The Function list displays the options that you can use to derive the new
column from the source data.

For numeric and string columnsin thetime dimension, the dialog box contains
aDate-part drop-down list. Use the optionsin the Date-part list to use the
column to define a Dynamic Time Series member in the metaoutline and thus
toreport to-datetotal s, such asweek-to-date totals, from the Hyperion Essbase
database. For more information about defining Dynamic Time Series
members, see the Hyperion Integration Server Desktop OLAP Metaoutline
User’s Guide.

5. Ifthecolumnisatime-related column of thetime dimension, inthe Date-part
drop-down list, select the part of the date that you want the column to
represent.

For example, if you want the column to contain the year, select Y ears.

7-6 1 Hyperion Integration Server Desktop OLAP Model User’s Guide



Transforming Columns

6. IntheFunction list, select Concatenate.

As shown in Figure 7-5, two list boxes, Column Names and Concate
Columns, are displayed to the right of the Function list box.

Column Properties [ %]

General Transformation Rule |

[™ Pass-through [Database Specific)

Function: Column Mames

TBC.PRODUCT.PEGTYPE
TBC.PRODUCT.SKU

QK I Cancel | Help

Figure 7-5: Concatenating Columns

In the example shown in Figure 7-5, the Column Names ist displays the
name of the source table (TBC.PRODUCT) as a column name prefix and the
names of the columns that you can include in the concatenated column
(PKGTYPE and SKU). The Concate Columnslist initially displaysthe
source column you selected to transform (in this case, CAFFEINATED).

7. Inthe Column Nameslist, select the name of the next column toincludein
the concatenated column (TBC.PRODUCT.PKGTY PE in this example), and

click the = button.

The new column is placed at the end of the Concate Columnslist.

Tip: To move more than one column at atime, select multiple columns.
See “Working with Multiple Columns’ on page 6-8. Asthe
columns move to the Concate Columns list, they retain the same
sequence of the Column Names list.

8. Toinclude additional columns, repeat step 7 for each column.
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9. Asnecessary, complete and repeat one or both of the following actions:
e Toremove acolumn from the Concate Columnslist, select the column

and click the _<| button. The selected column returns to the Column
Names list.

e To change the sequence of the column namesin the Concate Columns

list, select a column name and then click the _Al button or the _"l button
until the column isin the desired location.

10. When the Concate Columnslist displays al columnsto be concatenated and
they are sequenced in the correct order, click OK.

Defining Transformations for Numeric Columns

Numeric column transformations are the most common transformations for
columns of the accounts dimension table. A numeric column transformation isthe
result of a calculation that involves a source column and anumeric column that is
located in the same dimension.

For example, you can add, subtract, multiply, or divide the value of anumeric
source column from the accounts dimension table by the value of another numeric
column from the accounts dimension tabl e to derive the value that you want to
report.

For example, assume that you want to define atransformation rule for a new
column named NETPRICE. NETPRICE can be derived from the SALES and
DISCOUNTS columns of the TBC samplefact table called TBC.FACT_TABLE.
For the transformation rule, OLAP Integration Server uses the source

column, in this case, TBC.FACT_TABLE.SALES, asthefirst operand in the
calculation.

Y ou specify the subtract operator (-) and the other operand, the
TBC.FACT_TABLE.DISCOUNTS column. Thus, thecalculationfor NETPRICE
isasfollows:

TBC.FACT TABLE.SALES - TBC.FACT TABLE.DISCOUNTS
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Asaresult, for arow with avalueof 15.80 for SALESand 3 .50 for
DISCOUNTS, the value of NETPRICE is12. 30.

To define the transformation rule for a user-defined column, see “ Creating
User-Defined Columns” on page 6-14.

To use a pass-through transformation, see “ Defining Pass-Through
Transformations’ on page 7-14.

» To define atransformation rule for a numeric column (a column with a numeric
datatype):

1. Select the appropriate dimension table and then select View > Properties >
Table.

2. IntheTable Properties dialog box, select the Columnstab.

3. Double-click the column that you want to transform to display the Column
Properties dialog box.

4. Inthe Column Propertiesdialog box, click the Transformation Rule tab.

Column Properties [ ]

General Transformation Rule |

™ Passthrough [Databass Specifich D ate-part l <Nones LI

Operator: Colurnm:
| =

I Irvoert Parameters

QK I Cancel | Help

Figure 7-6: Transformation Rule Tab for a Numeric Column
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The Operator list displays the types of operations available. The Column
drop-down list displays the names of all other numeric columnsin the
dimension table. Y ou can use any one of the numeric columns as the second
operand in the calculation.

For numeric and string columnsin thetimedimension, thedial og box contains
aDate-part drop-down list. Use the optionsin the Date-part list to use a
column to define a Dynamic Time Series member in a metaoutline and thus
to report to-date totals, such as week-to-date totals, in the Hyperion Esshase
database. For more information about defining Dynamic Time Series
members, see the Hyperion Integration Server Desktop OLAP Metaoutline
User’s Guide.

If the columnisatime-related column of thetimedimension, inthe Date-part
drop-down list, select the part of the date that you want the column to
represent.

For example, if you want the column to contain the year, select Y ears.
Inthe Operator list, select an operator; for example, minus (-).

By default, the source column is the first operand in the calculation.
Note: Inthelist of available operators, the % operator is the modulus

function. The % operator returns the remainder of adivision
calculation; the % operator does not stand for percentage.
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7. Inthe Column drop-down list, select a column to be the other operand; for
example, TBC.SALESFACT.COGS.

The calculation is displayed in the box below the Operator box, asshownin
Figure 7-7; for example:

TBC.SALESFACT.SALES - TBC.SALESFACT.COGS

Column Properties [ %]

General Transformation Rule |

[~ Pasz-through [ atabase Specifick

Operator: Colurnm:
<None> | TBC.5ALESFACT COGS =
¥

I Irvoert Parameters

PR

TBC.SALESFACT SALES - TBC.SALESFACT.COGS

QK I Cancel | Help

Figure 7-7: Defining a Transformation Rule for a Numeric Column

8. Asnecessary, complete either or both of the following actions:
e Tochangetheoperator, from the Operator list, select adifferent operator.
The calculation reflects the change.

e To reverse the sequence of the operands, select I nvert Parameters.

The operands switch their positions; for example,
TBC.SALESFACT.SALES - TBC.SALESFACT.COGS
changesto

TBC.SALESFACT.COGS - TBC.SALESFACT.SALES

9. Whenthecaculation is correct, click OK.
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For atime-related column, select atransformation rule that maps the content of the
new column to the appropriate portion of a date, such as the year or month. For
more information about columns in the time dimension, see “Creating Time and
Accounts Dimensions’ on page 2-20.

Typicaly, time-related columns have a datetime data type. Time-related data can
also be stored with a string data type, with or without formatting. For example,

a string column can contain the date formatted with slashes, 03/24/2000, or
without slashes, 03242000. Time-related data can also be stored with a numeric
data type, without formatting; for example, 20000324.

In most cases, you work with columns with a datetime data type in the time
dimension table and in the fact table. If you include a column with adatetime data
type in another type of dimension, you can use the column as ajoin column or as
a column to be used in Drill-Through spreadsheet reports (see “About Joins™ on
page 9-3 and “ Defining Drill-Through Columns’ on page 6-12).

If your fiscal year starts at any month other than January, you must use a
user-defined calendar to tie measures data to time-related columns such as month
or quarter. For information, see “ Creating Time and Accounts Dimensions’ on
page 2-20.

To define the transformation rule for a user-defined column, see “Creating
User-Defined Columns” on page 6-14.

To use a pass-through transformation, see “Defining Pass-Through
Transformations” on page 7-14.

» To define atransformation rule for a datetime column:

1. Select the appropriate dimension table and then select View > Properties >
Table.

2. IntheTable Properties dialog box, select the Columnstab.

3. Double-click the column that you want to transform to display the Column
Properties dialog box.
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4. Inthe Column Propertiesdialog box, select the Transformation Rule tab.

Column Properties [ ]

General Transformation Rule |

™ Passthrough [Databass Specifich D ate-part l <Mones LI

Category: Function:

ears
Quarters
Manths
wheeks

QK I Cancel | Help

Figure 7-8: Transformation Rule Tab for a Datetime Column

5. Inthe Category list, select the time category for the column.

Select the part of the date that you want the new column to contain. For
example, if you select the Quarters category, OLAP Integration Server inserts
the quarter of the year into the new column. If the value in the source column

is04/21/2000, which isin the second quarter, OLAP Integration Server
insertsin the new column the value 2.

To copy the full date into the column, select <None>.
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6. IntheFunction list, select how to represent the date.

Category: Function:
<Maone:

ears Tk
[Juarters MOMTH

wheeks

Description of
selected function ——Twa digit manth

Figure 7-9: Selecting the Transformation for Month Values

Asshownin Figure 7-9, if you select Months from the Category list, the
Function list displays three possible formats: MM, MMM, and MONTH. If
the date value in the source columnisapril 15, 2000, and you select MM,
OLAP Integration Server insertsin the new column the value 04. Select
MMM for athree-character abbreviation; for example, apr. Select MONTH
for afull name; for example, april. Thetext box at the bottom of the
Transformation Rule tab describes the selected function.

7. Click OK.

Defining Pass-Through Transformations

7-14 1

If you need to extract data values for a column in ways other than those provided
in the Hyperion Integration Server Desktop standard user interface, use SQL
functions specific to the source RDBMS. When you define a pass-through
transformation rule, you provide a statement that OL AP Integration Server passes
through as a part of the SQL SELECT statement that it usesto build and load the
Hyperion Essbase outline and database.

For example, assume that a new column, SALESVAR, is based on the SALES
column. Y ou want the val ue of the new column to equal the variance of the values
in the SALES column. The Hyperion Integration Server Desktop standard user
interface does not provide a variance transformation rule because the variance
function isnot common to all RDBM Ss supported by Hyperion Integration Server.
However, if the RDBM S you are using supportsthe variance function, you can use
the pass-through transformation rule to calculate the variance of the valuesin the
SALES column.
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Y ou can use any function or stored procedure that isvalid for the source RDBMS.
For example, you can include a stored procedure that determines, based on certain
parameters that you include in the procedure, which of two columns to use as an
alias column.

Y ou can also use stored proceduresto perform calculations related to the database
asawhole. Such astored procedure might reduce the number of rowsincluded in
member load and dataload. For example, the standard procedure might restrict the
load to those products whose profit is greater than 30 percent.

Note: If you define a pass-through transformation in an OLAP model, you
must use the OLAP model with the RDBM S that you were using
when you defined the pass-through transformation.

» To define a pass-through transformation:

1. Select the appropriate dimension table and then select View > Properties >
Table.

2. IntheTable Properties dialog box, select the Columnstab.

3. Double-click the column that you want to transform to display the Column
Properties dialog box.

In the Column Properties dialog box, select the Transformation Rule tab.
Click Pass-through (Database Specific).

The Transfor mation Rule tab changes to display atext box, shownin
Figure 7-10, for specifying the pass-through transformation.

6. Inthetext box, enter the command or the information needed to perform the
pass-through function.

Y ou can enter anything that you can validly insert in the SELECT clause of an
SQL statement in the source RDBMS. Make sure that the text that you enter
is not enclosed in quotation marks.

Note: For column names, always enter the user 1D, the dimension table
name, and the column name. Place periods between the elements;
for example, TBC.SALESFACT.SALES.

In the statement that you enter, do not type the word SELECT; enter only the
text that you want to add to the SELECT clause.
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The performance of the pass-through function produces the value of the new
column. Here are two examples of using the pass-through feature:

e Asshown in Figure 7-10, to derive the variance of the SALES column,
type VARIANCE (TBC.SALESFACT . SALES)

¥ Pass-through (D atabase Specific)

VARIANCE(TBC. SALESFACT SALES)

Figure 7-10: Using a Variance Pass-through Transformation

e Asshown in Figure 7-11, to derive the month portion of a date that
is stored in anumeric column (if the source RDBM S supports the %
operator as a modulus operator), type

(TBC.TIME.TRANSDATE%10000) /100)

¥ Pass-through (D atabase Specific) Date-part:|<NDne> VI

[TEC.TIME. TRANSDATE210000/100)

Figure 7-11: Using a Calculation as a Pass-through Transformation

Note: For some RDBMSs, use the MOD or MODULUS operators
instead of the % operator.

7. Click OK.
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Editing Column Transformation Rules

Column transformation rules can be changed. The rulesthat are available for use
vary, depending upon the data type of the selected column. For more information
on data types, see “ About Column Data Types’ on page 6-3.

» To change the transformation rule for a column:

1. Select the appropriate dimension table, right-click, and select View Columns.

2. Select the column to edit, right-click, and select Properties.

3. Inthe Column Propertiesdialog box, select the Transformation Rule tab
and make the appropriate changes.

For more information, see one of the following subtopics:

“Defining Transformations that Use Substrings to Create String
Columns’ on page 7-3

“Defining Transformations that Use Concatenations to Create String
Columns’ on page 7-5

“Defining Transformations for Numeric Columns’ on page 7-8
“Defining Transformations for Datetime Columns® on page 7-12
“Defining Pass-Through Transformations” on page 7-14

Hyperion Integration Server Desktop OLAP Model User’s Guide m 7-17



Transforming Columns

7-18 1 Hyperion Integration Server Desktop OLAP Model User’s Guide



Setting Attribute-Enabled
Columns

This chapter describes how to select columns as attribute-enabled.
This chapter contains the following topics:

e “Understanding the OLAP Model Workflow” on page 8-2

e “About Attributes’ on page 8-3

e “Guidelinesfor Selecting and Deselecting Columns as Attribute-Enabled” on
page 8-5
e “Selecting and Deselecting Columns as Attribute-Enabled” on page 8-6

For atutorial on creating an OLAP model containing attribute-enabled columns,
see Appendix A, “ Creating a Sample OLAP Model Containing Attribute-Enabled
Columns.”

Hyperion Integration Server Desktop OLAP Model User’s Guide H 81



Setting Attribute-Enabled Columns

Understanding the OLAP Model Workflow

82 1

Figure 8-1 illustrates the workflow for creating an OLAP model. This workflow
includes creating and working with an OLAP model; creating afact table, an
accounts dimension, and atime dimension; creating and working with dimensions;
editing and transforming the columns of dimension tables; joining dimension
tables; and creating and working with hierarchies. This chapter focuses on
selecting columns to be attribute-enabl ed.

Creating and working | T i Ty e 1 1o L]
with OLAP Models ::= File Edit %iew Connections Tools ‘window Help

DESM & s |F| &2 | /

* . Hyperion Integration Server Desktop - [TBC Model]
::= File Edit “iew Connections Toolz ‘Window Help

Creating a fact table, DEME &= #|£]2 ] }
an accounts dimension,

5-E3 TBCFAMILY | /
and a time dimension ¥ TBCMARKET ?ﬂl
i MARKET | |
Creating and working M\ SACESEACI & Accounts |
with dimensions % PRODUCT | % SCENARIO |

Table Properties
@ Editing and
transforming

General Columns | PhysicalJoinsI
You Are Here  COlUMNS

R

| Table Mame | Column Marme | Hidden
Enec CAFFEINATED TBC.PRODUCT  CAFFEINATED

B FAMILYID TBC.PRODUCT  FAMILYID

Table Properties

General Columns | PhysicalJoinsI

| Table Mame | Column Marme | Hidden

Joining dimension tables BesFAMILYID  TBC.PRODUCT FAMILYID

B@INTRODATE  TECPRODUCT INTRODATE
Edit Hierarchy

Marne:
[VEAR-DUARTER-MONTH
. ) EE‘?’ “ear B, Year
Creating and working B Time EH&) Time. Quarter
with hierarchies [ .0 TICNS - Time.Manth

P.. COGS
s MARKETING
B MISC

Figure 8-1: OLAP Model Workflow
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About Attributes

Y ou can use attributes to retrieve and analyze data not only from the perspective
of dimensions, but also in terms of characteristics, or attributes, of those
dimensions. For example, you can analyze product profitability based on size or
packaging, and you can make more effective conclusions by incorporating market
attributes, such as the population size of each market region, into your analysis.

Such an analysis can tell you that decaffeinated drinks sold in cansin small (less
than 6,000,000-population) markets are less profitable than you had anticipated.
For more details, you can filter your analysis by specific attribute criteria,
including minimum or maximum sales and profits of different productsin similar
market segments.

Here are afew ways analysis by attribute provides depth and perspective,
supporting better-informed decisions:

e You can select, aggregate, and report on data based on common features
(attributes).

e By defining attributes as having a text, numeric, Boolean, or date type, you
can filter (select) data using type-related functions such as AND, OR, NOT,
<, >, and = comparisons.

e You can use the numeric attribute type to group statistical values by attribute
ranges; for example, population groupings such as <500,000, 500,000~
1,000,000, and >1,000,000.

e YOu can view sums, counts, minimum or maximum values, and average
values of attribute data.

e Youcan perform calculations using numeric attribute valuesin cal ¢ scriptsand
member formulas.

e Youcandrill down through datato find out more detailed information, or drill
up to see asummary overview of data.

Attribute Dimensions

In the sample relational data source (TBC), products have attributes that are
characteristics of the products; for example, products have an attribute that
describestheir packaging. In the metaoutline, the product and its characteristic are
seen as two dimensions, the Products dimension, and the PKGTY PE attribute
dimension that is associated with it.
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A standard dimension is any dimension that is not an attribute dimension. When
an attribute dimension is associated with a standard dimension, the standard
dimension isthe base dimension for that attribute dimension.

After you associate a base dimension with an attribute dimension, you associate
members of the base dimension with members of the associated attribute
dimension. For example, the Market dimension member Los Angeles could be
associated with the 6000000 member of the Population attribute dimension. That
makes 6000000 an attribute of Los Angeles.

Attribute Types

Attribute dimensions have atext, numeric, Boolean, or date type that enables
different functions for grouping, selecting, or calculating data.

The default attribute typeis text. Text attributes enable the functionality of the
basi ¢ attribute member selection and attribute calculations. Thisincludes AND,
OR, NOT, <, >, and = comparisons.

The names of level 0 members of numeric attribute dimensions are numeric
values. You can perform AND, OR, NOT, <, >, and = comparisons on numeric
attributes, and you can include the names (values) of numeric attribute dimension
membersin calculations.

Y ou can also associate numeric attributes with ranges of base dimension values;
for example, you can create market population groupings such as states with
populations of 12,000,000 or lessin one group and states with apopulation greater
than 12,000,000 in another group.

All Boolean attribute dimensions in a database contain only two members. The
member names must match the settings for the database; for example, True and
False.

Y ou can use date attributes to specify the date format, either month-day-year or
day-month-year, and to sequence information accordingly. Y ou can perform
AND, OR, NOT, <, >, and = comparisons on date attributes, and you can compare
datesin a calculation.
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Differences Between Attribute Dimensions and
Standard Dimensions

In general, attribute dimensions and their members are similar to standard
dimensions and members:

e You can provide aliases and member comments for attribute dimensions.
e Attribute dimensions can include hierarchies.
e You can name generations and levels.

e You can perform spreadsheet operations on attribute dimensions and
members.

Guidelines for Selecting and Deselecting
Columns as Attribute-Enabled

When selecting or desel ecting columns to be attribute-enabled, keep in mind the
following guidelines:

e You cannot select or deselect a column as attribute-enabled if thereis an
existing recursive hierarchy which includes the column.

e You cannot add arecursive hierarchy if one of the columnsis
attribute-enabled.

e You cannot deselect a column as attribute-enabled if such action would
invalidate an existing attribute dimension that includes the selected column.

Violating any of the above guidelines generates an error message.
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Selecting and Deselecting Columns as
Attribute-Enabled

» To select or deselect a column as attribute-enabl ed:

1. Intheright frame of the OLAP Model main window, right-click the table
containing the column you want to use, and select Properties from the pop-up
menu.

If you are not sure which table acolumnisin, select View > View All
Columns.

Hyperion Integration Server Desktop displays the General tab of the Table
Properties dialog box, as shown in Figure 8-2.

Table Properties [ %]

General | Calumns | Physical Joins |

I ame:

Dimensior:

IM arket

Lewvel:

|1

List of Physical Table(z]
TEC.MARKET

QK I Cancel | Help |

Figure 8-2: Table Properties Dialog Box, General Tab
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2. Select the Columnstab.

Hyperion Integration Server Desktop displays the Columnstab of the Table
Properties dialog box, as shown in Figure 8-3.

Table Properties [ %]
General Columns | PhysicalJoinsI
Mame | Table Mame | Column Marme | HI DI At
12z POPULATIONID TECMARKET POPULATIONID Edit... |
5% . G ONID TEC.MARKET REGIONID A
Blee STATE TBC.MARKET STATE Add...
B.. STATEID TEC.MARKET STATEID
Delete... |
[ate-Hierarchy |
Hide |
Dill-Through |
1] | ] Attribute |

QK I Cancel | Help |

Figure 8-3: Tables Properties Dialog Box, Columns Tab

If acolumn has previously been attribute-enabled, the Attribute Field contains
aY (Yes); for example, REGIONID, as shown in Figure 8-3.

3. Select the name of the column you want to be attribute-enabled or the column
where you want to remove atttribute-enabled.
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4. Click Attribute.

If you select the column as attribute-enabled, the Attribute Field containsa 'Y
(Yes); for example, STATE, as shown in Figure 8-4.

Table Properties [ %]

General  Columns | PhysicalJoinsI

Narme | Table Mame | Column Mame | HI DI Alhri...
1es FOPULATIONID TBC.MARKET  POPULATIONID Edit..

P: REGIONID TEC.MARKET REGIOMID Y
oo TATE TEC.MARKET STATE A Add...
B STATEID TEC.MARKET STATEID

Delete... |

[ate-Hieranzty |

Hide |

Crrill-Through |

| | ] Attribute I

0K | Cancel | Help |

Figure 8-4: Attribute-Enabled Column

If you deselect the column as attribute-enabled, the Attribute Field no longer
containsaY (Yes).
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Chapter

Joining Dimension Tables

This chapter describes tasks that you can perform on joins between tables that an
OLAP model contains. A join establishes a relationship between the data of one
table and the data of another table. The join is based on column values common
to each table. The two tables can be one fact table and a dimension table, two
dimension tables, two source tables consolidated within a dimension table, or a
tablejoined toitself. Join relationships provide information that OL AP Integration
Server usestoretrieve datafromrelational sourcetables. OLAP Integration Server
then uses the data to build Hyperion Essbase outlines and |oad Hyperion Essbase
databases.

Note: Tasksthat you perform on the joins of an OLAP model do not affect

the relational data source.

This chapter contains the following topics:

“Understanding the OLAP Model Workflow” on page 9-2
“About Joins’ on page 9-3
“Joining Dimension Tables Directly to the Fact Table” on page 9-6

“Joining Dimension Tables to Create or Expand a Dimension Branch” on
page 9-8

“Combining Table Columns to Join Dimension Tables’ on page 9-10
“Working with Joins’ on page 9-13

“Defining a Recursive Table” on page 9-15
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Joining Dimension Tables

Understanding the OLAP Model Workflow

9-2

Figure 9-1 illustrates the workflow for creating an OLAP model. This workflow
includes creating and working with an OLAP model; creating afact table, an
accounts dimension, and atime dimension; creating and working with dimensions;
editing and transforming the columns of dimension tables; joining dimension

tables; and creating and working with hierarchies. This chapter focuses on
defining relationships between tables through joins.

Creating and working | T i Ty e 1 1o L]
with OLAP Models ::= File Edit %iew Connections Tools ‘window Help

DEE|&] & [#] 2] 2 | /

* . Hyperion Integration Server Desktop - [TBC Model]
::= File Edit “iew Connections Toolz ‘Window Help

Creating a fact table, DEME &= #|£]2 ] }
an accounts dimension, TEC.FAMILY | /
and a time dimension - TBC.MARKET ?ﬂl
i MARKET | [@vear |
Creating and working 1AL ESEAGH I8 Accounts |
with dimensions % PRODUCT | % SCENARIO |

Table Properties

General Columns | PhysicalJoinsI

| Table Mame | Column Marme | Hidden
Enec CAFFEINATED TBC.PRODUCT  CAFFEINATED

B FAMILYID TBC.PRODUCT  FAMILYID

Editing and transforming
columns

@ Joining
dimension

You Are Here  tables

Table Properties

General Columns | PhysicalJoinsI

| Table Mame | Column Marme | Hidden
Enec CAFFEINATED TBC.PRODUCT  CAFFEINATED

Be: FAMILYID TEC.PRODUCT  FAMILYID

B@INTRODATE  TECPRODUCT INTRODATE

Edit Hierarchy
Mame:

IYEAH-DUAHTEH-MDNTH

E% rear
EH&) Timne. Quarter
- Time.Manth

Creating and working
with hierarchies

Figure 9-1: OLAP Model Workflow
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About Joins

Joining Dimension Tables

Joins between two tables are formed through related columns called join columns.
Thejoin columns of the two tables represent the same entity. For example, assume
that two tables contain information about products. One table stores information
about product suppliers. The other table stores information about the number of
product units in the warehouse. Because both tables have a column that contains
product numbers, you can join the tables by using the product number columns as

join columns.

When a data value of ajoin column matches the data value of the corresponding
join column, the information contained in the associated rows of both tablesis
related. For example, in Figure 9-2, the datavaluesin join columns PRODUCTID
and PRODNO match, so all information in the KC-100 row of the PRODUCTS
table appliesto the KC-100 row of the ORDERS table. Thus, you know that the
supplier, Beverage Distrib. supplies the product Kool Colaat 1.10 per case.

PRODUCTID

PRODDESC

SUPPLIERID

UNITOFMEASURE

PRODUCTS | KC-100

Kool Cola

SUP440

case

I— Join columns

PRODNO

SUPPLIERID

SUPPLIERDESC

CONTRACTPRICE

ORDERS KC-100

SUP440

Beverage Distrib.

1.10

Figure 9-2: Join Columns Between Two Tables

Note: The names of the joined columns do not have to match.

e If the dimension table automatically joins to the fact table, and you want to
join the dimension table to adimension tablein adimension branch, deletethe
join line between the dimension table and the fact table. You can now join the
dimension table to whatever table you select (see “ Joining Dimension Tables

to Create or Expand a Dimension Branch” on page 9-8).
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Why You May Need to Define Multiple Joins

Y ou may need more than one pair of join columnsto define ajoin relationship. For
example, if aproduct number, as used by two suppliers, indicates two different
products, you need to create two pairs of join columns, as shown in Figure 9-3.
Each pair of join columnsis called a column join. One column join includes the
product number columns of both tables. The other column join includes the
SUPPLIERID columns of both tables. The second column join ensures unique
joins.

PRODUCTID PRODDESC SUPPLIERID UNITOFMEASURE

PRODUCTS | KC-100 Kool Cola SUP440 Case

ORDERS

Iﬁ Column joins 7/

PRODNO SUPPLIERID SUPPLIERDESC CONTRACTPRICE

KC-100 SUP440 Beverage Distrib. | 1.10

Figure 9-3: Using Multiple Sets of Join Columns

In this example, for product KC-100 and supplier SUP440, the data of the
two rowsisrelated. If more than one supplier supplies Kool Cola, the join
on SUPPLIERID ensures that the price and supplier name retrieved from the
PRODUCTS table are correct for each supplier.

How Joins Are Displayed in an OLAP Model

94 1

A join line between two tables indicates a join relationship. As shown in

Figure 9-4, asolidjoin lineindicates afully-defined join; that is, the join columns
of both dimension tables are specified (see “About Joins” on page 9-3). A broken
lineindicates that the dimension tables arejoined but that the join columns are not
specified.

Note: If every dimension table isnot joined either to another dimension
table or to the fact table, the OLAP modéd isinvalid. You can save an
invalid OLAP model, but you cannot use an invalid OLAP model to
create a metaoutline.
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Any dimension table that you join to the fact table becomes adimension in the
OLAP model. Any dimension table that you join to another dimension table
becomes part of the dimension of that dimension table. For more information,
see “Adding Source Tables to Create Dimension Branches’ on page 5-6.

8 Accounts

1 SALESFACT N

% PRODUCT | OET—

NI o

Figure 9-4: Working with Joins in the OLAP Model

To seethepropertiesof ajoin, select thejoinline, right-click, and select Properties.

To seethejoin columnsin ajoin, move the cursor over thejoin line. A tool tip
displays the names of the table and join columns. To hide the tool tip, deselect

View > Enable Join Tool Tips.

Note: If ajoin relationship exists between tables in the relational data
source, the columns join automatically when you add a new source
table to an existing dimension table in the OLAP model.
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Joining Dimension Tables Directly to
the Fact Table

When you join a dimension table to the fact table, the joined table is called the
primary dimension table. The primary dimension table becomes a dimension to
form adimension branch. Inadimension branch, only the primary dimension joins
directly to the fact table.

» Tojoin adimension table to the fact table:

1. Clickthejointool, < , (inthe upper right of the OLAP Model main window)
to enter Add Joins mode, and draw aline between the dimension table and the
fact table.

Tip: Another way to switchto Add Joinsmodeistoright-click in ablank
space of the right frame and select Add Joins Mode.

Hyperion Integration Server Desktop displays the Create New Dimension
dialog box.

Note: If the predefined primary-foreign relationship exists between the fact
table and the table that you drag to the right frame, Hyperion
Integration Server creates a join automatically and displays the
Create New Dimension dialog box.
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2. Specify the dimension name and dimension type and click OK .
For more information, see “Creating Dimensions’ on page 5-3.

Hyperion Integration Server Desktop displays the Edit Join I nfo dialog box,
as shown in Figure 9-5.

Edit Join Info for SALESFACT and PRODUCT E
SALESFACT PRODUCT
ADDITIONS - CAFFEINATED Close
COGS FAMILYID I_I
MARKETING INTRODATE i
MISC OUNCES =
OPEMINGINVENTORY PKGTYPE
PavYROLL PRODUCTID
PRODUCTID SkU
SALES - SKUMAME
<I I 3
Current Jain Infarmation:
Calurmn 1 | Column 2 |
SALESFACT.PRODUCTID PRODUCT.PRODUCTID |
Welete,.

Help |

Figure 9-5: Specifying Column Joins Between the Fact Table and a
New Dimension

Above the l€eft list box is the name of the fact table (in this case,
SALESFACT). Above theright list box is the name of the table
that you joined to the fact table (in this case, PRODUCT).

The list boxes (in this case, SALESFACT and PRODUCT) contain the
columns of their repective tables. If a predefined primary-foreign key
relationship exists between the tables that you are joining, the Current Join
I nformation list box contains one entry for each column join between the two
tables.

For information about deleting joins, see“ Deleting Joins Between Dimension
Tables’ on page 9-14 or “ Deleting Joins Within Dimension Tables’ on
page 9-14.
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3.

4.
5.

From each table list, select ajoin column, and click Add.

For example, select PRODUCTID in both tables. A solid line between the
selected columns connects the two tables.

The columns that you select are displayed in the Current Join Information
box.

Tip: Double-click acolumn in one table to select its corresponding
column in the other table.

For each column join that you want to add to the join definition, repeat Step 3.

Whenthe Current Join Information box listsall required columnjoins, click
Close.

Note: If you plan to create arecursive hierarchy from a newly-created
dimension, the table that you use to create the dimension must
have a self-join defined (see “ Defining a Recursive Table” on
page 9-15).

If you close the dialog box without defining a column join, thejoin line
displaysasabrokenline. The OLAPmode isinvalid. Y ou can savethe OLAP
model, but you cannot useit to create a metaoutline until all joins are defined.
If you see abroken line, create avalid join. See “Working with Joins” on
page 9-13.

Joining Dimension Tables to Create or
Expand a Dimension Branch

You can join adimension table to a primary dimension table, thus forming a
dimension branch (see “ About Dimension Branches’ on page 5-5.) You can aso

98

join adimension table to any table of adimension branch, thus expanding the

branch.
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» Tojoin two dimension tables:

1. Clickthejointool, < , (inthe upper right of the OLAP M odel main window)
to enter Add Joins mode, and drag the tool between the two tables.

Tip: Another way to switch to Add Joinsmodeisto right-click in ablank
space of the right frame and select Add Joins Mode.

Hyperion Integration Server Desktop displays the Edit Join Info dialog box
for the join, as shown in Figure 9-6.

Edit Join Info for PRODUCT and PRODUCTDIM [X]

PRODUCT

PRODUCTDIM

CAFFEINATED
FAMILYID
INTRODATE
OUMNCES
PEGTYPE
PRODUCTID
SkU
SKUNAME

Current Jain Infarmation:

FAMILY
FAMILYATTR
FAMILYMAME
SkU
SKUNAME

Calurmn 1

| Colurmn 2

PRODUCT.SKU

PRODUCTDIM.SEU

Welete,. |

Help |

Figure 9-6: Specifying or Verifying Join Information for a
New Join Between Dimension Tables

At the top of the dialog box are the names of the original dimension

table and the table that you are joining to the original table (in this case,
PRODUCT and PRODUCTDIM). Thelist boxes contain the columns of their
respectivetables. If a predefined primary-foreign key relationship exists
between the tables that you are joining, the Current Join Information list
box contains one entry for each column join.

For example, in Figure 9-6, the Current Join I nfor mation list box showsthat
the PRODUCT table and the PRODUCTDIM table are joined on the SKU
column in both tables.
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2. From eachtablelist, select acolumnto join, and click Add.
For example, select SKU in both tables.

Tip: Double-click acolumn in one table to select its corresponding
column in the other table.

The columns that you select are displayed in the Current Join Information
list box.

3. For each column join that you want to add to the join definition, repeat Step 2.
Y ou can create column joinsin any sequence.

4. When the Current Join Information list displaysall required column joins,
click Close.

In theright frame of the OL AP Model main window, asolid join line connects
the two joined tables.

Note: If you plan to create arecursive hierarchy from a newly-created
dimension, the table that you use to create the dimension must
have a self-join defined (see “ Defining a Recursive Table” on
page 9-15).

If you close the dialog box without defining a column join, thejoin line
displays as abroken line. An OLAP model that contains unjoined tablesis
invalid. You can save the OLAP model, but you cannot use it to create a
metaoutline until al joins are defined. If you see abroken line, create avalid
join. See “Working with Joins’ on page 9-13.

Combining Table Columns to Join
Dimension Tables

9-10 H

Y ou can add a source table to a dimension by dragging the source table directly
onto an existing dimension table. When you use this process, the columnsfrom the
second table are combined with the columns of the existing dimension table. When
you drop adimension table directly onto the fact table or onto another dimension
table, you must join the two tables. For more information, see “ Adding Source
Tablesto Create Dimension Branches’ on page 5-6.
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» To add and join a dimension table to another dimension table or to the fact table:
1. Intheleft frame of the OLAP Model main window, select a source table.

2. Dragthe selected source table to theright frame, and drop it on the dimension
table to which you want to join it.

When you add a source table to an existing dimension table or to thefact table,
Hyperion Integration Server Desktop displays the Physical Joins tab of the
Table Properties dialog box, as shown in Figure 9-7.

Table Properties [ %]
Generall Colurnre  Physical Jains |
Table Table
|TeC.PRODUCT =l |Tec.PRoDUCTDIM |
Column |:| Column |
INTRODATE FamILY
OUNCES FAMILYATTR
PKGTYPE FaILYMNAME
PRODUCTID SkU
SkU SKUMAME
SKUMAME A
Colurnm 1 | Colurmn 2 |
TEC.PRODUCT.SKU TEC.PRODUCTDIM.SKU
Welete,. |
Eecursian... |
QK | Cancel | Help |

Figure 9-7: Table Properties Dialog Box, Physical Joins Tab

Two drop-down lists at the top of the dialog box contain the names of the
joined tables. The Column lists display the names of the columns of their
respective tables. The join information box below lists the column joins.
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3.

If you want to find and correct columnsthat are incorrectly joined and shown

at the bottom of the dialog box or if you want to join columns that are not

already joined, complete stepsa. and b., as appropriate; otherwise, proceed to

step 4.

a. If thetablesto bejoined are not already displayed, from the two
drop-down Table lists, select the appropriate tables.

b. From each Column ligt, select a column to join, and click Add.

The columns that you join are displayed in the join information box at the
bottom of the dialog box. For example, in Figure 9-7, the list box shows that
the TBC.PRODUCT table and the TBC.PRODUCTDIM table are joined on
the SKU column in both tables.

Tip: Double-click acolumn in one table to select its corresponding
column in the other table.

If aprimary-foreign key relationship exists between one or more columns of
the selected tables, the join information box contains one entry for each
columnjoin. Inthisexample, the SKU columnsfrom the two tablesarejoined.

Repeat Step 3 for each column join at the bottom of the dialog box that you
want to add to the join definition.

Y ou can create column joinsin any sequence.

5. Click OK.
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Working with Joins

Y ou can view existing joins and edit them, as needed, to add new joinsto existing
dimension tables and to the fact table and to delete existing joins.

This topic contains the following subtopics:

e “Viewing Joins Information” on page 9-13

e “Deleting Joins Between Dimension Tables’ on page 9-14
e “Deleting Joins Within Dimension Tables’ on page 9-14

Viewing Joins Information

Toview join information for joins between tables, right-click the join line between
two dimension tables or between the fact table and a dimension table. Hyperion
Integration Server Desktop displays the Edit Join Information dialog box. (A
different dialog box is displayed if you click the dimension table rather than the
joinline.)

When the Edit Join Information dialog box opens, you can review the following
join property information:

e Names of joined tables
e Names of columns within the joined tables

e Names of joined columns

If you want to add column joins between tables, follow the same procedure as
described in Step 2 of “Joining Dimension Tables to Create or Expand a
Dimension Branch” on page 9-8.

If you want to delete column joins, see “Deleting Joins Between Dimension
Tables” on page 9-14 and “Del eting Joins Within Dimension Tables’” on
page 9-14.
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Deleting Joins Between Dimension Tables

Deleting ajoin between two dimension tables or between a dimension table and
the fact table results in an unjoined dimension table or dimension branch. An
unjoined dimension table or dimension branch makes an OLAP model invalid.

Y ou cannot create a metaoutline from an OLAP model that contains a dimension
table that is not joined either directly to the fact table or to a dimension table that
joins, in series, to the fact table.

» To delete ajoin between two dimension tables or between a dimension table and
the fact table:

1.

Right-click the join line and select Delete.

Hyperion Integration Server Desktop displays a delete confirmation dialog
box.

Click Yesto confirm the deletion.
Thejoin line disappears.

Tip: Another way to delete ajoin between dimension tablesisto select
the join line and right-click Delete.

Deleting Joins Within Dimension Tables

9-14 W

» To delete joins within a dimension table:

1.
2.

Select the appropriate dimension, right-click, and select View Columns.
In the column view, double-click the dimension table name.

Hyperion Integration Server Desktop displays the General tab of the Table
Properties dialog box.

Select the Physical Joins tab.

Click the column join that you want to delete; for example, SKU, and click
Delete.

In the OLAP model, the column join is removed from the table.
Note: If you deleteall column joins, an OLAP model becomesinvalid.
To delete atable from within adimension table, delete all the

columns from the dimension table, as described in “Deleting
Columns’ on page 6-9.
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Defining a Recursive Table

A recursive table describes the hierarchical relationship of a Hyperion Essbase
dimension in just two columns. One column functions as a parent column and the
other column functions as a child column. Information in one row relates to
information in another row.

For example, assume that a payroll database includes an EMPLOY EES table that
contains a child column, EMPLOY EE_ID, and a parent column,

REPORTS TO_ID. Asshownin Figure 9-8, the data value (100101) is included
in two rows, one row in the child column and another row in the parent column.

Parent Column Child Column
EMPLOYEES REPORTS_TO_ID EMPLOYEE_ID
Table <NULL> 100101
100101 273645
273645 978663

Figure 9-8: Example of Parent and Child Columns in a Recursive Table

To define arecursive table, you need to join the table to itself. In relational
databases, this processis called a self-join. See “Joining a Table to Itself” on
page 9-19.

For more information about recursive tables, see “Building Hyperion Essbase
Hierarchies from Recursive Tables’ on page 2-8.
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Preparing Recursive Tables to Be Used with Aliases
and User-Defined Attributes
A recursive table can contain additional information that relates to the parent

column or child column values. In Figure 9-9, the additional information provided
in the FULL_NAME column and the TITLE column relates to the employees

named in the child column, EMPLOY EE_ID.

EMPLOYEES

Table

Parent Column Child Column Additional Information
REPORTS_TO_ID | EMPLOYEE_ID FULL_NAME TITLE
<NULL> 100101 John Smith CEO
100101 273645 Mary Lee VP Sales
273645 978663 James White | Dir Sales,

Eastern Region

Figure 9-9: Example of a Recursive Table Containing Additional Information

OLAP Integration Server can use the values of the columns that provide the
additional information as aliases or as user-defined attributes (UDAS). A UDAis
aword or phrase that describes a member level.

In ametaoutline, you can assign an alias column to a parent or child column.
OLAP Integration Server then substitutes the value of the alias column for the
value of the parent or child column. Aliasesimprove the readability of Hyperion
Essbase outlines or reports. For example, if you use the product description
column (PRODUCT_DESC) as an dlias for the product code column
(PRODUCT_ID), users see the description, Root Beer, instead of the product
code, 200-10, on their reports.

In ametaoutline, you can create a UDA for a member level. For example, you
might create a UDA called Under Forecast for regions whose sales are bel ow the
forecast.

9-16 W
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Whether you can define aliases or create UDAs for columns in arecursive table
depends on the nature of the data and on how you define the joins for therecursive
table. To use aliases and UDAS, you must define joins as follows:

e Theinformation of an alias or aUDA column must be related either to the
value in the parent column or to the value in the child column. (You cannot
apply an alias or aUDA column to both the parent column and the child
column.)

e Inmost cases, the datain the column for which you are defining the alias or
UDA must be fully defined. For example, in Figure 9-9, the child columniis
fully defined and the parent column is not.

For more information about fully defined columnsin recursive tables, see
“Building Hyperion Essbhase Hierarchiesfrom Recursive Tables’ on page 2-8.

In some cases, the parent and child columns and the columns with additional
information are not in the same table. For example, in Figure 9-10, the
EMPLOY EE RELATIONSHIPS table and the EMPLOY EE DETAILStable
show such adifferentiation.

Parent Column Child Column

EMPLOYEE
RELATIONSHIPS REPORTS_TO_ID | EMPLOYEE_ID
Table <NULL> 100101

100101 273645

273645 978663

Additional Information

EMPLOYEE
DETAILS EMPLOYEE_ID FULL_NAME TITLE
Table 100101 Jean Smith CEO

273645 Mary Lee VP Saes

978663 James White Dir Sales, Eastern

Region

Figure 9-10: Example of a Recursive Table with
Additional Information in a Separate Table
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Table 9-1 describes how to define arecursive table that can be used with aliases or
UDAs. In Table 9-1, the Data value characteristics column includes only those
situations for which OLAP Integration Server can work with aliases or UDAS.

For more information about aliases and UDAS, see the Hyperion Integration
Server Desktop OLAP Metaoutline User’s Guide.

Table 9-1: Defining a Recursive Table Associated with Additional Information in
Alias or UDA Columns

When the alias or UDA
columns and the parent

When the alias or UDA
columns and the parent and

Data Value and child columns are in | child columns are in separate
Characteristics one recursive table tables
Theadditiona | 1. Definetherecursive | 1. Definetherecursivetablewith aself-join.
mfc:}rmaﬂon applies teblewith aself-join. | 2 30in the foreign key column of the table
tolt e parer(;t h 2. Hidethe child column. containing the alias or UDA column to
column and the the parent column of the recursive table.
parent column _ _
is fully defined. 3. Hidethe child column.
Theadditional | 1. Definetherecursive | 1. Definetherecursivetablewith aself-join.
mfcr)]rmart]! ? dn aﬁph& teblewith aself-join. | 2 30in the foreign key column of the table
to :j ehc Ih'lgo umn | 2 Hidethe parent containing the alias or UDA column to
?(r)]l urtnr? chi column. the child column of the recursive table.
is fully defined. 3. Hidethe parent column.
Theadditional | Youcannotuseandiasor | 1. Definetherecursivetablewith aself-join.
qurmanon applies | aUDA in this situation. 2. Join the foreign key column of the table
to Ielther the p?]rent containing the alias or UDA column to
column or tothe the parent column of the recursive table.
child column and . i

3. Join the foreign key column of the table

neither column is

containing the alias or UDA column to

fully defined. . )
the child column of the recursive table.
» Do not hide the parent column.
* Do not hide the child column.
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For further details, see:
e “JoiningaTableto Itself” on page 9-19
e “Hiding and Showing Columns’ on page 6-6

Joining a Table to Itself

» Tojoin atabletoitself:

1. Intheright frame of the OLAP Model main window, select the dimension
table to be joined to itself, and select View > Properties > Table.

Hyperion Integration Server Desktop displays the Table Properties dialog
box.

2. Select the Physical Joins tab, shown in Figure 9-11.

Table Properties [ %]
Generall Colurnre  Physical Jains |
Table Table
| TBC.MARKET x| |TeCHaRKET =l
Column | | Column |
POPULATIONID POPULATIONID
REGIONID REGIONID oy
STATE STATE —
STATEID STATEID
Colurnm 1 | Colurmn 2 |
Welete,. |
Eecursian... |
QK I Cancel | Help |

Figure 9-11: Joining a Table to Itself

On the Physical Joinstab, two Table drop-down lists display the name of the
physical table that you are joining to itself. Two Column lists display the
columnsin the table.
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3. Inthe Column list on the left, select the name of the column representing the
lower level of therelationship; for example, asshownin Figure 9-12, STATE.

4. IntheColumn list ontheright, select the name of the column representing the
higher level of the relationship; for example, as shown in Figure 9-12,
REGIONID.

Table Properties [ %]

Generall Colurnre  Physical Jains |

Tahle Tahle

| TBC.MARKET =l |TECHaRKET |

Column | | Column |
POPULATIONID POPULATIONID

REGIONID (I CINILY Add
STATE STATE —
STATEID STATEID

Colurnm 1 | Colurmn 2 |

Welete,. |
Eecursian... |

QK I Cancel | Help |

Figure 9-12: Selecting Join Columns in a Recursive Table
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5. Click Add.
The two join columns are displayed in the Recur sion dialog box.

Recursion E

Parent Columi:

REGIONID |
Cancel
Child Columr: ul=e |

|STATE
Swap |

Figure 9-13: Defining Parent and Child Relationships in a Recursive Table
If thewrong columns are displayed in the Parent Column and Child Column
list boxes, click Swap to switch the columns.
If you make a mistake, click Swap to switch the columns again.
6. Click OK.

Hyperion Integration Server Desktop displays the Physical Joins tab of the
Table Propertiesdialog box, with the table and column names in the Current
Join Information box, as shown in Figure 9-14.

Table Properties [ %]
Generall Colurnre  Physical Jains |
Table Table
| TBC.MARKET =l |TECHaRKET |
Column | | Column |
POPULATIONID POPULATIONID
REGIONID REGIONID
STATE STATE
STATEID STATEID
Colurnm 1 | Colurmn 2 |
TEC.MARKET.STATE TEC.MARKET.REGIONID
Welete,. |
Eecursian... |

QK | Cancel | Help |

Figure 9-14: Joined Columns in a Self-Joined Table
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7. Click Close.

Note: In most cases, either the Parent Column or the Child Columniis
the significant column in the table. After defining a self-join for
arecursive table, hide the column that is not significant (see
“Hiding and Showing Columns’ on page 6-6).

CAUTION: Be surethat the joins are correctly defined. Otherwise, the
Hyperion Essbase outline built from the table may not load
correctly.
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10 with Hierarchies

Within adimension in an OLAP model, you can arrange columnsinto hierarchies.
In an OLAP model, hierarchies define a tree-structure relationship of the datain
columns. In a metaoutline, this structure determines the member levels of a
dimension and the children of those member levels. Y ou can specify column
filters, sorts, and transformations on columns in hierarchies to define how data
appears in the Hyperion Essbase outline.

This chapter contains the following topics:

e “Understanding the OLAP Model Workflow” on page 10-2
e “About Hierarchies’ on page 10-3

e “Creating Hierarchies’ on page 10-7

e “Editing and Deleting Hierarchies’ on page 10-10

e “Filtering Datain Hierarchies’ on page 10-12

e “Sorting Datain Hierarchies’ on page 10-21

e ‘“Transforming Datain Hierarchies’ on page 10-22

e “Previewing the Hyperion Essbase Outline” on page 10-27
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Understanding the OLAP Model Workflow

10-2 W

Figure 10-1 illustrates the workflow for creating an OLAP model. Thisworkflow
includes creating and working with an OLAP model; creating afact table, an
accounts dimension, and atime dimension; creating and working with dimensions;
editing and transforming columns of the dimension tables; joining dimension
tables; and creating and working with hierarchies. This chapter focuses on
defining hierarchies, including creating filters, sorts, and data transformations.

Creating and working | T i Ty e 1 1o L]
with OLAP Models ::= File Edit %iew Connections Tools ‘window Help

DEE|&] & [#] 2] 2 | /

* . Hyperion Integration Server Desktop - [TBC Model]
::= File Edit “iew Connections Toolz ‘Window Help

Creating a fact table, DEME &= #|£]2 ] }
an accounts dimension, TEC.FAMILY | /
and a time dimension - TBC.MARKET ?ﬂl
i MARKET | [@vear |
Creating and working 1AL ESEAGH I8 Accounts |
with dimensions % PRODUCT | % SCENARIO |

Table Properties

General Columns | PhysicalJoinsI

| Table Mame | Column Marme | Hidden
Enec CAFFEINATED TBC.PRODUCT  CAFFEINATED

B FAMILYID TBC.PRODUCT  FAMILYID

Editing and transforming
columns

Table Properties

General Columns | PhysicalJoinsI

| Table Mame | Column Marme | Hidden
Enec CAFFEINATED TBC.PRODUCT  CAFFEINATED

Be: FAMILYID TEC.PRODUCT  FAMILYID

B@INTRODATE  TECPRODUCT INTRODATE

Edit Hierarchy

Joining dimension tables

Mame:
. IYEAH-DUAHTEH-MDNTH
@ Creating and | —— —
R i B- ar
WOrk|ng with -“-” i EHE{) Time. Quarter

You Are Here  hierarchies "Bd TimeManth

Figure 10-1: OLAP Model Workflow
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About Hierarchies

In Hyperion Essbase, hierarchies determine how datais consolidated. For
example, many businesses summarize their data monthly, roll up the monthly data
to get quarterly figures, and then roll up the quarterly datato get annual figures.
Some businesses may a so summarize data by zip code, and then by city, state, and
country. Any dimension can be used to consolidate data for reporting purposes.

For example, a hierarchy for a GEOGRAPHY dimension in an OLAP
model might look like the hierarchy shown in Figure 10-2. In this
hierarchy, REGION.REGION isachild of the dimension GEOGRAPHY,,
and MARKET.STATE isachild of REGION.REGION.

Thestructure of the hierarchy carries over to the Hyperion Essbase outline,
where you can report on salesfor individual cities, consolidate city figures
to report on sales for states, and consolidate state figures to report on
regional sales.

= % PR
&-Bies REGION.REGION

Pl MARKET.STATE
Figure 10-2: Sample Hierarchy

Hierarchies provide named structures that contain:

e Thehierarchica structure itself—alevel-by-level sequence for consolidating
data. For example, salestotalsby STATE roll up to salestotals by REGION.
If you had CITY asachild of STATE in your hierarchy, salestotalsby CITY
could roll up to sales totals by STATE.

e Thedatafiltersthat are placed on selected columns within the hierarchy—a
way to select specific categories of information. For example, you can filter
the REGION column to include only information on sales in the USA.

e Theorganizational sequence of the data—the sort sequence for a column. For
example, you can sort the MONTH column in descending sequence to see the
most recent totals first.

e Transformations—away to control column data values, which become
Hyperion Essbase member names. For example, if you had CITY asachild of
STATE in your hierarchy, you could ensure unique member names by
prefixing each STATE value with an appropriate value from the REGION
column. You could then differentiate between REGALBANY and
GAALBANY.
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After ahierarchy is created in an OLAP model, it can be dragged directly onto a
metaoutline. By creating hierarchiesin OLAP models, you can customize an
OLAP model for each user group. For example, assume that you use hierarchical
filtersin the OLAP model that you provide to users from a specific corporate
division. With such an OLAP model, the users can more easily create metaoutlines
that contain only the datarelevant to their specific division. For information about
how to use hierarchiesto create metaoutlines, see the Hyperion Integration Server
Desktop OLAP Metaoutline User’s Guide.

About Recursive Tables

A recursive table (parent and child table) contains information in one row that
isrelated to information in another row. For example, assume that you have a
recursive table named GEOGRAPHY that contains the columns GEO_CHILD
and GEO_PARENT. Thefact that thetableisrecursiveindicates that, within each
row, the child geographical areais part of the parent geographical area. Any value
can serve as both parent and child, a parent in one row and a child in another row.

For example, in Figure 10-3, zip code 01010 is within Bangor, which iswithin
Maine, which iswithin East. A <NULL> parent value defines the corresponding
child value as the highest level in the branch, in this case, USA.

GEO_CHILD GEO_PARENT
USA <NULL>

East USA

Maine East

Bangor Maine

01010 Bangor

Figure 10-3: Example Recursive Table
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Whenever OLAP Integration Server finds a<NULL> parent, the child vaueis
considered the parent of anew branch. Thus, the datain Figure 10-3 generatesthe
hierarchy shown in Figure 10-4:

Ausa
L [A]East
L [A]Maine
L [A]Bangor
o1

Figure 10-4: Hierarchy Generated from a Recursive Table

About Shared Members in Recursive Tables

When OLAP Integration Server finds a child with two parents, one parent in each
of two records, it creates a shared member. In Hyperion Essbase, a shared member
isamember that shares storage space with another member of the same name. The
use of shared members prevents Hyperion Essbase from making extracal culations
on members that are in more than one location in the outline.

For example, the relational table shown in Figure 10-5 generates a Hyperion
Essbase outline hierarchy where 100-20 (Diet Cola) is a shared member of Diet
becauseit isalready achild of 100 (Colas), and 200-20 is a shared member of Diet
becauseit isalready a child of 200 (Fruit Drinks).

Child Column Child Description Parent Column
100-10 Regular Cola 100
100-20 Diet Cola 100
100-30 Caffeine-free Cola 100
200-10 Regular Fruit-Orange | 200
200-20 Diet Fruit-Orange 200
200-30 Regular Fruit Lime 200

100 Colas <NULL>
200 Fruit Drinks <NULL>
Diet Diet Drinks <NULL>
100-20 Diet
200-20 Diet

Figure 10-5: Recursive Table Resulting in Shared Members
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The outline hierarchy based on Figure 10-5 includes the shared members 100-20
and 200-20 under Diet, as shown in Figure 10-6:

IA|PRODUCTS

[~)100 (Colas)
1DD 1D
1DD 20
100-30

[~]200
200-10
ZDD-ZD
200-30

[A)Diet
100-20
ZDD-ZD

Figure 10-6: Shared Member Hierarchy
Generated from a Recursive Table

If arelational database contains recursive tables, you need to join each recursive
table to itself (self-join) to access any related information and to consolidate the
data properly. Detailed procedures for creating a self-join are provided in
“Defining a Recursive Table” on page 9-15.

About Ragged Hierarchies

Ragged (asymmetrical) hierarchies occur when branches within adimension have
different numbers of levels. Figure 10-7 illustrates a ragged hierarchy where the
East branch contains four levels, and the West branch contains five levels:

AEast
L [A]Maine
L [A]Bangor
o1
[AJwvest
L [A] california
L [A]santa Clara County

L [A]san Jose
L [Jos129

Figure 10-7: Ragged Hierarchy

OLAP Integration Server can handle tables that create ragged hierarchies.
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» To create a hierarchy:

Creating and Working with Hierarchies

1. Double-click the dimension for which you want to create a hierarchy; for
example, MARKET.

Hyperion Integration Server Desktop displays the Dimension Properties
dialog box, as shown in Figure 10-8.

2. Inthe Dimension Properties dialog box, select the Hierar chies tab.

Dimension Properties [ %]

General Hierarchies |

Market

Eddit...

Add... |
Welete,. |

o]

Cancel | Help |

Figure 10-8: Dimension Properties Dialog Box, Hierarchies Tab

The box lists any hierarchies that have been defined for the selected

dimension.
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3. To openthe Edit Hierarchy dialog box, select adimension and click Add.

Edit Hierarchy [ %]

Higrarchyl
B Maket Ty, Hisrarchyl e |
-E# REGION —
POPULATION
Tiransfarm.. |
Wiew Table Data,.. |
Wiew Sample.. |

Cancel |
Help |

Figure 10-9: Edit Hierarchy Dialog Box

The box on the left displays the dimension name above the name of the
dimension table. The hierarchy graphic in the right box contains the default
name for the hierarchy.

4. Inthe Name text box, enter the name for the hierarchy; for example,
Geography.

The hierarchy name that you enter replaces the default name (Hierarchyl).

5. Todisplay the columnsof the selected dimension, in theleft box, click the plus
sign, [, in front of the table.

To view the datain a column, in the left box, select acolumn and click View
Table Data.

For more information, see “Viewing Table Data” on page 3-17.

10-8 H Hyperion Integration Server Desktop OLAP Model User’s Guide



Creating and Working with Hierarchies

6. To placeacolumn at thetop of the hierarchy, in the left box, double-click the
column name.

The name of the selected column is displayed in the right box immediately
below the name of the hierarchy. For example, double-click the REGION
columnto placeit at thetop of the hierarchy. Column namesin ahierarchy are
prefaced with the name of the dimension table to which they belong; for
example, REGION.REGION.

7. To place acolumn at the next level in the hierarchy, double-click the column.

The column is displayed in the right box immediately below the previously
selected column. In the example shown in Figure 10-10, STATE was sel ected
for the next level.

Y our hierarchy should look similar to the one shown in Figure 10-10.

Edit Hierarchy [ %]
Mame:
IMarket
BT oo =l 5% Marke Filter... |
=5 REGION £-Ple. REGION REGION
B DIRECTOR P, MARKET STATE Trarsfom.. |
A _
B8 MARKET “iew Table Data... |
P, POPULATIONID
B REGIONID Yiew Sample... |
. P STATE
L B.: STATEID
=5 POPULATION
B, POPGROUP
-B: POPULATION
B, POPULATIONID
P; POPULATIONNAME
=5 MARKET
B, POPULATIONID Cancel |
-f.: REGIONID b
e STATE 4| Help |

Figure 10-10: Edit Hierarchy Dialog Box with Completed
Geography Hierarchy
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8. Toview or perform additional operations on a completed hierarchy, proceed
with any of the following options:

e Tocreate afilter or sort on the selected column, click Filter (see“About
Hierarchy Filters’ on page 10-13 or “ Sorting Datain Hierarchies” on
page 10-21).

e To transform the data in the selected column, click Transform (see
“Transforming Datain Hierarchies’ on page 10-22).

e Toview the hierarchy asit will appear in the Hyperion Essbase database,
click View Sample. For moreinformation, see“ Previewing the Hyperion
Essbase Outline” on page 10-27.

9. Click OK twiceto return to the OLAP Mode main window.

Editing and Deleting Hierarchies

You can delete or edit any existing hierarchy.

» To delete ahierarchy:

1. Double-click the dimension that contains the hierarchy; for example,
MARKET.

2. When the Dimension Propertiesdialog box opens, select the Hierar chies
tab.

Select the name of the hierarchy.
4. Click Deleteto delete the selected hierarchy.
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» To edit ahierarchy:
1. Complete steps 1 through 3 of the delete a hierarchy procedure.
2. IntheHierarchiestab of the Dimension Properties dialog box, click Edit.

Hyperion Integration Server Desktop displaysthe Edit Hierar chy dialog box,
as shown in Figure 10-11.

Edit Hierarchy [ %]
Mame:
IMa*et
E|Ej Market E% Market Fiter |
=5 REGION 2Pl REGION.REGION —
P, DIRECTOR “Plee MARKET STATE
B, REGION _ Do |
- P REGIONID :
[]---E‘E" MARKET Wiew Table Data... |
=& POPLLATION :
flee POPGROUR Yiew Sample... |
P, POPULATION
[, POPULATIONID
[l POPULATIONMAME

B MARKET
B

STAIE
Cancel |
Help |

AEC
----- Ba: STATEID

Figure 10-11: Edit Hierarchy Dialog Box
The hierarchy graphic in the right box contains the name of the hierarchy that
you are editing; for example, Market.

3. Todisplay thecolumns of adimension tablein theleft box, click the plussign,
[+, in front of the table to expand the view.

4. Toview thedatainacolumn, intheleft box, select the column and click View
Table Data.

Hyperion Integration Server Desktop displays the View Table Data dialog
box showing the first 100 rows of datain the selected column.

For more information, see “Viewing Table Data” on page 3-17.

Hyperion Integration Server Desktop OLAP Model User’s Guide B 10-11




Creating and Working with Hierarchies

5. To make changes to an existing hierarchy, proceed with any of the following
options:

To delete a column from the hierarchy, right click the column in the
hierarchy and select Delete.

To add acolumn or to move acolumn to somelevel abovethelowest level
in the hierarchy, delete the columns located above the level where you
want to add or move a column and then add the columns in the order that
you want them listed.

To create or edit afilter or sort on the selected column, click Filter (see
“ About Hierarchy Filters’ on page 10-13 or “ Sorting Datain Hierarchies’
on page 10-21).

To create or edit data transformations on the selected column, click
Transform (see “Transforming Datain Hierarchies’ on page 10-22).

To view the hierarchy asit will appear in the Hyperion Esshase database,
click View Sample. For moreinformation, see“ Previewing the Hyperion
Essbase Outline” on page 10-27.

6. Click OK to close the dialog box.

Filtering Data in Hierarchies

Thistopic describes how to createfilterson columnsin hierarchies. Y ou usefilters
to determinewhat datavalues arereturned. When transforming datavalues, OLAP
Integration Server performsfilters before it performs sorts and transformations.

This topic contains the following subtopics:

e “About Hierarchy Filters’ on page 10-13

e “About Recursive Table Filters’ on page 10-14

e “Creating Filtersin Hierarchies’ on page 10-15

10-12 1
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About Hierarchy Filters

Y ou can apply filtersto the columnsin a hierarchy to restrict the data values that
arereported. For example, you can create afilter for each regional officein the
United States so that regional managers can view sales totals only for their
respectiveregions. At headquarters, you can view salesfor each region and for the
total USA.

A filter contains the following components:

WMARKET.REGION = ('Central')

column being filtered operator  condition
Figure 10-12: Components of a Filter

In an OLAP model, you can define afilter only at the column level of ahierarchy.
Any filter that you define on a parent value applies to the children of that parent
value; for example, if you defineaREGION column filter that selects valuesfrom
the Central region, values from the cities (children) of the Central region are
automatically selected.

Thefilters that you define in an OLAP model are used to create related
metaoutlines and are then used to create related Hyperion Essbase outlines.

Inametaoutline, you can definefiltersfor member levelsin dimension hierarchies,
for member levels created from columns contained in an OLAP model, or for
measures contained in an OLAP model. For details, see the Hyperion Integration
Server Desktop OLAP Metaoutline User’s Guide.

Note: If you make changesto afilter in ahierarchy in an OLAP model, the
changes do not carry through to metaoutlines previously created from
that OLAP model.

Y ou can al so define the sequence in which you want to see information. To define
the sort order of a column, see “Sorting Datain Hierarchies’ on page 10-21.
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About Recursive Table Filters

Y ou can most easily define afilter for a column of arecursive table in the process
of defining a metaoutline. For more information, see the Hyperion Integration
Server Desktop OLAP Metaoutline User’s Guide.

However, one advantage of an OLAP model is the fact that you can select and
reuse its predefined dimensions and hierarchies in more than one metaoutline. If
you plan to use afilter in more than one metaoutline, you may want to consider
creating thefilter inan OLAP model. Remember that, to create afilter on acolumn
of arecursive tablein areusable OLAP model, you must first create a hierarchy.
Y ou can define filtersin an OLAP model only through hierarchies.

When you create a hierarchy from arecursive table, filter on only the parent
column or the child column. For more information on creating filters, see
“Filtering Datain Hierarchies” on page 10-12.

CAUTION: If you place both the parent and child columns of a
hierarchy into an OLAP model, you lose the recursive tie
between the rows of the table. Consequently, thetableisno
longer recursive.

To understand what to expect when you filter from arecursive table, consider the
following example based on data shown in Table 10-1.

Table 10-1: Filtering on Columns in a Recursive Table

Row Number GEO_CHILD GEO_PARENT
1 USA <NULL>

2 East USA

3 Maine East

4 Bangor Maine

5 01010 Bangor

6 New York East

7 Buffalo New York

8 30092 Buffalo
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When you filter on avalue in aparent column, OLAP Integration Server retrieves
only records that include the filter value as the parent. For example, on the
GEO_PARENT column, filtering for the value East retrieves the two rows that
include East as the parent, rows 3 and 6, which contain Maine and New York in
the GEO_CHILD column. No other rows are retrieved or reported on in the
Hyperion Essbase database.

When you filter on avalue in a child column, OLAP Integration Server retrieves
only records that include the filter value as the child. For example, on the
GEO_CHILD column, filtering for the value East retrieves only row 2, the row
that includes East in GEO_CHILD and USA in GEO_PARENT.

If you filter on the parent column, hide the child column as described in “Hiding
and Showing Columns’ on page 6-6. If you filter on the child column, hide the
parent column.

For more information about working with parent and child relationshipsin
recursive tables, see “ About Recursive Tables’ on page 10-4.

Creating Filters in Hierarchies

» To create afilter for acolumn in ahierarchy:
1. IntheDimension Properties dialog box, select the Hierar chies tab.
a. Select the hierarchy to filter and click Edit.
The Edit Hierarchy dialog box is displayed.

b. Intheright-hand box, click theplussign, 2, in front of ahierarchy name;
for example, Geography.

The columnsin the hierarchy are displayed, as shown in Figure 10-11.
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2. From the hierarchy, select the column to filter (for example,
PRODUCTDIM.SKU) and click Filter.

Hyperion Integration Server Desktop displays the Edit Filter dialog box, as
shown in Figure 10-13. Usethe dialog box to specify conditions and operators
for the selected conditions. A condition that you apply to afilter islikean SQL
WHERE clause.

If you enter a condition value directly into the Filter s text box, you must use
the syntax rules of the SQL for the relational database management system

(RDBMS) that you use.
Edit Filter - PRODUCTDIM.SKU E
Filters |Drdering|
Colurnm: Operator: Condition:
[ku =i = [

Add Type
b £ And veity |
é o Werify

Filters:

Freview Results... |

QK I Cancel | Help |

Figure 10-13: Edit Filter Dialog Box

The Column drop-down box displays the selected column. Notice that the
Add button is not selectable; you cannot add a filter until you have selected
the condition to use to create the filter, as described in steps 3 and 4.
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3. Click the browse button, ;|.

Hyperion Integration Server Desktop displays the Select Values dialog box,
as shown in Figure 10-14. The Select Values dialog box lists the values that
you can select.

Select ¥alues From PRODUCTDIM . SKU. [ %]

Walue | ik |

10010

100-20 Cancel
100-30 —I
20010 Help
200-20

200-30

200-40

30010

300-20

300-30

40010

400-20

400-30

Figure 10-14: Select Values Dialog Box
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4. Select one or more valuesto include in the filter; for example, 100-10 and

200-10.

The number of values (conditions) that you can select depends on the type
of operator that you want to apply. Y ou can select more than one value
(condition) when applying the in or not in operator. Y ou can select only
asingle value (condition) when applying any other operator. Available
operators are described in Table 10-2.

Table 10-2: Condition Filter Operators

Operator

Description

in

Use to select one or more values; for example, Region in

United States or Europe Selectsregionsin both the

United States and Europe.

not in

Use to eliminate one or more values (see in operator).

like

Selects values with similar characters. For example, to select
all products that begin with P without specifying all characters
in the name, set the condition Like “P%” (thewildcard
character may vary with the RDBMS).

Selects values without similar characters (see Like operator).

Equal to.

Not equal to.

Greater than.

Greater than or equal to.

Less than.

Less than or equal to.
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The values (conditions) that you selected are displayed in the Condition text
box of the Edit Filter dialog box.

The Add button of the Edit Filter dialog box is now selectable, as shown in

Figure 10-15.
Edit Filter - PRODUCTDIM.SKU E
Filters |Drdering|
Colurnm: Operator: Condition:
sku =] fin =] [riooiovzo0toy ]
Add Type———
fdd C Apd j |
£ & o Werify
Filters:
=
=
Freview Results... |
QK I Cancel | Help |

Figure 10-15: Defining Filters

6. From the Operator drop-down list, select an operator; for example, in or =

(equal to).

For a description of available Operator options, see Table 10-2.
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7. Click Add.

The condition and the operator that you selected are displayed in the Filters
list box, as shown in Figure 10-16.

Edit Filter - PRODUCTDIM.SKU E
Filters |Drdering|
Colurnm: Operator: Condition:
[ku =i = [
Add Type———
A £ And veity |
& o Werify
Filters:
PRODUCTDIM.SKU in (1001020010 ;I
Freview Results... |
QK I Cancel | Help |

Figure 10-16: Selected Values Displayed in Filters List Box
To add another condition to thefilter, in the Add Type box, click And or Or
to determine how the filters are combined, and repeat steps 3 through 7.

Y ou can group And and Or clauses by typing them directly into the Filters
text box. Be sure to use complete SQL WHERE clauses with the valid SQL
syntax for the RDBMS that you use.

To view the data that will be returned by the filter, click Preview Results.

For more information, see “Previewing the Hyperion Essbase Outline” on
page 10-27.

10. To apply thefilter to the column and return to the Edit Hierar chy dialog box,

click OK.
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Sorting Data in Hierarchies

Y ou can specify a sequence for sorting the values of any column. Y ou can select
ascending, descending, or none (no sort order). The default sort order is none. If
you select ascending or descending, datais retrieved faster than if you select none
for no sort order. If you make achange to asort in an OLAP model hierarchy, the
changes do not carry through to metaoutlines previously created from that OLAP
model.

Note: Whileretrieving data, OL AP Integration Server sorts columns after it
filters and before it performs transformations. For example, if the
MONTH column contains numeric values for the month (01, 02, 03,
and so on) and you specify atransformation that substitutes month
abbreviations, (Jan, Feb, Mar, and so on), OLAP Integration Server
sorts columns by their pre-transformation numeric values. April
totals are displayed after March totals because 04 sorts after 03.

» To define a sort order for column values:
1. Open the Hierarchiestab of the Dimension Properties dialog box.
a. Select ahierarchy and click Edit.
The Edit Hierarchy dialog box is displayed.

b. Toexpand theview, intheright box, click the plussign, &, in front of the
hierarchy (for example, Geography).

2. Todisplay the Edit Filter dialog box, select the column for which you want
to sort values, and then click Filter.

Select the Ordering tab.
4. Fromthe Sort Order drop-down list, select Ascending, Descending, or None.
Click OK threetimesto return to the OLAP Model main window.

To change the way data values are represented when reported by Hyperion
Essbase, see “Replacing Data’ on page 10-22.
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Transforming Data in Hierarchies

After you create adimension hierarchy, you can change the way the data val ues of
the hierarchy are represented when reported by Hyperion Essbase. For example,

perhaps the date values of the OLAP model hierarchy are numeric and you want
the corresponding Hyperion Essbase members to be al phabetic.

A transformation that you define on a hierarchy in an OLAP model is used

to create first a metaoutline and then a Hyperion Essbase outline. If you change
atransformation in an OLAP model, the change does not carry through to
metaoutlines previously created from the OLAP model. OLAP | ntegration Server
performsfilters and sorts before transformations.

For more information about transforming datain hierarchies, see:
e “Replacing Data” on page 10-22
e “Prefixing and Suffixing Column Values’ on page 10-25

Replacing Data
Y ou can change column data by replacing current values with new values,
changing capitalization, and removing leading and trailing spaces.
» To transform data values in a hierarchy:

1. Double-click the dimension that contains the hierarchy with which you want
to work.

2. Todisplay the Edit Hierarchy dialog box, select the Hier ar chies tab, then
select the appropriate hierarchy, and click Edit.
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3. IntheEdit Hierarchy dialog box, select from the hierarchy the column for
which you want to transform data values (for example, MARKET), and click
Transform.

Hyperion Integration Server Desktop displays the Replace tab of the Edit
Transformations dialog box, as shown in Figure 10-17.

Edit Transformations - MARKET STATE [ %]
Feplace | Prefix.-"SuffigI
Search for —LCase
[5TATEID & Driginal
_ " Upper Case
Fieplace with @ v Cese
IState D " Capitalize First Letters
™ Case Sensitive [C) — Space:
™ Match whale \wWard [ V' Drop Leading/Trailing Spaces
¥ Eeplace &l Dccurences (&) V' Corwert Spaces to Underscores
Addto List EdiDeial | Deee |
Search | Feplace | Conditions
Freview Hesults...l QK I Cancel | Help |

Figure 10-17: Replace Tab of the Edit Transformations Dialog Box
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4. To replace text, change the capitalization of the text, or to replace spaces,
follow the stepsin Table 10-3, and click OK.

Table 10-3: Editing Text in Hierarchy Data

Replacement | Actions

Text 1. Inthe Search for text box, enter the original value and, in the Replacewith
text box, enter the text to replace the value.

Specify the conditions for making the replacement by checking one or
more of the following options:
Case Sensitive (C). Replaces only text strings that match the capitalization
of the string in the Replace text box.
Match Whole Word (W). Replaces the text string only when it occurs asa
whole word. For example, when replacing the 10 inthe string 100 10 1
with an a, if you set the Match Whole Word option, the string changes to
100A 1.
Replace All Occurrences (A). Replaces every occurrence of the text
string. For example, if you replace all occurrences of 10 in the string
100 10 1 with an a, the string changesto 20 A 1.

2. Click Add to List to add the transformation to the value specified. The
entries move to the Replace box.

Case To change the case of the data value, select one of the following options:
» Original. Does not change the case. This setting is the default.

» Upper Case. Changes the value to uppercase; for example, january or
January to JANUARY.

* Lower Case. Changesthe value to lowercase; for example, JANUARY or
January to january.

» CapitalizeFirst Letters. Changesthefirst letter of the value and the first
letter following a space or an underscore to uppercase; for example,
gtrl_january changesto Qtrl January.

Spaces » Toomit spaceshefore or after the datavalue, select Drop Leading/Trailing
Spaces.

» To convert spacesthat exist in the original data value to underscores( _),
select Convert Spacesto Under scores.
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5. Toview thedataasit will appear in the Hyperion Essbase outline, click
Preview Results.

For more information, see “Previewing the Hyperion Essbase Outline” on
page 10-27.

6. Click OK threetimesto return to the OLAP Model main window.

Prefixing and Suffixing Column Values

Y ou can use aprefix or suffix to generate unique member names from the columns
of ahierarchy. Hyperion Essbase requires unique member names to report data
values accurately. For example, if you use the same month names for multiple
years, you can add ayear suffix to the month column names of each hierarchy to
ensure that Hyperion Essbase reports the correct value for each month of each
year.

Note: The default setting for columnsin atime hierarchy is parent name.

» To define prefixes or suffixes for data valuesin a hierarchy:

1. Double-click the dimension that contains the hierarchy with which you want
to work.

2. Todisplay the Edit Hierarchy dialog box, select the Hier ar chies tab, then
select the appropriate hierarchy, and click Edit.

3. IntheEdit Hierarchy dialog box, select the hierarchy column that you want
to transform (for example, MARKET.CITY), and click Transform.

The Edit Transformations dialog box is displayed.
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4. Select the Prefix/Suffix tab.

Hyperion Integration Server Desktop displaysthe Pr efix/Suffix tab, as shown

in Figure 10-18.

Edit OLAP Model Transformations - REGION E

Feplace Prefis/Suffiz |

E é.r;tName

" Grandparent Name
= Al Ancestors' Names
= Dimenszion MNarme

Frefis Separator—————————————

= Underscore [ _ ]
" Pipe[l]

= Caret[ "]

* Mo separator

Custom Prefix F'rewew Prefix
I member
— Suffi Suffis Separator—————————————
i+ Mone [w] = Underscare [ _ ]
= Parent Mame [Y] = Pipe[l]
" Grandparent Name [£] = Caret[ "]
= Al Ancestors' Names * Mo separator
= Dimenszion Marme

Custom Suffis [¥] Preview Suffiz
I member
Freview Hesults...l QK I Cancel | Help |

Figure 10-18: Prefix/Suffix Tab

listed in Table 10-4.

To add a prefix or suffix to adatavalue, select the value to prefix or suffix, as

Table 10-4: Prefix and Suffix Values

Prefix/Suffix

Definition

None Uses the column value as the full name. Nothing is
attached.
Parent Name Attaches the immediate parent; for example,

Florida Miami.

Grandparent Name

Attaches the parent and the parent of the parent; for
example, Central_Florida Miami.

All Ancestors Names

Attaches all parents;, for example,
Market Central_Florida_ Miami.
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Table 10-4: Prefix and Suffix Values (Continued)

Prefix/Suffix Definition

Dimension Name Attaches the dimension name; for example,
Market Miami.

Custom Prefix Attaches your own prefix or suffix. Type the prefix or

Custom Suffix suffix in the text box; for example, SKU_.

6. Toinsert acharacter between the prefix or suffix and the member value, inthe
Prefix Separator or Suffix Separator box, select the character to insert.

For example, to prefix the valuefor Y ear to the quarter members and insert an
underscore between the prefix and the quarter member, select Parent Name
and Under scor e. This procedure creates member names like 2000_Quarter4.

7. Toview thedataasit will appear in the Hyperion Essbase outline, click
Preview Results.

For more information, see “Previewing the Hyperion Essbase Outline” on
page 10-27.

8. Click OK threetimesto return to the main window.

Previewing the Hyperion Essbase Outline

Y ou can preview the Hyperion Essbase outline that will be created from a
hierarchy. The preview includes the results of filtering and transformation
operations. For example, you can create afilter and then view the column values
that will be returned by the filter.

» To preview the Hyperion Essbase outline:
1. Choose one of the following options:

e If you arecreating afilter in the Edit Filter dialog box, click Preview
Results.

e If you are creating atransformation in the Edit OL AP M odel
Transformation dialog box, click Preview Results.

e If you are creating a hierarchy in the Edit Hierarchy dialog box, click
View Sample.
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Hyperion Integration Server Desktop displays a dialog box similar to the one

in Figure 10-19. You can click the plus sign, [, in front of each member to
expand and view the full member hierarchy within the sample outline.

Preview Transformation Results [ %]
- Markst
[=)- Central Help |

Sarple Build SOL:

SELECT aREGION. aSTATE, aCITY ;I
FROM TEC.LODOKUP_MARKET a

-]

Figure 10-19: Viewing a Sample Hyperion Essbase Outline

Thetop list box displays the members that will show up in the Hyperion
Essbase outline. The SampleBuild SQL list box displaysthe SQL that OLAP
Integration Server uses to retrieve the members from the data source.

2. When you finish viewing the members and the SQL, click Close.

10-28 W Hyperion Integration Server Desktop OLAP Model User’s Guide



SLEIEESS Creating a Sample
OLAP Model Containing
Attribute-Enabled Columns

This appendix provides procedures for creating an OLAP model containing
attribute-enabled columns. The sample login information, sample screens, OLAP
model name, metaoutline name, and relational data source are al based on the
Hyperion Integration Server sample application.

The Hyperion Integration Server sample application is based on afictitious
company named The Beverage Company (TBC). To review the benefitsthat TBC
gains from using Hyperion Integration Server, see “ The Benefits of OLAP to
TBC” on page A-2.

For information about installing the sample application, see the Hyperion
Integration Server Installation Guide. For information on creating a metaoutline
containing attribute dimensions, see the Hyperion Integration Server Desktop
OLAP Metaoutline User’s Guide.

Refer to the following topics in this appendix for information about creating a
sample OLAP model containing attribute-enabled columns:

e “Sample TBC Model Dimensions” on page A-3
e “Starting Up and Logging On” on page A-5

e “Opening the Standard User Interface to Create aNew OLAP Model” on
page A-6

e “Working inthe OLAP Model Main Window” on page A-8

To create the sample OLAP maodel described in the following procedures, you

must have the sample application installed. If you do not have the sample

application installed, you can use these procedures as a guide for creating an
OLAP model with your own relational data source and OLAP Metadata Catal og.
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The Benefits of OLAP to TBC

A-2 B

The Hyperion Integration Server sample application is based on afictitious
company named The Beverage Company (TBC) and contains the following
components:

e A relational data source (TBC)

e AnOLAP Metadata Catalog (TBC_MD)
e A sample OLAP model (TBC Model)

e A sample metaoutline (TBC Metaoutline)

TBC usesonlineanalytical processing (OLAP) technology to better understand its
business operations. A multidimensional database supports multiple views of data
sets for users who need to analyze rel ationships between data categories. For
example, a marketing analyst at TBC might want answers to the following
guestions:

e How did caffeinated beverages sell in August? How does this figure compare
to salesin August over the previous five years?

e How do the sales of non-caffeinated beveragesin Quarter 1 compare with the
sales of diet drinksin Quarter 1?

e Did diet drinks sdll better in one region compared to another region? Have
salesincreased in a particular region during the last two years?

e Wereany type of beverages returned by customersin large quantities? Where
were these unsuccessful beverages bottled?

e Did commissions and pricing affect how salespeople sold the products? Did
pricing have agreater impact in New York?

e Didthe salespeople east of the Mississippi do a better job of selling large
bottles of non-diet drinks than did the salespeople west of the Mississippi?

TBC uses multidimensional databases to consolidate and calculate datato provide
different views, drill down through data to find out more detailed information, or
drill up to see asummary overview of data. The dimensions used by TBC are
discussed in “Sample TBC Model Dimensions’ on page A-3.
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Creating a Sample OLAP Model Containing Attribute-Enabled Columns

The TBC sample OLAP model contains both standard dimensions and
attribute-enabled columns that can be used to create attribute dimensionsin the
subsequent metaoutline. The procedures and screen examplesin this appendix
illustrate how to create an OLAP model that contains the standard and base
dimensions defined in Table A-1. Table A-2 describes the attribute-enabled
columns that the OLAP model contains.

Table A-1: Sample TBC OLAP Model Standard Dimensions

Dimension

Description

Year

A hierarchy based on the transformation of a date/time stamp
column in the fact table. This hierarchy contains Quarters and
Months.

Measures

A hierarchy containing members from the fact table and containing
derived (user-defined) members such as Profit, Margin, and Total
Expenses.

Product

A hierarchy based on the FAMILY and SKU (Stock Keeping Unit)
columns in the PRODUCTDIM table. PRODUCTDIM isan
additional table added to the star schemato facilitate the building of
a Hyperion Essbase dimension containing alternative hierarchies
(repeated SKU). Repeated SKU is abusiness analysis requirement.
Product is the base dimension for the Caffeinated, Ounces, Pkgtype,
and Introdate attribute dimensions.

Market

A hierarchy based on the REGION and STATE where products are
sold. Thisisthe base dimension for the Population attribute.

Scenario

A hierarchy based on the SCENARIO fact column, containing any
combination of Actual, Budget, Forecast, and Plan. This dimension
also contains derived (user-defined) members for variances and
percentage variances.

Supplier

A hierarchy based on the SUPPLIER fact column, containing

Supplier, Address, and City.
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Table A-2: Sample TBC OLAP Model Attribute-Enabled Columns

Attribute-
Enabled
Columns Description

Caffeinated | This attribute describes a product SKU as caffeinated; it isaBoolean
attribute associated with level 0 Product members or SKU level
products.

Ounces This attribute describes the container size of the product; it isa
numeric attribute associated with level O Product members or SKU
level products.

Pkatype This attribute describes the type of container in which the product is
sold; it isatext attribute associated with level 0 Product members or
SKU level products.

Population | This attribute describes the population range of a state; itisa
numeric attribute associated with level 0 Market members or a
STATE metaoutline member.

Population | This attribute (POPGROUP) describes the relative population of a
city: small, medium, or large; it is a Boolean attribute associated
with level 0 Market members or a STATE metaoutline member.

Introdate This attribute describes the product introduction date; it is a date
attribute associated with level 0 product members or SKU level
products.
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Starting Up and Logging On

To beginthe OLAP model creation process, you must first start OLAP Integration
Server, and then start and log on to Hyperion Integration Server Desktop. For
details on starting up and logging on, see “ Starting Hyperion Integration Server
Desktop” on page 3-3.

After you have logged on, Hyperion Integration Server Desktop displays the
Welcome dialog box, as shown in Figure A-1.

k}\ Hyperion® Integration Server

— "

Mew |Existing| Hecentl

Select the object to create or select an Assistant to guide you through the object creation process. Then click Dpen.

&

OLAP Metaoutline OLAP todel OLAP Metaoutline
Azsistant Azsistant

Open I Owerview... | Cancel | Help |

Figure A-1: Hyperion Integration Server Desktop Welcome Dialog Box
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Opening the Standard User Interface to
Create a New OLAP Model

To createanew OLAP model containing attribute-enabled columns, you must use
the standard user interface, rather than the OLAP Model Assistant.
» To open the OLAP Model standard user interface:
1. Inthe Welcome dialog box, select the New tab.
2. Select the OLAP Model icon and click Open.

The Data Sour ce dialog box opens, as shown in Figure A-2.

Data Source x|
Select or enter the name of the database that contains the
source data.
Data Source
|TEC =l
Uszer Mame
[tbe |
Passward
QK | Cancel | Help |

Figure A-2: Data Source Dialog Box

3. Fromthe Data Sour ce drop-down list, select the relational data sourceto use
for creating the OLAP model (TBC for the sample application).

4. From the User Name drop-down list, select the user name for creating the
OLAP model (tbc for the sample application).
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5. Inthe Password text box, type your password (password for the sample
application, all lowercase |etters) and click OK.

Hyperion Integration Server Desktop displays the OLAP Model main
window, as shown in Figure A-3.

* . Hyperion Integration Server Desktop - [OLAP Modell] M =]k
H File Edit “iew Connections Toolz ‘Window Help _|ﬁ||1|
DEH (&= |22
=-E TBC.FAMILY -
TEC.MARKET
TEC.POPULATION
TEC.PRODUCT
TEC.PRODUCTDIM
TEC.REGION
TBC.S4LESFACT
-3 TBC.SCENARIO
=-EJ TBC.SUPFLIER
K — _>l_I
|Data Source: the
Faor Help, press F1 |DLAF' Catalog: TEC_MD i

Figure A-3: OLAP Model Main Window

The OLAP Model main window consists of two frames. The left frame contains
information about the relational data source, and the right frame, which is blank,
isthe areawhere you create the OLAP model.
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Working in the OLAP Model Main Window

This topic contains the following subtopics that describe how to create a sample
OLAP mode containing attribute-enabled columns:

e “Creating the Fact Table” on page A-8

e “Creating the Product, Family, and Productdim Tables” on page A-10
e “Creating Additional Dimension Tables” on page A-17

e “Adding Hierarchiesto the OLAP Model” on page A-20

e “Setting Columnsto Attribute-Enabled” on page A-32

e “Saving the OLAP Model” on page A-35

Creating the Fact Table

» To createthe fact table:

1. Drag thefact table to the right frame and rel ease the mouse button. In this
example, SALESFACT isthe fact table.

2. The system displays the following prompts:
a. “Would you like a Time dimension using avalue from the fact table?’ In
this exercise, the answer is Yes.

Note: Usually in afact table that contains a DATETIME field
related to the metrics being measured, the answer is Yes.

b. “Would you like to add an Accounts dimension?’ In this exercise, the
answer isYes.

In some cases, either or both of the Time and Accounts dimensions are
separate from the fact table. Thisis especialy truein the financial sector,
where an accounts dimension may include thousands of members. The
four possible combinations for the Time and Accounts dimensions are:

e Time, yes; Accounts, yes.
e Time, yes; Accounts, no.
e Time, no; Accounts, yes.

e Time, no; Accounts, no.
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3. After you have dragged the SALESFACT table to the right frame and have
answered both the Time and Accounts questions, the OLAP Model main
window looks like the one shown in Figure A-4.

* . Hyperion Integration Server Desktop - [OLAP Modell] M =]k
H File Edit “iew Connections Toolz ‘Window Help _|ﬁ||1|
DEH(& = |22

E] TBLFAMILY -
TBCMARKET
TBC.POPULATION
TBC.PRODUCT
TBC.PRODUCTDIM
TBCREGION

; TBC.SALESFACT ) |
-3 TBC.SCENARIO

#-F3 TEC.SUPPLIER ;

1§ SALESFACT !

8 Accounts |

-
1 | »

|Data Source: the
Faor Help, press F1 |DLAF' Catalog: TEC_MD i

Figure A-4: Sample OLAP Model with SALESFACT Table, Time Dimension,
and Accounts Dimension

The dotted line between the Time dimension and the SALESFACT table
indicates that column join information isincomplete.
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4. Tocompletethecolumnjoin betweenthetwotables, right-click thedotted join
line and select Properties from the pop-up menu.

Hyperion Integration Server Desktop displays the Edit Join I nfo dialog box,
as shown in Figure A-5.

Edit Join Info for SALESFACT and Time E

SALESFACT Time

OPEMINGINVENTORY - OPEMINGINVENTORY - Cloze
PavYROLL _I PavYROLL _I —I
PRODUCTID PRODUCTID

SALES SALES

SCENARIOID SCENARIOID

STATEID STATEID

SUPPLIERID SUPPLIERID

TRAMSDATE - TRAMSDATE -

4 I I 3 4 I I 3

Current Jain Infarmation:

Colurnm 1 | Colurmn 2 |

SALESFACT. TRANSDATE Time. TRANSDATE |

Welete,.

Help |

Figure A-5: Edit Join Info Dialog Box for the Time Table

5. IntheEdit Join Info dialog box, select a column pair to create avalid join
between the two tables.

Y ou can select multiple pairs for ajoin. In this example, the tables are joined
by the TRANSDATE column.

6. Click Add and then click Close.

Creating the Product, Family, and Productdim Tables

In addition to the fact table, other tables required to create dimensions must be
dragged to the right frame to create the OLAP model. The first group of these
tables are PRODUCT, FAMILY, and PRODUCTDIM.
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The Product Table

» To createthe PRODUCT table;

1. Inthe OLAP Model main window, drag the PRODUCT table to the right
frame and rel ease the mouse button.

Depending on the type of relationship existing between the dragged table
(here, the PRODUCT table) and the fact table, one of the following scenarios
occurs:

e If aprimary or foreign key relationship exists between the dragged table
and the fact table, Hyperion Integration Server Desktop displays the
Create New Dimension dialog box, as shown in Figure A-6. Click OK
to automatically create the join.

Note: Inthisexample, aprimary or foreign key relationship exists
between the PRODUCT table and the SALESFACT table.

Create Hew Dimension x|
M ame: ok |
IPHDDUET

Cancel |
Dimenzion Type:
IDefauIt j Help |

Current Dimensions:

Accounts
Time

Figure A-6: Create New Dimension Dialog Box

e If norelationship existsin the relational database management system
(RDBMS) between the dragged table and the fact tabl e, the dialog box to
create anew dimension isnot automatically displayed and the tables must
be joined manually. See “ Joining Tables Manually” on page A-13.
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The OLAP model now looks like the one shown in Figure A-7.

* . Hyperion Integration Server Desktop M=l E3

H File Edit “iew Connections Toolz ‘Window Help

==l x|

DEE|(&|w s | & &%

TBC.FAMILY
TBC.MARKET
TBC.POPULATION
TBC.PRODUCT
TBC.PRODUCTDIM
TBC.REGION
TBC.SALESFACT
TBC.SCENARIO
TBC.SUPPLIER

1 e o

Faor Help, press F1

i PRODUCT |

O Time

1§ SALESFACT

| |

8 Accounts

|Data Source: TBC
|OLAP Catalog: TEC_MD i

Figure A-7: Sample OLAP Model with PRODUCT Table Joined to the

SALESFACT Table

A-12 H

Hyperion Integration Server Desktop OLAP Model User’s Guide




Creating a Sample OLAP Model Containing Attribute-Enabled Columns

Joining Tables Manually

» Tojoin tables manually:

1. Onthe OLAP Model toolbar, click the Join button, which changes the pointer
behavior from drag to join selection. See Figure A-8.

* . Hyperion Integration Server Desktop - [OLAP Modell]

H File Edit “iew Connections Toolz ‘Window Help

DEE|(&|w s | & &%

Figure A-8: OLAP Model Toolbar

The Join button is on the right of the toolbar and looks like this:

a

Figure A-9: Join Button

2. Placethe pointer over the table you want to join to another table.
The pointer changes to a hand symbol.
3. Usetheleft mouse button to drag the hand symbol to the table you want to
join.
A dotted line trails the hand symbol.
4. Releasethe left mouse button.
Hyperion Integration Server Desktop displays the Edit Join I nfo dialog box.

5. IntheEdit Join Info dialog box, select a column pair to create avalid join
between the two tables.

You can select multiple pairsfor ajoin.

Note: When double-clicking acolumn namein either tablelist box, the
identical column name in the other list box is automatically
selected. If both column namesto bejoined arenot identical, they
must be selected individually.

6. Click Add to add thejoin condition to the Current Join I nfor mation section.

7. Click Close to accept the join.
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The Family Table

» To createthe FAMILY table;

1.

Inthe OLAP Model main window, drag the FAMILY table to the right frame.

Because no join exists between this table and the fact table, the join is not
created automatically. See “Joining Tables Manually” on page A-13.

Note: FAMILY isjoined to SALESFACT through the PRODUCT
table. Accordingly, as you follow the instructions in “ Joining
Tables Manually” on page A-13, join the FAMILY table to the
PRODUCT table.

In this example, Hyperion Integration Server Desktop displaysthe Edit Join
Info dialog box, as shown in Figure A-10.

Edit Join Info for FAMILY and PRODUCT ]
FamILY PRODUCT
FamILY CAFFEINATED Close
FAMILYID FAMILYID —l
FaILYMNAME INTRODATE i
INTRODATE OUNCES =
PKGTYPE
PRODUCTID
SkU
SKUMAME
Current Jain Infarmation:
Calurmn 1 | Column 2 |
FAMILY.FAMILYID PRODUCT FAMILYID |
Welete,.
N

Figure A-10: Edit Join Info Dialog Box for the FAMILY and PRODUCT Tables

Because a primary or foreign key exists between the FAMILY and the
PRODUCT tables, the join from FAMILY.FAMILYID to
PRODUCT.FAMILYID is suggested as the join condition between the two
tables. If no primary or foreign key existed between the tables, the join
condition would have to be selected manually.
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2. Click Close to accept thisjoin.

The OLAP model now looks like the one shown in Figure A-11.

* . Hyperion Integration Server Desktop - [OLAP Modell] M=l E3

H File Edit “iew Connections Toolz ‘Window Help _|ﬁ||1|

DEE|(&|w s | & &%

&-E3 TECFAMILY -
: TEC.MARKET

TEC.POPULATION —

TBC PRODUCT
TEC.PRODUCTDIM
TEC.REGION
TEC.SALESFACT
TEC.SCENARID

@[ TBC.SUPPLIER = PRODUCT |

O Time

1 SALESFACT

| |

8 Accounts

K — _>l_I
|Data Source: TBC
Faor Help, press F1 |DLAF' Catalog: TEC_MD i

Figure A-11: Sample OLAP Model with Family Table Joined to PRODUCT Table
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The Productdim Table

» To create the PRODUCTDIM table:

1.

Inthe OLAP Model main window, drag the PRODUCTDIM tableto theright
frame.

Because no join exists between this table and the fact table, the join is not
created automatically. See “ Joining Tables Manually” on page A-13.

Note: PRODUCTDIM isjoined to SALESFACT through the
PRODUCT table. Accordingly, asyou follow theinstructionsin
“Joining Tables Manually” on page A-13, join the
PRODUCTDIM tableto the same PRODUCT tableto whichyou
joined the FAMILY table.

Hyperion Integration Server Desktop displays the Edit Join I nfo dialog box,
asshown in Figure A-12.

Edit Join Info for PRODUCTDIM and PRODUCT E
PRODUCTDIM PRODUCT
FamILY CAFFEINATED Close
FAMILYATTR FAMILYID —I
FaILYMNAME INTRODATE
SkU OUNCES
SKUMAME PKGTYPE
PRODUCTID
SkU
SKUMAME
Current Jain Infarmation:
Colurnm 1 | Colurmn 2 |
PRODUCTDIM.SEU PRODUCT.SKU |
Welete,.

Help |

Figure A-12: Edit Join Info Dialog Box for the PRODUCTDIM and
PRODUCT Tables

Because no primary or foreign key exists between the two tables, no join

informationissupplied. Use SKU tojointhe PRODUCTDIM and PRODUCT
tables.
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2. Click Close to accept thisjoin.
The OLAP model now looks like the one shown in Figure A-13.

* . Hyperion Integration Server Desktop - [OLAP Modell] M= 3
H File Edit “iew Connections Toolz ‘Window Help _|ﬁ||1|
Ded&= & 2e
TBC.FAMILY -
TEC.MARKET
T pmoone i
TEC.PRODUCT =2 PRODUCT oA (FIRIOIDIIET
TEC.PRODUCTDIM
TEC.REGION

TBC.SALESFACT
TBC.SCENARIO

TEC.SUPPLIER = PRODUCT |

O Time

1 SALESFACT

| |

8 Accounts

|Data Source: TBC
Faor Help, press F1 |DLAF' Catalog: TEC_MD i

Figure A-13: Sample OLAP Model with PRODUCTDIM Table Joined to
PRODUCT Table

Creating Additional Dimension Tables

To complete the OLAP model, you must drag additional relationa tablesto the
right frameto create the necessary dimension tables. Use the same procedures that
you used to drag the PRODUCT, FAMILY, and PRODUCTDIM tables to the
right frame. See “ Creating the Product, Family, and Productdim Tables’ on
page A-10.

Hyperion Integration Server Desktop OLAP Model User’s Guide H A-17



Creating a Sample OLAP Model Containing Attribute-Enabled Columns

A-18 H

> To create the required additional dimension tables:

1.

Inthe OLAP Modé mainwindow, drag the MARKET tableto theright frame.

In this example, because aprimary or foreign key relationship to the
SALESFACT table exists, Hyperion Integration Server Desktop displays the
Create New Dimension dialog box.

Click OK to automatically create the join.
In the OLAP Modéd main window, drag the REGION table to the right frame.

Because REGION isjoined to SALESFACT through the MARKET table,
drag the REGION table to the MARKET table.

Hyperion Integration Server Desktop displays the Edit Join I nfo dialog box.

Inthisexample, becauseaprimary or foreign key exists between the REGION
and the MARKET tables, the join from REGION.REGIONID to
MARKET.REGIONID is suggested as the join condition between the two
tables.

Click Close to accept thisjoin.

In the OLAP Model main window, drag the POPULATION table to the right
frame.

Because POPULATION isjoined to SALESFACT through the MARKET
table, drag the POPULATION table to the same MARKET tableto which you
joined the REGION table.

Hyperion Integration Server Desktop displays the Edit Join I nfo dialog box.

Because a primary or foreign key exists between the POPULATION and the
MARKET tables, the join from POPULATION.POPULATIONID to
MARKET.POPULATIONID is suggested as the join condition between the
two tables.

Click Close to accept thisjoin.

In the OLAP Model main window, drag the SCENARIO table to the right
frame.

In this example, because a primary or foreign key relationship to the
SALESFACT table exists, Hyperion Integration Server Desktop displays the
Create New Dimension dialog box.

10. Click OK to automatically create the join.
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11. Inthe OLAP Model main window, drag the SUPPLIER table to the right
frame.

In this example, because aprimary or foreign key relationship to the
SALESFACT table exists, Hyperion Integration Server Desktop displays the
Create New Dimension dialog box.

12. Click OK to automatically create the join.

Note: In thisexercise, the SUPPLIER tableis not used to create a
dimension. SUPPLIER is used only for drill-through purposes,
using the Hyperion Esshase Spreadsheet Add-in. See “Defining
Drill-Through Columns’ on page 6-12.

When all tables have been dragged to the right frame, the OLAP model looks
like the one shown in Figure A-14.

* . Hyperion Integration Server Desktop - [OLAP Modell] M =]k
H File Edit “iew Connections Toolz ‘Window Help _|ﬁ||1|
Ded&= & 2e

-3 TEBC.FAMILY -

B TecheReT
- TBC.POPULATION
-E§ TBC.PRODUCT

TBC.PRODUCTDIM

£l

‘B TEC.REGION = Product
TBC.SALESFACT
-Ed TBC.SCENARID
-] TEC.SUPPLIER .
@i |

1§ SALESFACT

= Supplier @8 Accounts |

[ vaet [T Market___]

K _>l_I
|Data Source: the
Faor Help, press F1 |DLAF' Catalog: TEC_MD i

Figure A-14: Dimension Tables in Completed Sample OLAP Model
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Adding Hierarchies to the OLAP Model

A-20

After the dimension tables have been created, the hierarchies for the Hyperion
Essbase standard and base dimensions can be created. These include hierarchies
for the Market, Product, and Time dimensions.

Note: Attribute dimension hierarchies are created later when you build the
metaoutline.

Thistopic containsthe following subtopicsthat describe how to create hierarchies:
e “Creating the Market Hierarchy” on page A-20

e “Creating the Product Hierarchy” on page A-22

e “Creating the Time Y ear Hierarchy” on page A-23

Creating the Market Hierarchy

» To create the Market hierarchy:

1. Inthe OLAP Model mainwindow, right-click any Market dimension tableand
select Properties from the pop-up menu.
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2. Select theHierarchiestab and click Add.

Hyperion Integration Server Desktop displaysthe Edit Hierar chy dialog box,
as shown in Figure A-15.

Edit Hierarchy x|
Mame:
IMa*et
El-E# Market 5% Market i
=5 REGION -8, REGION REGION [ e |
- B DIRECTOR - Biee MARKET STATE
Bec REGION Tiranstori.. |
P, REGIONID _
B MARKET e Tabilebata.. |
fe; POPULATIONID _
Em REGIOMNID iew S anmple. |
Phee STATE
----- B.: STATEID

-Ef POPULATION

oK |
Cancel |
Help |

Figure A-15: Edit Hierarchy Dialog Box for Market Hierarchy

3. Inthe Name text box of the Edit Hierar chy dialog box, type Market to
change the name from “Hierarchy1” to “Market.”

4. Click the plus (+) symbol in front of the REGION table to expand the view.
Click the plus (+) symbol in front of the MARKET table to expand the view.

Under the REGION table, double-click the REGION column and then under
the MARKET table, double-click the STATE column.

Note: You can achieve the same result by dragging the columns from
the left side to the right side.

7. Click OK, then click OK again.
Note: Inthisexample, al dimensionsare built by generation. However,

Hyperion Integration Server Desktop can also build dimensions
recursively (that is, by parent/child).
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Creating the Product Hierarchy

» To create the Product hierarchy:

1. Inthe OLAP Model main window, right-click any Product dimension table
and select Properties from the pop-up menu.

2. Select theHierarchiestab and click Add.

Hyperion Integration Server Desktop displaysthe Edit Hierar chy dialog box,
as shown in Figure A-16.

Edit Hierarchy [ ]
Mame:
IProduct
=B PRODUCT =%, Product Fiter |
555 FAMILY -l PRODUCTDIM.FAMILY —
R FaMILY B PRODUCTDIM.SKU —
ey FAMILYID I |
o P FAMILYNAME -
[ HG) INTRODATE Wiew Table Data... |
- E-Ej PRODUCT :
E-E# PRODUCTDIM Yiew Sample... |
- Plge FAMILY

- Phge FAMILYATTR
Pl FAMILYMAME
o

Biee SKUMAME
-E§ PRODUCT

Cancel |
Help |

Figure A-16: Edit Hierarchy Dialog Box for Product Hierarchy
3. Inthe Name text box of the Edit Hierarchy dialog box, select Hierarchyl,
press Back space, and type Product to change the name.

4. Click the plus (+) symbol in front of the PRODUCTDIM table to expand the
view.

5. Under the PRODUCTDIM table, double-click the FAMILY column and then
double-click the SKU column.
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6. Click OK, thenclick OK again.

In thisexample, the PRODUCTDIM tableillustratesthat, at times, atable can
be created separately from the star schema and still be used in the creation of
ahierarchy. Specifically, the FAMILYATTR column is used later in the
metaoutline to create the consolidation attribute.

Also, in this example, duplicate SKUs are in the PRODUCTDIM table. By
creating a separate table, you can create an alternate hierarchy called Diet.

Creating the Time Year Hierarchy

» To create the Time Year hierarchy:

1. Inthe OLAP Model main window, right-click the Time dimension table and
click View Columns.

Hyperion Integration Server Desktop expands the Time table and displaysthe
columns that make up the Time dimension, as shown in Figure A-17.

Time =]
Ba: ADDITIONS J
P, COGS
P MARKETING
P MISC
P OPENINGINVENTOR |

Figure A-17: Time Dimension Columns
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2. Inthe Time dimension box, right-click the Time table and select Properties
from the pop-up menu.

Hyperion Integration Server Desktop displays the Table Properties dialog
box, as shown in Figure A-18.

Table Properties [ %]

General Columns | PhysicalJoinsI

| Table Mame | Column Marme | H| D| Al

TBC.SALESF..  ADDITIONS Edit... |

TBCSALESF.. COGS
Pe: MARKETING  TBC.SALESF.. MARKETING Add...
B MISC TBCSALESF..  MISC

P OPENINGIN.. TEC.SALESF.. OPEMINGIN... Delete. . |

B PAYROLL TBCSALESF.. PAYROLL

P PRODUCTID  TEC.SALESF.. PRODUCTID D ate-Hierarchy |

P SALES TBCSALESF.. SALES

Bi: SCENARIOID  TECSALESF.. SCENARIOID Hide |

B STATEID TBCSALESF.. STATEID

Pe: SUPFLIERID  TBC.SALESF..  SUPFLIERID Diill-Through |
AolGIEYSIEE ToC SALESF.. TRANSDATE
Attribute |

QK I Cancel | Help |

Figure A-18: Table Properties Dialog Box

In the Table Properties dialog box, select the Columnstab.

4. Because both of the new columns are based on a transformation of the
TRANSDATE column, select TRANSDATE and then click Add.

Hyperion Integration Server Desktop displays the Add New Column to
Table dialog box, as shown in Figure A-19.

Add New Column to Table ‘Time* %]
I ame: -
IQuarter |
Physical T able: Cancel |

| TBC.5ALESFACT =l Help |
Physical Column:

| TRaNSDATE |

Type:

IDateTime

Figure A-19: Add New Column to Table Dialog Box
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5. Inthe Name text box of the Add New Column to Table dialog box, type
Quarter and click OK.

Hyperion Integration Server Desktop displays the Column Propertiesdialog
box, as shown in Figure A-20.

Column Properties x|
General Transformation Rule |

[™ Pass-through [Database Specific)

Category: Function:
<Maone:
‘ears

Manths
wheeks

Single digit quarker

QK Cancel Help

Figure A-20: Column Properties Dialog Box

6. Inthe Column Propertiesdialog box, select the Transformation Rule tab.

7. Inthe Category list box, select Quarters and in the Function list box,
select Q.
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8.

10.

11.

A-26 H

Click OK.

Hyperion Integration Server Desktop displays the Table Properties dialog
box, as shown in Figure A-21.

Table Properties [ %]
General Columns | PhysicalJoinsI
| Table Mame | Column Marme | H| D| Al
TBC.S&LESF.. &DDITIONS Edit... |
TBC.SALESF.. COGS
Pe: MARKETING  TEBC.SALESF. MARKETING Add...
B MISC TBC.SALESF.. MISC
P OPEMINGIN.. TBC.SALESF. OPEMINGIM... Delete... |
B PAYROLL TEC.SALESF.. PavyROLL
.. FRODUCTID TBC.SALESF. FRODUCTID D ate-Hierarchy |
et Duarter | TEC.SALESF.. TRAMSDATE
B SALES TBC.SALESF.. SalES Hide |
P SCENARIDID  TEC.SALESF.. SCENARIOID
B STATEID TBC.SALESF.. STATEID Diill-Through |
Pe: SUPFLIERID  TBC.SALESF.. SUPFLIERID
B TRANSDATE  TEC.SALESF.. TRANSDATE Attribute |

QK I Cancel | Help |

Figure A-21: Table Properties Dialog Box
Y ou have created the column Quarter as the extraction of the Quarter
Date-Part from the TRANSDATE column.

In the Name column of the Table Properties dialog box, select
TRANSDATE and click Add.

Hyperion Integration Server Desktop displays the Add New Column to
Table dialog box.

In the Name text box of the Add New Column to Table dialog box, type
Month and click OK.

Hyperion Integration Server Desktop displays the Column Propertiesdialog
box.

In the Column Properties dialog box, select the Transformation Rule tab.
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12. Inthe Category list box, select Months and then in the Function list box,
select MM.

13. Click OK, then click OK again to exit and return to the OLAP Model main
window.

Y ou have created the logical column Month as the extraction of the Month
Date-Part from the TRANSDATE column. The available Category and
Function selectionsvary, based on the datatype of the source column (in this
example, TRANSDATE, which has a datetime data type in the source
column).

Renaming the Time Dimension

The Time dimension must be renamed before the Y ear hierarchy can be created.

» To rename the Time dimension:

1. Inthe OLAP Model main window, right-click the Time dimension table and
select Rename from the pop-up menu.

2. Inthe Nametext box, select the name Time, press Back space, and type Y ear
to change the name.

3. Pressthe Enter key.

Creating the Year Hierarchy
After you have created the logica columns Quarter and Month and the Time
dimension has been renamed to Y ear, you can create the Y ear Hierarchy.

» To create the Year hierarchy:

1. Inthe OLAP Model main window, right-click the Year dimension table and
select Properties from the pop-up menu.

Hyperion Integration Server Desktop displays the Dimension Properties
dialog box.
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2. Select theHierarchiestab and click Add.

Hyperion Integration Server Desktop displaysthe Edit Hierar chy dialog box,
as shown in Figure A-22.

Edit Hierarchy [ ]
I ame:
IYear
B Yo EF% Yex Filter... |
=5 Time BB Time Quarter =
""E‘B égggm“s 86 TimeMerih Transform... |
P
Bz MARKETING _
Pz MISC Wiew Table Data... |
Az
ES o .
P OPEMINGIMVENTORY Wiew Sample... |

[y PAYROLL
-fl.. PRODUCTID

Ay Quarter

Pl SALES

[, SCENARIDID

Pl STATEID

P SUPPLIERID

----- B TRANSDATE
Cancel |
Help |

Figure A-22: Edit Hierarchy Dialog Box for Year Hierarchy

3. Inthe Nametext box of the Edit Hierarchy dialog box, select Hierarchyl,
press Backspace, and type Y ear to change the name.

4. Click the plus (+) symbol in front of the Time dimension to expand the view.

Under the TIME table, double-click the Quarter column, and then
double-click the Month column.
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6. Select the Time.Quarter member and then click Transform.

Hyperion Integration Server Desktop displays the Replace tab of the Edit
Transformations dialog box, as shown in Figure A-23.

Edit Transformations - Time.Quarter

Feplace | Prefin/s uffi;l
Search for —Case
|| ' Original
_ " Upper Case
Replace with @ (L G
| " Capitalize First Letters
[ Caze Sensitive (C) — Space
™ Match whale wiord ) ¥ Drop Leading/Trailing 5 paces
V¥ Beplace Al Dccurrences [4) [V Convert Spaces to Underscores
e taLis Edipeae. | Delete |
Search | Replace | Conditions
Freview Hesults...l Ok I Cancel | Help |

Figure A-23: Edit Transformations Dialog Box, Replace Tab
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7. Select the Prefix/Suffix tab.

Hyperion Integration Server Desktop displays the Pr efix/Suffix tab of the
Edit Transformations dialog box, as shown in Figure A-24.

Edit Transformations - Time Quarter

Feplace Prefix/Suffiz |

* Mone

= Parent Mame

" Grandparent Name
= Al Ancestors' Names
= Dimenzion MNarme

= Parent Mame [Y]
" Grandparent Name [£]
= Al Ancestors' Names

Frefis Separator—————————————

€ Urderseore (| ]
€ Frell]

€ Caret [ ]

(& N separator

Custom Prefix Preview Prefis
Jatr o0
— Suffi
* Mone [w] € Urderseare (| ]

€ Frell]
€ Caret [ ]
(& N separaton

= Dimenzion Marme
Custom Suffis [¥]

Preview Hesults...l

|' Suffis Separator———————————

F'rewew Sufflx—‘

Cancel | Help |

Figure A-24: Edit Transformations Dialog Box, Prefix/Suffix Tab

8. Inthe Custom Prefix text box, type Qtr and click OK to return to the Edit
Hierarchy dialog box.

Note: Many Prefix/Suffix parameters can be selected to ensure that
Hyperion Essbase members are unique.
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9. IntheEdit Hierarchy dialog box, select the Time.Month member and click

Transform.

Hyperion Integration Server Desktop displays the Replace tab of the Edit

Transformations dialog box, as shown in Figure A-25.

Edit Transformations - Time_Month x|
Feplace | Prefix.-"SuffigI
Search for —Casze
|1 & Driginal
_ " Upper Case
Fieplace with @ v Cese
IJan " Capitalize First Letters
™ Case Sensitive [C) — Space:
¥ Match whale \wWard [w) V' Drop Leading/Trailing Spaces
™ Beplace &l Dccurences (&) V' Corwert Spaces to Underscores
Add to List EdiDetals | Dekte |
Search | Feplace | Conditions ;I
1 Jan W -t
2 Feb W
3 Mar W -
| | B
Freview Hesults...l QK | Cancel | Help |

Figure A-25: Edit Transformations Dialog Box, Replace Tab
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Replacing the Year Hierarchy Month Numbers

Y ou can change the format of year hierarchy months from numeric digits to
three-character month abbreviations to make spreadsheet reports easy to read.

To replace month numbers:
1.
2.

In the Search for text box, enter the Month number to be replaced.

In the Replace with text box, enter the text label which will replace the
numeric month value.

The default replacement option isReplace All Occurrences (A). Changethis
selection to Match WholeWord (W), by first clicking Replace All
Occurrences (A) to deselect it and then clicking Match Whole Word (W).

Click Add to List to add this Search and Replace operation to thelist.

Note: Repeat this process for the other eleven months. Each
numeric-digit month must be replaced individually.

Click OK three timesto exit the dialog box.
Note: You can apply other transformations in the Edit

Transformations dialog box; for example, you can change the
case of the member names and omit leading or tailing spaces.

Setting Columns to Attribute-Enabled

Thefinal step in setting up the OLAP model so that you can create attribute
dimensionsin the subsequent metaoutline is to set columns to attribute-enabled.

A-32 1

» To set columns to attribute-enabled:

1.

Inthe OLAP Model main window, right-click all the Product dimensions and
select View Columns from the pull-down menu.

Note: Inthisexample, there are three Product dimensions.

Select the Product dimension with PRODUCTDIM as the table name.
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3. Right-click PRODUCTDIM and select Properties from the pop-up menu.

Hyperion Integration Server Desktop displays the General tab of the Table
Properties dialog box, as shown in Figure A-26.

Table Properties [ %]

General | Calumns | Physical Joins |

I ame:

Dimensior:
IProduct

Lewvel:

|2

List of Physical Table(z]
TEC.PRODUCTDIM

QK I Cancel | Help |

Figure A-26: Table Properties Dialog Box, General Tab
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Select the Columns tab.

Hyperion Integration Server Desktop displays the Columns tab of the Table
Properties dialog box, as shown in Figure A-27.

Table Properties ]
General Columns | PhysicalJoinsI
Mame | Table Mame | Column Marme | H| D| Al
wec CAFFEIMA.. TECPRODU.. CAFFEINATED e Edit... |
Bex FAMILYID TEC.PRODU... FAMILYID
AmINTRODATE TECFRODU.. INTRODATE e Add...
B.. OUNCES TEC.PRODU... OUMCES e
B.PKGTYPE  TECPRODU.. PKGTYPE e Delete... |
P.. FRODUCTID TECPRODU.. PRODUCTID
Ensc SEU TEC.PRODU... SkU [ate-Hierarchy |
BeoSKUMAME  TECPRODU..  SKUMAME
Hide |
Dill-Through |
Attribute |
()3 | Cancel | Help |

Figure A-27: Table Properties Dialog Box, Columns Tab

Select all column namesthat areto be set as attribute-enabled (in thisexample,
CAFFEINATED, INTRODATE, OUNCES, and PKGTY PE).

Click Attribute, and then click OK .

Inthe OLAP Model main window, right-click all the Market dimension tables
and select View Columns from the pull-down menu.

Note: Inthisexample, there are three Market dimensions.

Select the Market dimension with POPULATION as the table name.
Right-click POPULATION and select Properties from the pop-up menu.

Hyperion Integration Server Desktop displays the Table Properties dialog
box.
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10. Select the Columnstab.

11. Select al column namesthat areto be set as attribute-enabled (in thisexample,
POPGROUP and POPULATION).

12. Click Attribute, and then click OK to return to the OLAP Model main
window.

Renaming the Accounts Dimension
Before the OLAP model is saved, the Accounts dimension must be renamed to
“Measures.”

» To rename the Accounts dimension:

1. Inthe OLAP Model main window, right-click the Accounts dimension and
click Rename.

2. Inthe Nametext box, select the name Accounts, press Backspace, and type
M easur es to change the name.

3. Pressthe Enter key.

Saving the OLAP Model

» To save the OLAP moddl:
1. Select File> Save.
2. Enter the OLAP model name and click OK .
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#MISSING. See missing data (#MISSING).

accountsdimension. A dimension type that makes accounting intelligence
available. Y ou can tag only one dimension as accounts; you do not need an
accounts dimension.

Add Joinsmode. In Hyperion Integration Server, a state in which you can draw
lines to define joins between objects in the OLAP model.

agent log file. A record of actions performed by the agent (server).
aggregate. See consolidate.

aggregation level. See consolidation level.

alias. An dternative name for a dimension, member, or description.

alias column. In Hyperion Integration Server, a column in the data source that
contains the aliases for a member level in the metaoutline.

alternate name. Seeadlias.

ancestor. A branch member that has members below it. For example, in a
dimension that includes years, quarters, and months, the members Qtr2 and 2001
are ancestors of the member April.

application. InHyperion Essbase, acontainer for one or more Hyperion Essbase
databases and files, such as calc scripts and dataload rules, that are related to the
databases.

ARBORPATH. An environment variable that specifies the Hyperion Essbase
root directory.

Architect. See Hyperion Integration Server Desktop.
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attribute. A classification of amember in adimension. Y ou can specify an
attribute to select and group members with a specified attribute and to perform
calculations and application-specific functions. For example, a Product dimension
can have several attributes, such as Size and Flavor. A specific member of the
Product dimension can have the Size attribute 8 and the Flavor attribute Cola.

base dimension. A standard dimension that is associated with one or more
attribute dimensions. To classify amember of a base dimension, you associate it
with a member of one or more attribute dimensions that describes the
classification, such as a specific flavor. For example, assuming products have
flavors, the Product dimension is the base dimension for the Flavors attribute
dimension.

block. The primary storage unit within Hyperion Essbase. A datablock isa
multidimensional array representing the cells of all dense dimensions.

branch. A member of ahierarchy that may or may not contain leaf members.
Builder. SeeHyperion Integration Server Desktop.
calc script. See calculation script.

calculation script. A text file containing a set of instructions telling Hyperion
Essbase how to calculate a database.

Catalog. See OLAP Metadata Catalog.

cell. A unit of data representing the intersection of dimensionsin a
multidimensional database; the intersection of arow and acolumn in aworksheet.

child. A member that has a parent above it in the database outline. A child may
have peers (siblings) that exist at the same layer of the database outline.

column. Inrelationa databases, avertical part of atable. Also known as afield.
A column contains all the values for a specific type of information. Every column
has a name and a particular data type. For example, a column may contain the
name or employee number for each employee.

Command Interface. See OLAP Command Interface.

concatenation. An operation that joins two characters or stringsin the order
specified, forming one string whose length is equal to the sum of the lengths of the
two characters or strings. For example, the strings “New York” and “Library,”
when concatenated, become “New Y ork Library.”

condition. Inrelational databases, a data extraction criterion. For example, you
can apply a condition to extract only the data that begins with the letter A.
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consolidate. The process of gathering data from dependent entities and
aggregating the data to parent entities. After you enter or load datainto child
entities, you perform a consolidation to aggregate the data through the
organization. As data consolidates, intercompany processing, conversion
methods, equity adjustments, and minority ownerships perform cal cul ationson the
data.

consolidation level. The top of an aggregation hierarchy or any branch or
sub-branch below the top, including the input (leaf) portion of the hierarchy.

data block. See block.

data cleansing. The process of making inconsistent data consistent. Examples of
inconsistent data are data in which some values are incorrect or are not of the
correct data type.

datafile. A file containing data blocks; Hyperion Essbase generates the datafile
during adataload and storesit on disk.

dataload. The process of populating a Hyperion Essbase database with data.
L oading dataestablishes actual valuesfor the cellsdefined by the structural outline
of the database.

dataload rules. A setof criteriaor rulesthat Hyperion Essbase usesto determine
how to load data from a text-based file or arelational data set into a Hyperion
Essbase database.

data point. Seecdll.

data source. External data, such as atext file, spreadsheet file, or SQL database
that will be loaded into a Hyperion Essbase database.

datatype. Definesthe kind of datathat a column can contain. For example,
columns with the Numeric data type contain numbers.

data value. Seecell.

database. A collection of related information. Each unit (record) of the database
istypically organized in afixed format to makeit easy to retrieve selected portions
of the dataon demand. Each record ismade up of one or more datafields, and each
datafield can hold one piece of data (known as a value).

database administrator. Anindividua who administers database servers, such
as Hyperion Essbase, and who may also design, maintain, and create databases.

database outline. See outline.
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DateTimetransformation. A set of instructions that defines how to change or
reformat arelational database DateTime data type to your choice of date format.

DBMS. Seerelational database management system (RDBMS, DBMS).

denormalization. The process of adding redundancy to datain a database,
typically by joining tables to form more complete sets of data in the individual
tables. This processis performed for the purpose of increasing data retrieval
performance. Contrast with normalization.

dense dimension. A dimension likely to contain data for every combination of
dimension members. For example, atime dimension is typically a dense
dimension because it contains all combinations of all members. Contrast with
sparse dimension.

descendant. Any member below aparent in the database outline. For example, in
adimension that includesyears, quarters, and months, the members Qtr2 and April
are descendants of the member Y ear.

detail member. Seeleaf member.

dimension. A datacategory that isused to organize businessdatafor retrieval and
preservation of values. Each dimension usually contains a hierarchy of related
members grouped within it. For example, a 'Y ear dimension often includes
members for each time period, such as quarters and months. Other common
business dimensions may be measures, natural accounts, products, and markets.

dimension branch. A collection of dimension tables organized in a hierarchical
structure, with one of the dimension tables joined directly to the fact table. A
dimension branch defines asingle, potential Hyperion Essbase dimensionin a
Hyperion Integration Server metaoutline.

dimension build rules. In Hyperion Essbase, a set of operations similar to data
load rules. Instead of |oading data, the dimension build rules modify the outline
based on data in the external data source file.

dimension table. A container in the OLAP model for one or more relational
tables that define a potential Hyperion Essbase dimension. When one dimension
table joinsto another dimension table, forming adimension branch, the dimension
is composed of the columns of al the dimension tables in the dimension branch.

dimension type. A property in the OLAP mode and in the metaoutline that
defines which tables form the Hyperion Essbase accounts, time, and standard
(default) dimensions.
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duplicate member. The second occurrence of a member name in a data source.
Users can determine whether Hyperion Integration Server ignores duplicate
members or adds them as shared members. See also shared member.

Dynamic Calc And Store members. A member that the Hyperion Essbase
server calculates only upon the first retrieval of the value. The server then stores
the calculated valuein the database. Subsequent retrievals of aDynamic Calc And
Store member do not require calculating.

Dynamic Calc members. A member that the Hyperion Essbase server calculates
only at retrieval time. The server discards calculated values after the retrieval
request is complete.

dynamic calculation. In Hyperion Essbase, a calculation that occurs only when
you retrieve data on amember that has been tagged as Dynamic Calc or Dynamic
Calc And Store. The valuesfor that member are calculated at retrieval timeinstead
of being precal culated during batch calculation.

Dynamic Time Series. A processthat isused to perform dynamic period-to-date
reporting.

Dynamic Time Series members. Predefined members that are used to perform
Dynamic Time Series reporting.

Esshase database. A repository of datawithin Hyperion Essbase that contains a
multidimensional data storage array. Each database consists of a defined storage
structure (a database outline), data, security definitions, and other associated files,
such as calculation scripts or dataload rules. See also application.

Essbase OLAP server. A database server that locates and accesses
multidimensiona data.

Essbase outline. See outline.

fact table. In Hyperion Integration Server, a container for one or more relational
tables that define the data val ues for each dimension intersection in the OLAP
model. For example, if the OLAP model contains Products, Region, and Y ear
dimensions, the fact table might include data values for the number of units of
Product A sold in New Y ork in January.

field. (1) InHyperion Esshase, avalueor item in adatasourcefilethat isretrieved
from a Hyperion Essbase database. (2) In relational databases, a space allocated
for aparticular item of information. Fields are the smallest units of information
that you can access. Most fiel ds have certain characteristics associated with them.
For example, some fields are numeric, whereas others are textual. Every field has
aname.
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file delimiter. Oneor more characters, such asacommayf(,), separating fieldsina
data source.

filter. (1) In Hyperion Essbase, amethod for controlling access to database cells.
A filter is the most detailed level of security, allowing you to define the varying
access level sthat users can haveto data. (2) In Hyperion Integration Server andin
relational databases, a method for controlling which data you retrieve from a
relational database. For example, you can choose to retrieve products only in the
Product A product family. A filter contains one or more conditions.

foreign key. Inrelational databases, a column whose data values correspond to
the values of akey column in another relational table. See also key column and

primary key.

formula. In Hyperion Essbase, a combination of operators and functions as well
as dimension names, member names, and numeric constants. Formulas are used to
calculate relationships between members of a Hyperion Essbase database.

@V AR(Actual, Budget) is an example of aformula.

generation. A layer in ahierarchical tree structure that defines member
relationships in a Hyperion Essbase database. Hyperion Essbase orders
generations incrementally from the dimension (generation 1) down to the leaf
members.

generation name. A unique name that describes a generation.

hierarchy. A set of multidimensional relationshipsin an outline, often created in
atree formation. For example, parents, children, and generations represent a
hierarchy.

Hyperion Essbase kernel. A layer of the Hyperion Essbase server that provides
the foundation for a variety of functions, including data loading, calculations,
spreadsheet lock& send, partitioning, and restructuring. The Hyperion Essbase
kernel reads, caches, and writes data; manages transactions; and enforces
transaction semanticsto ensure data consistency and data integrity.

Hyperion Integration Server Desktop. The client component of the Hyperion
Integration Server product family. Thistool is used to create OLAP models and
metaoutlines, and to load data into Hyperion Essbase databases.

index. (1) In Hyperion Essbase, a method of retrieving data based on sparse
dimensions. Also refersto theindex files, collectively. (2) In relational databases,
pointersthat arelogically arranged by the values of akey. Indexes optimize access
to relational data.

index cache. In Hyperion Essbase, a buffer in memory that holdsindex pages.
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index entry. In Hyperion Essbase, a pointer to an intersection of sparse
dimensions. Each index entry points to ablock on adisk and locates a particular
cell within the block by means of an offset.

index file. In Hyperion Essbase, afile used to store data retrieval information.
It resides on adisk and contains index pages.

index page. InHyperion Essbase, asubdivision of anindex file containing entries
that point to data blocks.

input block. A type of data block that contains at least one loaded data value.

input data. Any datathat isloaded from a data source and is not generated by
calculation.

Integration Server. See OLAP Integration Server.

integrity constraint. Inrelational databases, arule stating that each row must
contain an entry for each required key column.

intersection level. Inthe Hyperion Essbase Spreadsheet Add-in, a Hyperion
Essbase member combination that defines a specific vaue. For example, the
member combination Actual, Root Beer, Sales, Jan, East represents the actual
January sales value for root beer in the Eastern region.

join. Inrelational databases, arelationship between two tables based on matching
key column values.

join columns. In Hyperion Integration Server, two relationa table columns that
are joined from one table to another.

key column. Inrelational databases, a column or columns that form a unique
identifier for each row. For example, EMPLOY EE_ID might be akey column.

leaf member. A member that has no children.

left frame. (1) In the Hyperion Integration Server Desktop OLAP Metaoutline
main window, the area on the | eft that enables you to view alist of dimensions
previously defined in the OLAP maodel. (2) Inthe OLAP Model main window, the
areaon the left that displays alist of the tables and views available in your source
relational database.

Hyperion Integration Server Desktop OLAP Model User’s Guide B Glossary-7



Glossary

level. (1) InHyperion Essbase, alayer of ahierarchical tree structure that defines
database member relationships. Hyperion Essbase numbers levelsincrementally
from the leaf member (level 0) up to the dimension member. (2) In Hyperion
Integration Server, the distance of adimension table from the fact table in the
OLAP model. For example, if atableislevel 2, it is separated from the fact table
by two links.

level O block. A datablock that is created for sparse member combinations when
all the members of the sparse combination are level 0 members.

level 0 member. Seeleaf member.
level name. A unique name that describes alevel.

load member. In Hyperion Integration Server, amember in a user-defined
dimension into which datais loaded. Only user-defined dimensions require load
members. For all non-user-defined dimensions, Hyperion Integration Server is
capable of loading members and data into the Hyperion Essbase database.

load properties. In Hyperion Integration Server, a set of rules that determine
what actions the product performs on member level names and data as they are
loaded.

logical column. In Hyperion Integration Server, a column created by
mani pul ating the datain one or more physical columns. See also column. Contrast
with physical column.

logical table. Inrelational databases, a table created by manipulating columns
from one or more physical tables. Thelogica tableisonly aview of the data; the
columns remain stored in the original tables and are not physically duplicated in
the logical table. See also view. Contrast with physical table.

mathematical operator. A symbol that defines how datais calculated. A
mathematical operator can be any of the standard mathematical or Boolean
operators, for example, +, -, *, /, and %. Mathematical operators are used in
formulas and outlines.

MDDB. See multidimensional database (MDDB).

measures. Datavaluesthat a user wants to track, such as Unit_Price and
Discount. By default, measures values map to the accounts dimension in the
OLAP model, which maps to the measure dimension in the OLAP metaoutline,
which in turn maps to the accounts dimension in the Hyperion Essbase outline.

measures dimension. In Hyperion Integration Server, a dimension that, by
default, maps to the accounts dimension in the Hyperion Essbase outline.
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member. A discrete component within adimension. For example, atime
dimension might include members such as Jan, Feb, and Qtrl.

member combination. In Hyperion Essbase, alist of member names used to
specify a set of data at the intersection of two or more dimensions. A member
combination is specified by using the cross-dimensional operator -> (a hyphen
followed by aright-angle bracket). For example, the actual salesdatafor the month
of January in Sample Basic is Sales->Jan->Actual.

member level. A hierarchical level of detail within adimension. For example, in
adimension that defines geographic areas by nation, which are then subdivided
into provinces, the nation and province categories each represent a member level.
A member level correspondsto aleve in aHyperion Essbase outline. The
measures dimension contains actual members that are also member levels.

member load. The process of adding new dimensions or members (without data)
to a Hyperion Essbase outline. Contrast with data load.

metadata. The components of a database outline that describe and hold data.
Examples of metadata are dimension names, member names, properties, time
periods, and security.

metaoutline. In Hyperion Integration Server, atemplate containing the structure
and rules for creating a Hyperion Essbase outline from an OLAP moddl.

missing data (#M1SSING). A marker indicating that datain the labeled location
does not exist, contains no meaningful value, or was never entered or loaded. For
example, missing data exists when an account contains data for a previous or a
future period but not for the current period.

Move mode. In Hyperion Integration Server, a state in which you can pick up,
move, and drop objectsin the OLAP Model main window.

multidimensional. Describesamethod of referencing datathrough three or more
dimensions. Anindividual datavalueistheintersection of one member from each
dimension.

multidimensional database (MDDB). A type of database that enables
referencing data through three or more dimensions. An individual record isthe
intersection of a point for a set of dimensions. Contrast with relational database.

normalization. The process of grouping and removing redundancy from data so
that each entity isin itsappropriate placein the database and only initsappropriate
place. Contrast with denormalization.
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numeric transformation. In Hyperion Integration Server, a set of instructions
that define how to change or reformat arelational database numericfield type. For
example, you may choose to divide numeric data by 100.

ODBC. See Open Database Connectivity (ODBC).

ODBC data source. Location of the data that you are accessing and the
information necessary to access the data using ODBC. For example, an ODBC
datasource that connectsto an SQL server might require aserver name, adatabase
name, a user name, and a password. See also Open Database Connectivity
(ODBC).

OLAP. Seeonlineanalytical processing (OLAP).

OLAP Architect. See Hyperion Integration Server Desktop.
OLAP Builder. See Hyperion Integration Server Desktop.
OLAP Catalog. See OLAP Metadata Catal og.

OLAP Command Interface. InHyperion Integration Server, acommand-line
tool that you can use to perform common operations on the Hyperion Essbase
outline and the data in the Hyperion Essbase database. For example, you can use
the LOADDATA command to load data.

OLAP Integration Server. The server component of the Hyperion Integration
Server product family. OLAP Integration Server uses the information stored in
OLAP Metadata Catal og to extract the dimension names and member names
needed to build a Hyperion Essbase outline from the data source. When the
Hyperion Essbase outlineis complete, OLAP Integration Server extractsdatafrom
the data source, performsthe operations specified in the metaoutline, and loadsthe
datainto the Hyperion Esshase database.

OLAP Metadata Catalog. InHyperion Integration Server, arelational database
containing metadata describing the nature, source, location, and type of data that
you pull from therelational data source. OLAP Integration Server accesses OLAP
M etadata Catal og to generate the SQL statements and the information required to
generate a Hyperion Essbase database outline.

OLAP model. InHyperion Integration Server, alogical model (star schema) that
you create from tables and columnsin arelational database. Y ou can then use the
OLAP model to generate the structure of a multidimensional database.

OLTP. Seeonline transaction processing (OLTP).
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online analytical processing (OLAP). A multidimensional, multiuser,
client-server computing environment for users who need to analyze consolidated
enterprise datain real time. OLAP systems feature drilling down, data pivoting,
complex calculations, trend analyses, and modeling.

onlinetransaction processing (OLTP). OLTP applications are commonly
referred to as data capture, data entry, or data collection applications. OLTP
applications enable an organization to capture the large amounts of data resulting
from its daily activities but provide limited capahility for reporting on the data.

Open Database Connectivity (ODBC). Standardized application programming
interface (API) technology that allows applications to access multiple third-party
databases.

outline. The structure that defines all elements of a database within Hyperion
Essbase. For example, an outline contains definitions of dimensions, members,
and formulas.

parent. A member that has an aggregated branch below it.

pass-through transformations. In Hyperion Integration Server, afeature that
enables you to use functions specific to your relational database management
system (RDBMS) to extract data valuesfor columns. Y ou can provide a statement
that Hyperion Integration Server passes through to your RDBMS as a part of the
SQL SELECT statement. Y ou provide the statement as a property of acolumn and
the pass-through feature returns a value for the column.

permission. A special privilegethat must be assigned to users or groupsto enable
them to access or modify secure data. Permissions include Read, Read/Write and
None.

physical column. A column that is stored in arelational database. See also
column. Contrast with logical column.

physical table. A combination of rows and columns stored in arelational
database. Contrast with logical table.

pointer. Inrelational databases, adata element that indicates the location of data
in storage.

primary dimension table. A dimension tablethat joinsdirectly to the fact table.
Additional dimension tables may join to the primary dimension table to create a
dimension branch.

primary key. Inrelational databases, acolumn (key) that uniquely identifiesa
row. For example, Employee ID.
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qguery governor. In Hyperion Integration Server, a parameter that you set to
control the time and size of the queries made to the data source.

RDBMS. Seerelational database management system (RDBMS, DBMS).

record. A set of information in a data source. Records are composed of fields,
each of which contains one item of information. A set of records constitutes a
table. A single record constitutes arow in the table. For example, atable
containing personnel information might contain records (rows) that have three
fields: aNAME field, an ADDRESS field, and a PHONE_NUMBER fidld.

recursivetable. A source relational table that contains information in one row
that isa parent or child of information in another row. For example, in arelational
source table containing the columns EMPLOY EE_ID, NAME, and
MANAGER_ID, the columns EMPLOY EE_ID and MANAGER_ID are
recursive because MANAGER_ID refers back to the EMPLOYEE_ID. Using
Hyperion Integration Server, you can build a Hyperion Essbase outline hierarchy
from arecursive source table.

relational database. A type of database that stores data in the form of related
tables. A single database can be spread across several tables, and can be viewed in
many different ways. Contrast with multidimensional database (MDDB).

relational database management system (RDBM S, DBMS). A system for
accessing datain arelational database. Thisterm is often used to describe systems
for management of multiple relational databases or tables.

restructure. In Hyperion Essbase, an operation to regenerate or rebuild the
database index and, in some cases, the data files.

right frame. Inthe Hyperion Integration Server Desktop OLAP Metaoutline
main window, the areaon theright, in which you build ametaoutline. Inthe OLAP
Model main window, the area on the right, in which you build an OLAP model.

roll-up. See consolidate.

schema. In relational databases, alogical model that represents the data and the
relationships between the data.

server. See Essbase OLAP server and OLAP Integration Server.

shared member. A member that shares storage space with another member of the
same name. The shared member has a property that designates it as shared. The
use of shared members prevents duplicate cal cul ation of membersthat occur more
than once in a Hyperion Essbase outline.
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sibling. A child member within a dimension, having the same parent as another
child member. For example, the members East and West are both children of the
Markets dimension and siblings of each other.

sparse dimension. A dimension unlikely to contain data for all combinations of
dimension members. For example, product and market dimensions are sparse if
not all products are sold in all markets. Contrast with dense dimension.

SQL. Seestructured query language (SQL).

staging area. A database that you create to meet the needs of a specific
application. A staging areais a snapshot or restructured version of one or more
RDBM Ss.

standard dimension. A dimension that is not an attribute dimension.

star schema. InHyperionIntegration Server, alogical model that representsyour
relational datain aform that mirrors OLAP. A star schema contains a fact table
and one or more dimension tables.

storage manager. See Hyperion Essbase kernel.
string. A sequence of characters treated as a unit.

structured query language (SQL). A computer language used to access datain
relational databases.

supervisor. A defined type of user who has full accessto all applications,
databases, related files, and security mechanisms for a server.

system administrator. A person who maintains the hardware, software, disk
space distribution, and configurations for running software applications such as
Hyperion Essbase.

table. Inrelationa databases, aform of data storage in which datais stored in
rows and columns.

timedimension. A dimension type that defines how often datais collected and
updated, such as per fiscal or calendar periods. Only one dimension may betagged
astime; atime dimension is not required.

transformation rules. In Hyperion Integration Server, a set of instructions that
define how to change or reformat the member names and datathat you extract from
the source relational database.

two-pass calculation. A Hyperion Essbase property that is used to recalculate
members that are dependent on the calculated val ues of other members. Two-pass
members are calculated during a second pass through the database outline.
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UDA. Formerly called user-defined attribute. A UDA is aterm associated with
members of an outlineto describe aparticular characteristic of the members. Users
can specify UDAswithin calculation scripts and reports to return lists of members
that have the specified UDA associated with them. UDAS can be applied to dense
aswell as sparse dimensions.

unary operator. A group of mathematical indicators (+, -, *, /, %) that define
how consolidations take place on the database outline.

union. Inrelational databases, atype of join that combines the results of two
SELECT statements. A union is often used to merge lists of values contained in
two tables.

upper-level block. A type of datablock that is created for sparse member
combinations when at least one of the sparse membersis a parent-level member.

user-defined attribute. See UDA.

user -defined dimension. Dimensions that you explicitly create in Hyperion
Integration Server, rather than dimensions obtained or built from the relational
data source.

user -defined member. Members that you explicitly create in Hyperion
Integration Server, rather than obtaining and building them from therel ational data
source.

validation. (1) In Hyperion Esshase, aprocess of checking arulesfile against the
outline to make surethat therulesfileisvalid. (2) In Hyperion Integration Server,
aprocess of checking the OLAP model and metaoutine.

view. Inrelational databases, alogical table created by combining columnsfrom
one or more tables.
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1= (not equd to) operator, 10-18

" (double quotation marks), in dimension and
member names, 3-28

#MISSING, as reserved word, 3-28

% (percent) operator, modulus function, 7-10

& (ampersand), in dimension and member names,
3-28

() (parentheses), in dimension and member names,

3-28

* (asterisks), in dimension and member names, 3-28
+ (plus signs), in dimension and member names, 3-28

. (periods), in dimension and member names, 3-28
< (lessthan)
in dimension and member names, 3-28
operator, 8-4, 10-18
<= (less than or equal to) operator, 8-4, 10-18
<> (not equal to) operator, 10-18
<NONE> aggregation option, 6-18
= (equal signs)
in dimension and member names, 3-28
= (egual to) operator, 10-18
> (greater than) operator, 8-4, 10-18
>= (greater than or equal to) operator, 8-4, 10-18

@ (at signs), in dimension and member names, 3-28

\ (backdashes), in dimension and member names,
3-28
_ (underscores)
converting spaces to, 10-24
in dimension and member names, 3-28

{} (braces), in dimension and member names, 3-28

| (vertical bar), in dimension and member names,
3-28
— (dashes), in dimension and member names, 3-28
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' (single quotation mark), in dimension and member
names, 3-28
, (commas), in dimension and member names, 3-28

A

access

changing, for OLAP models, 3-25

specifying for OLAP models, 3-24
accessing

data sources, 3-4, 3-5

online help, xiv

tablesin OLAP Metadata Catalog, 2-23
accounts dimension

columns, adding to, 4-6

conditions when not required, 4-7

creating automatically, reasons for, 4-6

creating manually, 4-8

datatypesand, 5-10

defined, 4-7

deleted columns, 5-10

deleting, 5-16

dimension branches and, 5-6

effects of hiding or deleting columns, 6-7

fact table, relation to, 4-4

graphic, 3-14

hidden columns, 5-10

measures and, 4-7

overview, 4-7

relationship to fact table, 5-10, 5-11

renaming, A-35

rules for adding tables or views, 5-10

sample hierarchy, 2-11

source tables and views to use, 4-7

switching with time dimension, 4-14
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use in Hyperion Essbase outline, 2-20
use in metaoutlines, 4-7
when not to create automatically, 4-6
when required, 4-7
Add Accounts Dimension command, 4-8
Add Joins mode
defined, 5-15
Join tool, 3-13
joining tables, 9-6, 9-9
Add New Column to Table dialog box, 6-16, A-24
Add Time Dimension command, 4-10
aggregation
choosing level of, 2-2
defined, 1-3
filters, creating in metaoutlines, 10-13
options, defining for measures, 6-18
aliases
availability of columns as, 6-6, 6-12
concatenating, 2-19
creating for dimension or member names, 2-19
defining, 9-16
member levels, 9-16
pass-through transformations and, 2-19
recursive tables and, 2-8, 9-16
All command, View > Model |cons menu, 6-5
ampersands (&), in dimension and member names,
3-28
ancestors, prefixing or suffixing names, 10-26
and, using to combine filter conditions, 10-20
ascending sort, hierarchies and, 10-21
asterisks (*), 3-28
at signs (@), in dimension and member names, 3-28
attribute dimensions
associating with base dimensions, 8-4
comparison with standard dimensions, 8-4, 8-5
described, 8-3
attribute-enabled columns
deselecting, 8-6
selecting, 8-6, A-32
attributes
advantages, 8-3
Attribute Field, 8-8
Boolean type, 8-4
caculations, 8-4
comparison with standard dimensions, 8-4
date type, 8-4

Index-2 A

numeric type, 8-4

operators, 8-4

text type, 8-4

types, 8-4
audience, for this guide, xi
automatic joins, how created, 4-3
AV G aggregation option, 6-18

B

backslashes (\), in dimension and member names,
3-28

batch processing, OLAP Command Interface, 1-9
bitmapped indexes, defined, 2-14
braces ({ }), in dimension and member names, 3-28
branches

dimension, defined, 5-5

recursive hierarchies and, 10-5

C

calculations, Numeric data types and, 7-11
calendar, user-defined, example, 4-12
capitalization, changing, 10-24
case, changing, 10-24
case-sensitive names, 3-28
characters
forbidden at the beginning of a name, 3-28
maximum in dimension names, 3-28
maximum in member names, 3-28
child column
filtering example, 10-15
filtersand, 10-14
cleansing data, 2-6
clock graphic, 3-14
closing OLAP models, 3-27
collapsed view, source data, 3-15
column joins
adding, 9-10
changing, 9-12
defined, 9-1
deleting, 9-14
viewing, 9-7
Column Properties dialog box
adding user-defined columnsto dimension tables,
6-17
General tab, 6-17

Hyperion Integration Server Desktop OLAP Model User’s Guide



Transformation Rule tab
DateTime datatype, 7-13
Numeric datatype, 7-9
pass-through transformations, 7-15
String data type (concatenations), 7-6
String data type (substrings), 7-3
Column Transformation command, View > Model
Icons menu, 6-5
column transformations
DateTime data type, 7-12
graphicsfor, 6-5
Numeric datatype, 7-8
String data type as concatenation, 7-5
String data type as substring, 7-3
columns
accounts dimension, adding to, 4-6
adding, 6-14
attribute-enabled, 8-6, A-32
availability, aliases, 2-19
capitalization, xiii
child, 9-15
combining, 7-5
defining as Drill-Through, 6-12
deleted, fact table and accounts dimension, 5-10
deleting, 5-16, 6-9
dimension tables, adding to, 5-8, 9-10
displaying names and properties, 6-4
displaying source keys, 3-16
fact table, adding to, 9-10
filtering, 10-13
fully-defined in recursive tables, 2-9
graphics, 6-5
graphics, displaying, 6-5
hidden, fact table and accounts dimension, 5-10
hiding, 6-6
indexes, 2-14
key, time-related, 4-11
measures, 5-10
multiple sources, 2-4, 4-4
multiple tebles and, 5-7
parent, 9-15
renaming, 6-6
restricting, 10-13
rules for naming, 3-28
sorting in hierarchies, 10-21
timedatain, 4-14
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time dimension and fact table, 5-10
time dimension, adding to, 4-6
time-related, defining in source data, 2-20
tipsfor joining, 9-8
transposing with rows, 2-10
Columns tab, Table Properties dialog box, 6-7
commas (,), in dimension and member names, 3-28
compound key, defined, 4-3
concatenation
aliases, 2-19
example, 7-5
String data type transformations, 7-5
conditions, combining, 10-20
connecting
problems with, 3-6
to data sources or OLAP Metadata Catalog, 3-4,
3-5
Connections menu
OLAP Metadata Catalog > Connect command,
3-30
OLAP Metadata Catalog > Delete Locks
command, 3-31
consolidation
defined, 1-3
drill down and, 1-4
example, 1-3
hierarchies and, 10-3
members, 1-3
consolidation levels, dimension branches and, 5-5
conventions
naming, 3-28
used in this book, xv
copying OLAP models, 3-27
COUNT aggregation option, 6-18
Create New Dimension dialog box
creating a standard dimension, 5-3
joining dimension table to the fact table, 9-6
manually creating atime dimension, 5-3
switching time and accounts dimensions, 4-16
Create New Table dialog box, 4-15
creating
automatic joins, 4-3
hierarchies, 2-8, 10-7
Hyperion Essbase databases, workflow, 1-10
indexes, 2-14
joins, 9-8
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self joins, 9-19

standard dimensions, 5-3, 9-6

time dimension manually, 5-3
curly braces. See braces
customer comparisons, 1-2

D

dashes (-), in dimension and member names, 3-28
data
calculation operatorsin, 7-8
cleansing, 2-6
combining multiple sources, 2-4
concatenation example, 7-5
denormalizing, 2-12
drill down, 1-4
ensuring consistency, 2-6
hiding values, 6-6
pass-through transformations on, 7-14
pivoting to change view, 1-5
preparing for time analysis, 2-20
source preparation, 2-1
source, switching views, 3-16
transforming in columns, 7-1
transforming in data source, 2-14
transforming in hierarchies, 10-22
types of, 2-2
viewing hidden, 3-15
viewing source columns and keys, 3-16
Data Source dialog box, A-6
data sources
accessing, 3-4, 3-5
build levels, 2-8
collapsed view, 3-15, 3-17
column quick-view, 3-18, 6-4
defining, 2-3
OLTP databases, 1-5
parent-child, 2-8
spreadshest files, 1-5
SQL, 1-5
text files, 1-5
viewing column names, 3-15
viewing column names in left frame, 3-15
viewing column names in right frame, 3-15
workflow for transferring, 1-10
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data types
accounts dimension and, 5-10
cleansing, 2-6
supported, 6-3
time dimension and, 5-10
user-defined columns, 6-14
viewablein OLAP Model, 6-3
column joins
Seealsojoins
datavalues
See also measures
calculated using pass-through transformations,
7-14
numeric, 4-1
numeric, accounts dimension and, 4-7
prefixing, 10-25
replacing, 10-24
sorting, 10-21
suffixing, 10-25
transforming, 10-22
user-defined columns and, 7-1
data warehouse, diagram, 2-5
database management systems, pass-through
transformation rules, 7-15
databases, multidimensional. See multidimensional
databases
databases. See data sources
Date Hierarchy dialog box, 6-11
dates
format, specifying, 7-14
formatting in source data, 2-21
parts, setting, 7-4
rows, in user-defined calendars, 4-13
DateTime data type
graphicsfor, 6-5
mapped to ODBC data types, 6-3
transforming columns in dimension tables, 7-12
DB2, tablesdisplayed in, 2-16
default dimensions, creating, 5-3
Deletean OLAP Model/Metaoutline dialog box, 3-30
Delete Locks command, 3-31
deleting
accounts dimensions, 5-16
columns, 5-16, 6-9
dimension table columns, 6-9
dimension tables, 5-16
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fact table, 5-16
OLAP models, caution, 3-31
OLAP models, confirming, 3-31
OLAP models, open by other users, 3-25, 3-31
OLAP models, procedures, 3-30
denormalizing data, 2-12
descending sort, hierarchies and, 10-21
descriptions, entering for OLAP models, 3-24
desktop. See Hyperion Integration Server Desktop
detail data
choosing level of, 2-2
retrieving, 1-4
dialog boxes
Add New Column to Table, 6-16, A-24
Column Properties, 7-6, 7-9, 7-13, 7-15, A-25
Create New Dimension, 4-16, 5-3, 9-6, A-11
Create New Table, 4-15
Data Source, A-6
Date Hierarchy, 6-11
Delete an OLAP Model/Metaoutline, 3-30
Edit Filter, 10-16
Edit Filter, Ordering tab, 10-21
Edit Hierarchy, 10-8, 10-9, 10-11, 10-15, A-21,
A-28
Edit Join Info, 9-7, 9-9
Edit Transformations, 10-23, 10-26, A-29, A-30,
A-31
OLAP Moddl Assistant, 1-8, 3-7
OLAP Mode Properties, 3-25, 3-26
OLAP Model Validation Errors, 3-19
Preview Filter Results, 10-28
Preview Transformations dialog box, 10-28
Recursion, 9-21
Sample Outline, 10-28
Save New OLAP Modsdl, 3-23
Select Values, 10-17
Table Properties, 5-8, 5-13, 5-14, 6-9, 8-6, 8-7,
9-11, 9-14, 9-19, A-24, A-33, A-34
View Sample, 10-28
View Table Data, 3-17
dimension branches
consolidation levels and, 5-5
creating, 9-9
defined, 2-18, 5-5
diagrams, 5-5
fact table and, 5-6
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levelsin, 5-5

time dimension and, 5-6
dimension hierarchies. See hierarchies
dimension names

creating aliases, 2-19

maximum length, 3-28
Dimension Properties dialog box

Hierarchies tab, 10-7

Member Info tab, 4-17
dimension table columns. See columns
dimension tables

adding columns, 6-14

adding to existing dimension tables, 9-10

creating additional, A-17

defined, 1-12, 2-18

deleting, 5-16

deleting joins between, 9-14

deleting joins within, 9-14

joining, 9-6

joining to dimension tables, 9-9

joins between, 9-8, 9-14

moving, 5-15

names, changing, 5-15

OLAP models, 1-12

properties, viewing, 5-13

relationship to fact table, 4-3

renaming, 5-15

rules for naming, 3-28

self joins, 9-19

source tables, adding to, 5-8

user-defined columns, 6-14

views, 5-10
dimensions

accounts, 4-7

adding tablesto, 5-7

attribute, 8-3

choosing, 2-2

choosing tables for, 2-18

creating, 5-3

creating column joins, 9-7, 9-9

creating in ametaoutline, 1-13

creating standard, 9-6

defined, 1-3, 1-10, 2-18

examples, 1-3

frequency of change, 1-3

joining to fact table, 5-3
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joining, about, 9-5
member hierarchies, 10-7
members, 1-3
names, changing, 5-14
naming, 3-28, 5-4, 9-7
prefixing name, 10-27
renaming, 5-14
rules for naming, 3-28
sample TBC model, A-3
Scenario, 1-13
standard, creating, 5-3
standard, defined, 5-1
suffixing name, 10-27
time, 4-8
time, when required, 4-8
usein consolidation, 1-3
using in metaoutlines, 1-12
viewing, 5-14

dimensions and members, 3-28

directories
default OLAP Modd, 3-3
is, 3-3

documentation
Hyperion Essbase Spreadsheet Add-in, xiv

double quotation marks ("), in dimension and

member names, 3-28

drill down, 1-4

drill up, 1-4

Drill-Through columns
defining, 6-12
graphicsfor, 6-5

Drill-Through command, View >Model |cons menu,

6-5
Dynamic Time Series, 7-4

E

Edit Filter dialog box, 10-16
Edit Filter dialog box, Ordering tab, 10-21

Edit Hierarchy dialog box, 10-8, 10-9, 10-11, 10-15,

A-21, A-28
Edit Join Info dialog box, 9-7, 9-9
Edit Transformations dial og box
Prefix/Suffix tab, 10-26, A-30
Replace tab, 10-23, A-29, A-31

equal signs (=) in dimension and member names,
3-28

equal to operator (=), 10-18

examples, 10-6

Exclusive Access, saving with, 3-21

executable name
for Hyperion Integration Server Desktop, 3-3
for OLAP Model, 3-3

F

fact table

accounts dimension, relation to, 4-4

adding tablesto, 5-4

adding to, 9-10

as basis for creating time dimension, 4-10

choosing tables for, 2-17

compared with dimensions, 2-2

compound key, 4-3

contents of, 4-4

creating, 4-5, A-8

defined, 1-12, 2-17, 4-3

deleting, 5-16

diagram, 4-3

dimension branches and, 5-6

graphic, 3-14

hidden or deleted columns, 5-11

joining columns from newly added tables or

views, 5-12, 9-11

joining dimensions, 9-6

measures and, 2-17, 4-3

name, automatic, 4-5

name, changing, 5-14

options for completing, 4-7

properties, viewing, 5-13

relationship
to accounts dimension, 4-6, 5-10, 5-11
to dimension tables, 4-3
totimedimension, 5-11

renaming, 5-14

requirement for, 4-4

rolein OLAP modd, 1-12

rules for adding tables or views, 5-11

tables, adding to, 5-11, 5-12

time dimension and, 4-9

facts, defined, 1-10
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File menu
Delete command, 3-30
New command, 3-4
Open command, 3-4
Print command, 3-29
Save As command, 3-22, 3-27
Validate command, 3-18
Filter command, View > Model |cons menu, 6-5
filters
changing, 10-13
child column and, 10-14
combining conditions, 10-20
components of, 10-13
condition operators, 10-18
example, 10-13
graphicsfor, 6-5
hierarchy, 10-13
indexes on columns, 2-14
metaoutlines and, 10-13
operators and, 10-18
order performed, 10-21
parent column and, 10-14
recursive tables and, 10-14
SQL, 10-16
viewing results, 10-27
fiscal year, non-standard, 4-11, 4-13
flat files
asadatasource, 2-3
combining with SQL data sources, 2-4
forecasting, 1-4
formatting dates, specifying, 7-14
fully defined columns, defined, 2-9
functions, pass-through, 7-16

G

general ledger

data, 2-22

switching time and accounts, 4-14
General tab

Column Properties dialog box, 6-17

OLAP Model Properties dialog box, 3-25
grandparent, prefixing or suffixing name, 10-26
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graphics
accounts dimension, 3-14
column transformation, 6-5
column, displaying, 6-5
columns, 6-5
DateTime column, 6-5
Drill-Through column, 6-5
fact table, 3-14
filter column, 6-5
hidden column, 6-5
hierarchy transformation, 6-5
join column, 6-5
Numeric columnsin the fact table, 6-5
Numeric columns not in the fact table, 6-5
OLAP model components, 3-14
primary key column, 6-5
standard dimension, 3-14
String column, 6-5
time dimension clock, 3-14
greater than operator (>), 8-4, 10-18
greater than or equal to operator (>=), 8-4, 10-18

H

Help menu, Help Topics command, xiv

help, accessing online, xiv

Hidden Column command, View > Model Icons

menu, 6-5

hidden columns
accounts dimension, 5-10
defining, 6-6
fact table, 5-10
graphicsfor, 6-5

hierarchies
adding a data value prefix or suffix, 10-26
adding or editing, 10-8, 10-11, A-20
ascending sort and, 10-21
building from recursive tables, 2-8
changing data value character case, 10-24
components of, 10-3
consolidation and, 1-3, 10-3
converting spaces to underscores, 10-24
creating, 2-8, 10-7, A-20
data sources for building to a specific level, 2-8
data value transformations, defined, 10-22
defined, 10-1
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deleting, 10-10 OLAP Model, defined, 1-8
descending sort and, 10-21 product family

editing, 10-10, A-21 defined, 1-6

filter example, 10-20 diagram, 1-7

filter operators, 10-18 workflow, 1-10

filters, 10-13 standard user interface, defined, 1-8
filters, components of, 10-13 workflow, 1-6, 1-10, 1-13
Hyperion Essbase, 10-3 Hyperion Integration Server Desktop
inheritance, 10-13 defined, 1-1

metaoutlines, 10-1 executable name, 3-3

naming, 10-8 hyphens (=) in dimension and member names, 3-28

omitting leading or trailing spaces, 10-24
operators, specifying, 10-18 |

ragged, 10-6
recursive and branches, 10-5 icons, OLAP Model startup, 3-3
recursive tables, 10-4 in operator, 10-18
renaming time dimension, A-27 indenting, 1-3
replacing column data values, 10-24 indexes, working with, 2-14, 2-15
sorting, 10-21 inheritance, hierarchies and, 10-13
specifying filter conditions, 10-16 initial capitalization, setting, 10-24
time dimensions, 4-9, A-23, A-27, A-32 Integration Server. See Hyperion Integration Server
transformation and, 10-22 integrity constraints, cleansing data, 2-6
transformation, graphicsfor, 6-5 intersections, defined, 1-3
using in metaoutlines, 10-4 invalid OLAP models
viewing, 10-7 correcting, 3-19

Hierarchies tab, Dimension Properties dialog box, saving, 3-20

10-7 isdirectory, 3-3

hierarchy filters, combining, 10-20
Hierarchy Transformation command, View > Model J
Icons menu, 6-5

Hyperion Essbase join co!umns
accounts dimension, 2-20 defined, 9-3
databases, workflow, 1-10 deleti ng, 9-14
designing a database for user needs, 2-2 grephicsfor, 6-5
hierarchies, 10-3 multiple sets, 9-4
hierarchies, creating, 2-8 Join command, View > Model |cons menu, 6-5
OLAP Server, defined, 1-2 jOi_n lines, 9-4
overview of, 1-3 Join tool
users, 1-3 Add Joins mode, 3-13
Hyperion Essbase outlines, 10-13, 10-22, 10-27 description, 3-13
Hyperion Integration Server Move mode, 3-13
components, 1-8 using to join tables, 9-6
data warehouse, 2-5 joins
defined, 1-5 adding column joins, 9-10, 9-14
OLAP Command Interface, defined, 1-9 aiasesin recursive tables, 9-17
OLAP Metadata Catalog, defined, 1-9 automatic, 4-3

between dimension tables, 9-8, A-13
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changing, 9-3, 9-14

creating, 9-8

defined, 9-1

deleting, 5-16

deleting between dimension tables, 9-14
deleting column joins, 9-14

deleting within dimension tables, 9-14
joining atable to itself, 9-15

joining tablesin your RDBMS, 2-13
multiple, 9-4

natural, defined, 4-3

OLAP models, 9-4

overview, 9-3

properties, viewing, 9-5

recursive, 9-19

reducing through denormalization, 2-13
tool tipsand, 9-5

UDAsand, 9-17

unions, removing, 2-10

viewing, 9-5

keys
columns, transformations and, 2-15
compound, defined, 4-3
foreign, 4-3
primary, 4-3
viewing source columns, 3-16

L

left frame, 3-15
legacy data
preparing, 2-22
switching time and accounts, 4-14
less than operator (<), 8-4, 10-18
less than or equal to operator (<=), 8-4, 10-18
lessthan signs (<), in dimension and member names,
3-28
levels
data sources for building, 2-8
dimension branches and, 5-5
in OLAP models, 5-5
time hierarchy, 4-10
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like operator, 10-18
logical model, description, 1-10
lower case, setting, 10-24

M

MAX aggregation option, 6-18
measures
accounts dimension and, 4-7, A-35
bitmapped indexes and, 2-14
creating asingle, 4-7
creating filtersin metaoutlines, 10-13
data, associating with time periods, 2-20
defined, 2-3
defining a single measures column, 4-7
examples of, 4-1
fact table and, 2-17
how to treat asasingle value, 4-4
OLAP model container, 4-4
values, 4-3
Member Info tab, Dimension Properties dialog box,
4-17
member levels
aliasesfor, 9-16
UDAsfor, 9-16
member names
creating aliases, 2-19
maximum length, 3-28
members
attribute dimensions, 8-4
consolidation, 1-3
creating filtersin metaoutlines, 10-13
defined, 1-3
dimensions, 1-3
examples, 1-3
naming, 3-28
OLAP models, 1-3
rules for naming, 3-28
menu
bar, defined, 3-13
right-click, 3-13
metadata
accessing OLAP Metadata Catalog, 2-23
defined, 1-9
metadata repository. See OLAP Metadata Catalog
metadata, OLAP Metadata Catalog storage, 1-9
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metaoutlines
and invalid OLAP models, 3-25
creating dimensions, 1-12
defined, 1-8
defining time structure, 4-8
filtersand, 10-13
Hyperion Integration Server sample, Xiii
invalid OLAP models and, 3-25
printing, 3-29
saving with Exclusive Access, 3-21
MIN aggregation option, 6-18
minus signs (-), in dimension and member names,
3-28
#MISSING, as reserved word, 3-28
models. See OLAP models
modulus function, 7-10
monthly total, 4-8
Move mode
defined, 5-15
Join tool, 3-13
multidimensional databases
defined, 1-3
source data, 1-5
uses, 1-3, A-2
workflow, 1-5, 1-10
multiple
columns, selecting, 6-8
joins, 9-4

N

names
dimension tables, changing, 5-15
dimension, changing, 5-14
displaying column names in dimension tables,
6-4
fact table, 4-5
fact table, changing, 5-14
prefixing, 10-26
suffixing, 10-26
naming
conventions, 3-28
dimensions, 3-28
hierarchies, 10-8
members, 3-28
natural join, defined, 4-3
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NETPRICE example, 7-8
<NONE> aggregation option, 6-18
non-financial applications, 4-7
non-NULL values, consolidation of, 6-18
normalized data, denormalizing, 2-12
not equal to operator (<>), 10-18
not in operator, 10-18
not like operator, 10-18
null parents, recursive hierarchies and, 10-5
Numeric columns
graphicsin the fact table, 6-5
graphics not in the fact table, 6-5
numeric data
calculations and, 7-11
indexes and, 2-14
values, 4-1
Numeric datatype
column transformations, 7-8
mapped to ODBC data types, 6-3
transforming columns in dimension tables, 7-8

O

ODBC
SQL versions supported, 1-5
supported data types, 6-3
OLAP
benefits of, A-2
defined, A-2
OLAP Architect. See OLAP Model
OLAP Catalog. See OLAP Metadata Catalog
OLAP Command Interface
batch processing, 1-9
defined, 1-9
OLAP Integration Server
connection problems, 3-6
defined, 1-9
OLAP Metadata Catalog
accessing tables, 2-23
configuring for ODBC, 1-9
connecting to, 3-30
connection problems, 3-6
defined, 1-9
locks, deleting, 3-31
OLAP Metaoutline Assistant, 1-8
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OLAP metaoutlines, saving with Exclusive Access,
321

OLAP Modéd

choosing which tables are displayed, 2-16

creating, A-8

defined, 1-8

executable file name, 3-3

|eft frame source tables and views, 3-12

main window, 3-11, A-7, A-19

right frame modeling area, 3-13

saving, A-35

starting, 3-3

startup programs necessary, 3-3

uses, 1-1

using icon to start, 3-3

workflow to create an OLAP modd!, 1-13
OLAP Model Assistant, 1-8, 3-7
OLAP Model main window, 1-11, 3-11
OLAP Model main window, illustration, 4-5
OLAP Model Properties dialog box

General tab, 3-25

Optimization tab, 3-26

Propertiestab, 3-26
OLAP Mode Validation Errors dialog box, 3-19
OLAP models

accounts dimension, 4-7

choosing which tables are displayed, 2-16

closing, 3-27

columns, renaming, 6-6

components, 1-10, 1-11

compound key, 4-3

confirming a deletion, 3-31

copying, 3-27

creating, 1-9, 3-11

defined, 1-12

deleting, 3-30

deleting, caution, 3-31

dimension branches, 5-5

dimension tables, 1-12

dimensions, 1-3

dimensions, naming, 5-14

entering a storable description, 3-24

fact table, 1-12

graphic illustration, 1-12

graphicsin, 3-14

hierarchies, 10-3
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Hyperion Integration Server sample, xiii
invalid, 3-25
joining dimensions to the fact table, 9-6, A-13
levelsin, 5-5
locks, deleting, 3-31
measures, 4-3
members, 1-3
prerequisites for creating, 1-13
Save As, using to save, 3-18
saving under adifferent name, 3-27
saving when closing, 3-27
specifying user access permissions, 3-24
time dimension, 4-8
validating manually, 3-18
validation errors, 3-19
validation, checks performed, 3-19
validation, conditions, 3-18
workflow, 1-13, 1-15
OLAP. See Online Analytica Processing
olaparch.exe file, using to start OLAP Modd, 3-3
OLTP. See Online Transaction Processing
Online Analytical Processing (OLAP), defined, 1-2
online guide, displaying and searching, xiv
online help, accessing and printing, Xiv
Online Transaction Processing (OLTP) data,
examples of contents, 1-5
operational data, 1-5
operators
attributes and, 8-4
filtersand, 10-18
specifying for Numeric column transformations,
7-8
Optimization tab, OLAP Model Propertiesdiaog
box, 3-25
or, using to combine filter conditions, 10-20
Ordering tab, Edit Filter dialog box, 10-21
outlines. See Hyperion Esshase outlines;
metaoutlines

P

parent-child data source, 2-8
parent-child tables
defining, 9-21
description, 10-6
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examples, 10-6

joining atableto itself, 9-21
parentheses (), in dimension and member names,

3-28

parents

filtering example, 10-15

filtersand, 10-14

prefixing name, 10-26

recursive tables and, 10-5

suffixing name, 10-26
pass-through transformations

dliases and, 2-19

defined, 7-14

defining in OLAP model, 7-14

example, 7-16

functions, 7-15
percent operator (%), modulus function, 7-10
performance

bitmapped indexes and, 2-14

increasing through denormalization, 2-13

sorting and, 10-21
periodic reporting, 4-8
periods (.) in dimension and member names, 3-28
periods, time, examplein user-defined calendar, 4-11
permissions

required in the SQL data source, 2-16

saving metaoutlines and, 3-24
perspective, changing, 1-5
Physical Joinstab

joinsin adimension table, 9-14

Table Properties dialog box, 9-11, 9-14
pivoting, using to change data view, 1-5
plussigns (+), in dimension and member names, 3-28
Prefix/Suffix tab, Edit Transformations dial og box,

10-26, A-30

prefixes

data values, 10-25

names, ancestors, 10-26
prerequisites

for OLAP Model, xi

for using this guide, xi
Preview Filter Results dialog box, 10-28
Preview Transformation Results dialog box, 10-28
previewing Hyperion Essbase outline, 10-27
primary dimension table, defined, 5-5, 9-6
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primary key columns
defined, 4-3
graphicsfor, 6-5
Primary Key command, View > Model |cons menu,
6-5
Print button, OLAP Metaoutline toolbar, 3-29
printing metaoutlines, 3-29
privileges. See permissions
problems, connecting, 3-6
product code, example, 2-15
product comparisons, 1-2
properties
displaying column, 6-4
displaying join, 9-5
displaying table, 5-13
Propertiestab, OLAP Model Properties dialog box,
3-26

Q

quarterly totals, 4-8
quotation marks, in dimension and member names,
3-28

R

ragged hierarchies, 10-6
read access, setting, 3-24
read-only access, SQL data sources and, 2-16
Recursion dialog box, joining atable to itself, 9-21
recursive hierarchies

branches, 10-5

example, 10-5

filtersand, 10-14

multiple parents and, 10-5

null parents and, 10-5

shared members, example, 10-6
recursive hierarchies, shared members and, 10-5
recursive tables

adiases and, 2-8, 9-17

as sdlf joins, 9-15

creating Hyperion Essbase hierarchies from

recursive tables, 2-8

defined, 2-8, 9-15

defining for alias or UDAS, 2-8, 9-16

description, 10-6

example, parent-child, 10-6
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filtering on columns, 10-14
fully-defined columns for, 2-9
hierarchies and, 10-4
multiple, 9-17
rulesfor, 2-8
self joins and, 10-6
redundant data, denormalizing, 2-12
relational data sources
viewing column namesiin left frame, 3-15
viewing column namesin right frame, 3-15
viewing datain left frame, 3-15
relational databases. See data sources
relationship. Seejoins
removing. See deleting
renaming
columns, 6-6
dimension tables, 5-15
dimensions, 5-14
fact table, 5-14
Replacetab, Edit Transformations dialog box, 10-23,
A-29, A-31
repository. See OLAP Metadata Catal og
reserved words, 3-28
right-click menus, xvi, 3-13
roll-ups, defined, 1-3
rows, transposing with columns, 2-10

S

sample
applications, xiii
hierarchy, accounts dimension, 2-11
metaoutline, description, Xiii
OLAP model, description, xiii
TBC moddl, A-3
Sample Outline dialog box, 10-28
Save New OLAP Model diaog box, 3-23
saving
OLAP models, A-35
OLAP models, open by other users, 3-22
OLAP models, using different name, 3-27
OLAP models, using Save As, 3-18
scenarios, 1-4
seasonal comparisons, example, 4-8
seasons, user-defined calendars and, 4-13
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security
SQL data sources, 2-16
views and, 2-6
SELECT
permission, 2-16
statements, combining, 2-10
Select Vaues dialog box, 10-17
self joins
creating, 9-19
joining atableto itself, 9-15
recursive tables and, 10-6
shared members, recursive hierarchies and, 10-5
Show Tables command, 3-16
Show Views command, 3-16
skillsrequired, for this guide, xi
snapshot, staging area, 2-4
sorting
columnsin hierarchies, 10-21
data values, 10-21
filters, 10-21
hierarchies, 10-21
order performed, 10-21
viewing results, 10-27
source data
collapsing view, 3-17
column quick-view, 3-18, 6-4
denormalizing, 2-12
multidimensional databases, 1-5
switching views, 3-16
transforming, 2-14
viewable data types, 6-3
viewing column names in left frame, 3-15
viewing column names in right frame, 3-15
viewing columns and keys, 3-16
viewing hidden, 3-15
viewing in left frame, 3-15
sources. See data sources
spaces
converting to underscores, 10-24
deleting, 10-24
in dimension and member names, 3-28
spreadsheet files, data sources, 1-5
SQL
combining filter conditions, 10-20
data sources, 1-5
filtersand, 10-16
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pass-through transformations, 7-16
SQL 89, 1-5
versions supported, 1-5
viewable data types, 6-3
viewing sample, 10-28
WHERE clausesin filters, 10-16
SQL data sources
combining, 2-4
combining flat files, 2-4
consolidating multiple, 2-3
read-only accessto, 2-16
required permission for, 2-16
security, 2-16
staging area, 2-4
SQL Drill-Through. See Drill-Through columns
staging area
advantages of, 2-4
deciding whether to create, 2-4
defined, 2-4
diagram, 2-5
Y 2K issuesand, 2-5
standard dimensions
creating, 5-3, 9-6
graphic, 3-14
star schemas. See OLAP models
starting OLAP Model, 3-3
Status Bar, 3-14
stored procedures, pass-through transformations,
7-15
strategic planning, 1-4
String datatype
columns as concatenations, 7-5
columns as substrings, 7-3
graphicsfor, 6-5
mapped to ODBC data types, 6-3
strings, replacing, 10-24
substrings, String data type transformations, 7-3
suffixes
data values, 10-25
names, ancestors, 10-26
SUM aggregation option, 6-18

summary source data, associating with time periods,

2-21
synonyms, viewing, 3-12

T

tab character, in names, 3-28
Table Properties dial og box
attribute-enabled columns, 8-6, 8-7, A-33
Columnstab, 6-7, 6-9, 6-15, 8-7, A-24, A-34
deleting columns, 6-9
Dimensions tab, 5-14
General tab, 5-13, 8-6, 9-14, A-33
hiding columns, 6-7
joining atabletoitself, 9-19
joining another table to adimension table, 9-11
Physical Joinstab, 5-8, 9-11, 9-14, 9-19
renaming dimension tables, 9-14
viewing from the fact table, 5-13
tables
See also dimension tables
accessing tablesin OLAP Metadata Catalog, 2-23
adding to dimension tables, 5-8
capitalization, xiii
choosing which tables are displayed in OLAP
models, 2-16
collapsing view, 3-12
creating, A-8, A-10, A-17
creating to denormalize data, 2-12
deciding whether to create new tables, 2-6
denormalizing, 2-12
expanding to show columns, 3-12
fact table, adding to, 5-11
joining, 2-13
reasonsto create, 2-7
recursive
dliasesand, 2-8
as self joins, 9-15
defined, 2-8
fully-defined columnsfor, 2-9
rulesfor, 2-8
UDASsor dliases, 2-8
rules for naming, 3-28
viewing, 3-12
TBC, xiii
TBC Metaoutling, xiii
TBC Modd, xiii
TBC model dimensions, A-3
TBC_MD, xiii
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text
files, data sources, 1-5
replacing, 10-24
time
analysis, preparing data for, 2-20
associating with measures data, 2-20
data, columns, 4-14
time-related columns, defining in source data,
2-20
time dimension
clock graphic, 3-14
columns, adding, 4-6, 5-10
components of, 4-9
creating automatically, reasons for, 4-6
creating from fact table, 4-10, A-8
datatypesand, 5-10
defined, 2-20, 4-8
deleting, 5-16
dimension branches and, 5-6
examples, 4-8
hierarchies, 4-9, 7-12, A-23, A-27, A-32
hierarchy, default prefix for, 10-25
hierarchy, levels, 4-10
OLAP models, 4-8
overview, 4-8
prefix default value, 10-25
relationship to fact table, 5-11
requirements, 5-10
switching with accounts dimension, 4-14
tables, adding, 5-10
transformations, 7-12
use in Hyperion Essbase outline, 2-20
when required, 4-8
when to create automatically, 4-6
to-datetotals, 7-4
tool tips, joinsand, 9-5
toolbar, 3-13
Toolbar command, 3-13
tools, Join, 3-13
Transformation Rule tab, Column Properties dialog
box, 7-3, 7-6, 7-9, 7-13, 7-15, A-25
transformations
columns with Numeric data type, 7-8
datavaluesin hierarchies, 10-22
defining in OLAP models, 7-1
defining in SQL data sources, 2-15
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example in data source, 2-15
hierarchies and, 10-22
indexes and, 2-15
key columns and, 2-15
order performed, 10-21
pass-through, 7-14
reviewing results, 10-27
rules for columns, 7-1
rules for columns, changing, 7-17
rules for DateTime columns, 7-12
rules for Numeric columns, 7-8
rules for String columns, 7-3, 7-5
transposing columns and rows, 2-10
trends, 1-2, 4-8
troubleshooting, connecting, 3-6

U

UDAs
defined, 9-16
member levels, 9-16
recursive tables, 2-8, 9-16
underscores ()
converting spaces to, 10-24

in dimension and member names, 3-28

unions, removing, 2-10
UNIVERSE, as reserved word, 3-28
unjoined dimension tables, 5-16
upper case, setting, 10-24
user needs, defining, 2-2
user privileges. See permissions
user-defined attributes. See UDAS
user-defined calendar
defined, 4-11
determining need, 4-11
example, 4-12
table requirements, 4-11
time-related key column, 4-11, 4-12
user-defined columns
adding to dimension tables, 6-14
defined, 6-14
user-defined dimensions, defined, 1-13
users, Hyperion Esshase, 1-3
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Vv

validation
checks performed for OLAP models, 3-19
OLAP models, automatic, 3-18
problems, 3-19
troubleshooting, 3-19

values. See datavalues

variables, defined, 2-3

vertical bar (]), in dimension and member names,

3-28

View All Columns command, 3-18

View Columns command, 3-18, 6-4

View menu
Enable Join Tool Tips command, 9-5
Model Icons > All command, 6-5
Properties> OLAP Model command, 3-26
Show Synonyms command, 3-12
Show Tables command, 3-12
Show Views command, 3-12
Status Bar command, 3-14
Toolbar command, 3-13
View All Columns command, 3-18
View Columns command, 3-18, 6-4
View Table Data command, 3-12

View Sample dialog box, 10-28

View Table Datacommand, 3-12

View Table Data dialog box, 3-17

views
See also tables
adding to dimension tables, 5-8
collapsing columns, 3-12
deciding whether to create new views, 2-6
expanding to show columns, 3-12
reasons to create, 2-7
viewing, 3-12
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W

weekly totals, 4-8
what if scenarios, example, 1-4
WHERE clauses in filters, 10-16
whitespace. See spaces
Windows Start menu, using to start OLAP Model,
3-3
wizard. See OLAP Model Assistant; OLAP
Metaoutline Assistant
workflow
Hyperion Integration Server, 1-6
Hyperion Integration Server product family, 1-10
OLAP models, creating, 1-15
write access, setting, 3-24

Y

Y 2K issues and staging area, 2-5
yearly totals, 4-8

Z

zoom in. Seedrill down
zoom out. Seedrill up

Hyperion Integration Server Desktop OLAP Model User’s Guide



	Contents
	Preface
	About Hyperion Integration Server
	About OLAP
	About Multidimensional Databases
	User Interactions with Data
	Sources of Data

	About Hyperion Integration Server
	Components of Hyperion Integration Server
	Hyperion Integration Server Desktop
	OLAP Integration Server

	Workflow for Using Hyperion Integration Server

	About OLAP Models
	About Hyperion Integration Server OLAP Models
	About OLAP Models and Metaoutlines
	About the Fact Table
	About Dimension Tables

	Workflow for Creating an OLAP Model


	Preparing Relational Data�Sources
	Defining User Needs
	Defining Data Sources
	Consolidating Data into a Single Data Source
	Deciding Whether to Create a Staging Area
	Cleansing Data
	Creating Views and Tables
	Deciding Whether to Create a View or a New�Table
	Building Hyperion Essbase Hierarchies from Recursive�Tables
	Building a Hierarchy Down to a Specific Level
	Creating Aliases or UDAs for Members in a Recursive Table

	Removing Unions
	Transposing Columns and Rows
	Denormalizing Source Data Tables

	Joining Tables
	Creating Indexes
	Transforming Data
	Deciding Which Tables Are Available to OLAP Model Creators
	Selecting Tables for the Fact Table
	Selecting Tables for Dimensions
	Creating Aliases for Dimension and Member�Names

	Creating Time and Accounts Dimensions
	Preparing Data for Time Analysis
	Associating Time Data with Measures Data
	Working with Summary Data
	Formatting the Date
	Working with Data in Similar Time Periods


	Accessing Tables in OLAP Metadata Catalog

	Creating and Working with OLAP Models
	Understanding the OLAP Model Workflow
	Working with OLAP Models
	Starting Hyperion Integration Server Desktop
	Creating or Editing OLAP Models
	Correcting Connection Problems

	Working in OLAP Model Assistant
	Process Graphics
	Inline Help Text
	Tasks to Complete
	Buttons
	Tasks That Cannot Be Performed Using OLAP Model Assistant

	Working in the OLAP Model Standard User Interface
	Left Frame
	Right Frame
	Tools and Toolbars
	Menus
	Status Bar
	OLAP Model Dimension Table Graphics
	Display of Column Names
	Displaying Column Names in the Left Frame
	Viewing Table Data
	Displaying Column Names in the Right Frame


	Validating OLAP Models Manually
	Saving OLAP Models
	Understanding Exclusive Access
	Saving an OLAP Model Manually
	Changing Read/Write Access
	Specifying Retrieval Optimization Preferences

	Saving While Closing
	Saving an OLAP Model to a Different Name
	Observing Naming Rules

	Printing OLAP Models
	Deleting OLAP Models

	Creating the Fact Table, Accounts Dimension, and Time Dimension
	Understanding the OLAP Model Workflow
	About the Fact Table
	What Components Are Included in the Fact Table
	Why a Fact Table is Required

	Creating the Fact Table
	About the Accounts Dimension
	Creating the Accounts Dimension Manually
	About the Time Dimension
	Creating the Time Dimension Manually
	Manually Creating a Time Dimension that Is Based�on�the Fact Table
	Determining if a User-Defined Calendar Is Needed
	Designing a User-Defined Calendar

	Switching the Time and Accounts Dimensions
	Switching the Time and Accounts Dimensions in the OLAP Model
	Setting Dimension Properties in the Metaoutline


	Creating and Working with Dimensions
	Understanding the OLAP Model Workflow
	Creating Dimensions
	Adding Tables to Dimension Tables or to the Fact Table
	About Dimension Branches
	Adding Source Tables to Create Dimension Branches
	Adding Source Tables Directly to Dimension Tables
	About Adding Tables to the Time Dimension
	About Adding Tables to the Accounts Dimension
	About Adding Tables to the Fact Table
	Adding Tables to the Fact Table


	Viewing Dimension Table and Fact Table Information
	Renaming Dimensions and the Fact Table
	Renaming Dimension Tables
	Moving Tables
	Deleting Dimension Tables or the Fact Table

	Editing Columns in Dimension Tables and the Fact Table
	Understanding the OLAP Model Workflow
	About Column Data Types
	Viewing Column Properties
	Editing Columns
	Renaming Columns
	Hiding and Showing Columns
	Working with Multiple Columns
	Deleting Columns

	Using a Column to Create Time Hierarchies
	Defining Drill-Through Columns
	Creating User-Defined Columns

	Transforming Columns
	Understanding the OLAP Model Workflow
	Defining Transformations that Use Substrings to Create String Columns
	Defining Transformations that Use Concatenations to Create String Columns
	Defining Transformations for Numeric Columns
	Defining Transformations for Datetime Columns
	Defining Pass-Through Transformations
	Editing Column Transformation Rules

	Setting Attribute-Enabled Columns
	Understanding the OLAP Model Workflow
	About Attributes
	Attribute Dimensions
	Attribute Types
	Differences Between Attribute Dimensions and Standard Dimensions

	Guidelines for Selecting and Deselecting Columns as Attribute-Enabled
	Selecting and Deselecting Columns as Attribute-Enabled

	Joining Dimension Tables
	Understanding the OLAP Model Workflow
	About Joins
	Why You May Need to Define Multiple Joins
	How Joins Are Displayed in an OLAP Model

	Joining Dimension Tables Directly to the Fact Table
	Joining Dimension Tables to Create or Expand a Dimension Branch
	Combining Table Columns to Join Dimension Tables
	Working with Joins
	Viewing Joins Information
	Deleting Joins Between Dimension Tables
	Deleting Joins Within Dimension Tables

	Defining a Recursive Table
	Preparing Recursive Tables to Be Used with Aliases and User-Defined Attributes
	Joining a Table to Itself


	Creating and Working with Hierarchies
	Understanding the OLAP Model Workflow
	About Hierarchies
	About Recursive Tables
	About Shared Members in Recursive Tables
	About Ragged Hierarchies

	Creating Hierarchies
	Editing and Deleting Hierarchies
	Filtering Data in Hierarchies
	About Hierarchy Filters
	About Recursive Table Filters
	Creating Filters in Hierarchies

	Sorting Data in Hierarchies
	Transforming Data in Hierarchies
	Replacing Data
	Prefixing and Suffixing Column Values

	Previewing the Hyperion Essbase Outline

	Creating a Sample OLAP�Model Containing Attribute-Enabled Columns
	The Benefits of OLAP to TBC
	Sample TBC Model Dimensions
	Starting Up and Logging On
	Opening the Standard User Interface to Create�a New OLAP Model
	Working in the OLAP Model Main Window
	Creating the Fact Table
	Creating the Product, Family, and Productdim Tables
	The Product Table
	The Family Table
	The Productdim Table

	Creating Additional Dimension Tables
	Adding Hierarchies to the OLAP Model
	Creating the Market Hierarchy
	Creating the Product Hierarchy
	Creating the Time Year Hierarchy
	Creating the Year Hierarchy

	Setting Columns to Attribute-Enabled
	Renaming the Accounts Dimension

	Saving the OLAP Model


	Glossary
	Index

